EdMikroElektronika

SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD . . . vvalkivg b siunple

mikroPASCAL PRO for AUR

FETTEIERE W T R £ Tabtim
ki B e S N L e |

41 e 4 chamgn L e apemt nse

Develop your applications quickly and easily with the
world's most intuitive mikroPascal PRO for AVRI
Microcontrollers.

Highly sophisticated IDE provides the power you need with
the simplicity of a Windows based point-and-click
environment.

With useful implemented tools, many practical code
examples, broad set of built-in routines, and a
comprehensive Help, mikroPascal PRO for AVR makes a
fast and reliable tool, which can satisfy needs of
experienced engineers and beginners alike.



mikroPASCAL PRO for AVR

May 2009. | Reader’s note |

DISCLAIMER:

mikroPASCAL PRO for AVR and this manual are owned by mikroElektronika and are
protected by copyright law and international copyright treaty. Therefore, you should treat
this manual like any other copyrighted material (e.g., a book). The manual and the compiler
may not be copied, partially or as a whole without the written consent from the mikroEelk-
tronika. The PDF-edition of the manual can be printed for private or local use, but not for
distribution. Modifying the manual or the compiler is strictly prohibited.

HIGH RISK ACTIVITIES:

The mikroPASCAL PRO for AVR compiler is not fault-tolerant and is not designed, manu-
factured or intended for use or resale as on-line control equipment in hazardous environments
requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation
or communication systems, air traffic control, direct life support machines, or weapons sys-
tems, in which the failure of the Software could lead directly to death, personal injury, or severe
physical or environmental damage ("High Risk Activities"). mikroElektronika and its suppliers
specifically disclaim any express or implied warranty of fithess for High Risk Activities.

LICENSE AGREEMENT:

By using the mikroPASCAL PRO for AVR compiler, you agree to the terms of this agreement.
Only one person may use licensed version of mikroPascal PRO for AVR compiler at a time.
Copyright © mikroElektronika 2003 - 2009.

This manual covers mikroPASCAL PRO for AVR version 1.2.5 and the related topics.
Newer versions may contain changes without prior notice.

COMPILER BUG REPORTS:
The compiler has been carefully tested and debugged. It is, however, not possible to
guarantee a 100 % error free product. If you would like to report a bug, please contact us at
the address office@mikroe.com. Please include next information in your bug report:

- Your operating system

- Version of mikroPASCAL PRO for AVR

- Code sample

- Description of a bug

CONTACT US:
mikroElektronika

Voice: + 381 (11) 36 28 830
Fax: + 381 (11) 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com

Windows is a Registered trademark of Microsoft Corp. All other trade and/or services marks
are the property of the respective owners.
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Introduction to
mikroPascal PRO for AVR

Help version: 2009/05/18

The mikroPascal PRO for AVR is a powerful, feature-rich development tool for
AVR microcontrollers. It is designed to provide the programmer with the easiest
possible solution to developing applications for embedded systems, without com-
promising performance or control.
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Introduction to mikroPascal PRO for AVR
Features

- mikroPascal PRO for AVR allows you to quickly develop and deploy complex
applications:

- Write your Pascal source code using the built-in Code Editor (Code and Parame-
ter Assistants, Code Folding, Syntax Highlighting, Auto Correct, Code Templates,
and more.)

- Use included mikroPascal PRO for AVR libraries to dramatically speed up the
development: data acquisition, memory, displays, conversions, communication etc.

- Monitor your program structure, variables, and functions in the Code Explorer.

- Generate commented, human-readable assembly, and standard HEX compatible
with all programmers.

- Inspect program flow and debug executable logic with the integrated Software
Simulator.

- Get detailed reports and graphs: RAM and ROM map, code statistics, assembly
listing, calling tree, and more.

- mikroPascal PRO for AVR provides plenty of examples to expand, develop, and
use as building bricks in your projects. Copy them entirely if you deem fit — that’s
why we included them with the compiler.

2
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Where to Start

- In case that you're a beginner in programming AVR microcontrollers, read careful
ly the AVR Specifics chapter. It might give you some useful pointers on AVR con
straints, code portability, and good programming practices.

- If you are experienced in Pascal programming, you will probably want to consult
mikroPascal PRO for AVR Specifics first. For language issues, you can always
refer to the comprehensive Language Reference. A complete list of included
libraries is available at mikroPascal PRO for AVR Libraries.

- If you are not very experienced in Pascal programming, don’t panic! mikroPascal
PRO for AVR provides plenty of examples making it easy for you to go quickly. We
suggest that you first consult Projects and Source Files, and then start browsing
the examples that you're the most interested in.
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MIKROELEKTRONIKA ASSOCIATES LICENSE STATEMENT AND
LIMITED WARRANTY

IMPORTANT - READ CAREFULLY

This license statement and limited warranty constitute a legal agreement (“License Agree-
ment”) between you (either as an individual or a single entity) and mikroElektronika
(“mikroElektronika Associates”) for software product (“Software”) identified above, includ-
ing any software, media, and accompanying on-line or printed documentation.

BY INSTALLING, COPYING, OR OTHERWISE USING SOFTWARE, YOU AGREE TO
BE BOUND BY ALL TERMS AND CONDITIONS OF THE LICENSE AGREEMENT.

Upon your acceptance of the terms and conditions of the License Agreement, mikroElek-
tronika Associates grants you the right to use Software in a way provided below.

This Software is owned by mikroElektronika Associates and is protected by copy-
right law and international copyright treaty. Therefore, you must treat this Software
like any other copyright material (e.g., a book).

You may transfer Software and documentation on a permanent basis provided. You
retain no copies and the recipient agrees to the terms of the License Agreement.
Except as provided in the License Agreement, you may not transfer, rent, lease,
lend, copy, modify, translate, sublicense, time-share or electronically transmit or
receive Software, media or documentation. You acknowledge that Software in the
source code form remains a confidential trade secret of mikroElektronika Associates
and therefore you agree not to modify Software or attempt to reverse engineer,
decompile, or disassemble it, except and only to the extent that such activity is
expressly permitted by applicable law notwithstanding this limitation.

If you have purchased an upgrade version of Software, it constitutes a single prod-
uct with the mikroElektronika Associates software that you upgraded. You may use
the upgrade version of Software only in accordance with the License Agreement.

LIMITED WARRANTY

Respectfully excepting the Redistributables, which are provided “as is”, without war-
ranty of any kind, mikroElektronika Associates warrants that Software, once updat-
ed and properly used, will perform substantially in accordance with the accompany-
ing documentation, and Software media will be free from defects in materials and
workmanship, for a period of ninety (90) days from the date of receipt. Any implied
warranties on Software are limited to ninety (90) days.

mikroElektronika Associates’ and its suppliers’ entire liability and your exclusive
remedy shall be, at mikroElektronika Associates’ option, either (a) return of
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of the price paid, or (b) repair or replacement of Software that does not meet
mikroElektronika Associates’ Limited Warranty and which is returned to mikroElek-
tronika Associates with a copy of your receipt. DO NOT RETURN ANY PRODUCT
UNTIL YOU HAVE CALLED MIKROELEKTRONIKA ASSOCIATES FIRST AND
OBTAINED A RETURN AUTHORIZATION NUMBER. This Limited Warranty is void
if failure of Software has resulted from an accident, abuse, or misapplication. Any
replacement of Software will be warranted for the rest of the original warranty peri-
od or thirty (30) days, whichever is longer.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
MIKROELEKTRONIKA ASSOCIATES AND ITS SUPPLIERS DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESSED OR IMPLIED,
INCLUDED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND
NON-INFRINGEMENT, WITH REGARD TO SOFTWARE, AND THE PROVISION
OF OR FAILURE TO PROVIDE SUPPORT SERVICES.

IN NO EVENT SHALL MIKROELEKTRONIKA ASSOCIATES OR ITS SUPPLIERS BE
LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF BUSINESS PROFITS AND BUSINESS INFORMATION, BUSINESS
INTERRUPTION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE
OF OR INABILITY TO USE SOFTWARE PRODUCT OR THE PROVISION OF OR
FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF MIKROELEKTRONIKA
ASSOCIATES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN
ANY CASE, MIKROELEKTRONIKA ASSOCIATES’ ENTIRE LIABILITY UNDER ANY
PROVISION OF THIS LICENSE AGREEMENT SHALL BE LIMITED TO THE AMOUNT
ACTUALLY PAID BY YOU FOR SOFTWARE PRODUCT PROVIDED, HOWEVER, IF
YOU HAVE ENTERED INTO A MIKROELEKTRONIKA ASSOCIATES SUPPORT
SERVICES AGREEMENT, MIKROELEKTRONIKA ASSOCIATES’ ENTIRE LIABILITY
REGARDING SUPPORT SERVICES SHALL BE GOVERNED BY THE TERMS OF
THAT AGREEMENT.

HIGH RISK ACTIVITIES

Software is not fault-tolerant and is not designed, manufactured or intended for use
or resale as on-line control equipment in hazardous environments requiring fail-safe
performance, such as in the operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life support machines, or weapons
systems, in which the failure of Software could lead directly to death, personal injury,
or severe physical or environmental damage (“High Risk Activities”). mikroElektron-
ika Associates and its suppliers specifically disclaim any expressed or implied war-
ranty of fitness for High Risk Activities.
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GENERAL PROVISIONS

This statement may only be modified in writing signed by you and an authorised offi-
cer of mikroElektronika Associates. If any provision of this statement is found void
or unenforceable, the remainder will remain valid and enforceable according to its
terms. If any remedy provided is determined to have failed for its essential purpose,
all limitations of liability and exclusions of damages set forth in the Limited Warran-
ty shall remain in effect.

This statement gives you specific legal rights; you may have others, which vary, from
country to country. mikroElektronika Associates reserves all rights not specifically
granted in this statement.

mikroElektronika
Visegradska 1A,
11000 Belgrade,
Europe.

Phone: + 381 11 36 28 830
Fax: +381 11 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com
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TECHNICAL SUPPORT

In case you encounter any problem, you are welcome to our support forums at
www.mikroe.com/forum/. Here, you may also find helpful information, hardware tips,
and practical code snippets. Your comments and suggestions on future develop-
ment of the mikroPascal PRO for AVR are always appreciated — feel free to drop a
note or two on our Wishlist.

In our Knowledge Base www.mikroe.com/en/kb/ you can find the answers to Fre-
quently Asked Questions and solutions to known problems. If you can not find the
solution to your problem in Knowledge Base then report it to Support Desk
www.mikroe.com/en/support/. In this way, we can record and track down bugs more
efficiently, which is in our mutual interest. We respond to every bug report and ques-
tion in a suitable manner, ever improving our technical support.
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HOW TO REGISTER

The latest version of the mikroPascal PRO for AVR is always available for download-
ing from our website. It is a fully functional software libraries, examples, and com-
prehensive help included.

The only limitation of the free version is that it cannot generate hex output over 2
KB. Although it might sound restrictive, this margin allows you to develop practical,
working applications with no thinking of demo limit. If you intend to develop really
complex projects in the mikroPascal PRO for AVR, then you should consider the
possibility of purchasing the license key.

Who Gets the License Key

Buyers of the mikroPascal PRO for AVR are entitled to the license key. After you
have completed the payment procedure, you have an option of registering your
mikroPascal. In this way you can generate hex output without any limitations.

How to Get License Key

After you have completed the payment procedure, start the program. Select Help »
How to Register from the drop-down menu or click the How To Register Icon | ..
Fill out the registration form (figure below), select your distributor, and click the Send
button.
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mHowToRegister El [=] @

step 1. Fill in the form below. Please, make sure you fill in all required fields.
Step 2. Make sure that you provided a walid email address in the "EMAIL" edit baox. This email will be used far

sending yvou the activation key,

Step 3. Make sure you select a correct distributar which will rmake the registration process faster. If your
distributor is not on the list then select "Other” and type in distributor's email address in the box below,

Step 4. Press the SEMD button to send key request. A default email client will open with ready-to-send message.
Mote: If email client does not open, you may copy text of the message and paste it manually into a new email
message before sending it to vour distributar's email,

IW Marko Jovanovic
IW Enker your address

INVOICE Enter inwaice number if available
IW rnarko@miky o, com
IW rnarko@miky o, com
IW Enker company name
|| PRODUCTID | 515C-557265-6FED72-664F
[DISTRIBUTORY

* Required fields

I have made the payment and I wish to request activation keyv for mikroPascal PRO for AYVR

Name:
Marko Jovanovic

Address:
Invoice number:
Company:
E-Mail:

rnatko@mikyoe, com

Product key:
515C-557269-6Fa0 7 2-054F

Distributor:
2o Copyto [ SEND Cancel
= dipboard

This will start your e-mail client with message ready for sending. Review the information you
have entered, and add the comment if you deem it necessary. Please, do not modify the sub-
ject line.

Upon receiving and verifying your request, we will send the license key to the e-mail address
you specified in the form.
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After Receving the License Key

The license key comes as a small autoextracting file — just start it anywhere on your
computer in order to activate your copy of compiler and remove the demo limit. You
do not need to restart your computer or install any additional components. Also,
there is no need to run the mikroPascal PRO for AVR at the time of activation.

Notes:

- The license key is valid until you format your hard disk. In case you need to format
the hard disk, you should request a new activation key.

- Please keep the activation program in a safe place. Every time you upgrade the
compiler you should start this program again in order to reactivate the license.
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IDE OVERVIEW

The mikroPascal PRO for AVR is an user-friendly and intuitive environment:
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N Insert ChmikroPascal PRO for AVR\E

- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Spell Checker, Auto Correct for common typos
and Code Templates (Auto Complete).

- The Code Explorer (with Keyboard shortcut browser and Quick Help browser) is at
your disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings window

- Library manager enables simple handling libraries being used in a project

- The Error Window displays all errors detected during compiling and linking.

- The source-level Software Simulator lets you debug executable logic step-by-step
by watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create a project.

- Help files are syntax and context sensitive.

- Like in any modern Windows application, you may customize the layout of mikroPascal
PRO for AVR to suit your needs best.
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- Spell checker underlines identifiers which are unknown to the project. In this way
it helps the programmer to spot potential problems early, much before the project
is compiled.

- Spell checker can be disabled by choosing the option in the Preferences dialog (F12).

MAIN MENU OPTIONS

Available Main Menu options are:

File

Edit

Wigy

Project

Bun

Tools

Help

Related topics: Keyboard shortcuts
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File Menu Options

The File menu is the main entry point for manipulation with the source files.

L] Mew Unit  Crl+N
2 Open Chrl4
Recent Files k
H save Chr+5
Fﬁ Save fs
»u Close Ctrl+F4
= Print..  Ctr4+P
B Ext Akt
File Description
'] Mewlnit ctrl+M |[[Open a new editor window.
,ﬁ Open Ctri+2 | Open source file for editing or image file for viewing.
Recent Files * | Reopen recently used file.
H save Ctri+3 | Save changes for active editor.

Save the active source file with the different name or

H Save bs change the file type.

Ll Close al+F4 || Close active source file.
s Prink... Ckrl+P | Print Preview.

B Exit Ale+x | Exit IDE.

Related topics: Keyboard shortcuts, File Toolbar, Managing Source Files
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Edit Menu Options

<3 Undo Chrl+2
| Redo Shift+Chrl+2
gy Cut Chrl+
E= Copy Chrl+C
[ Paste Chriy
X Delete

Select al Chrl+A
A Find... Chrl+F
el Find Hext F3
93 Find Previous  Shift+F3
)R Replace. .. Ctrl+R
|d] FindInFiles...  Alt+F3
+ ] Goto Line... Tt

Advanced r

File Description

<& Undo Ctrl+Z |Undo last change.
& Redo shift+Ckrl+2 | Redo last change.
gb Cut i+ | Cut selected text to clipboard.
=2 Copy Ctri+Z | Copy selected text to clipboard.
I Paste Ctrl+y | Paste text from clipboard.
> Delete Delete selected text.

Select Al Ctrl+a | Select all text in active editor.
A2 Find... trl+F |Find text in active editor.
_)3 Find Mesxt F3 |Find next occurence of text in active editor.
‘}-J Find Previous  Shift+F3 |Find previous occurence of text in active editor.
M Replace... Ctr+r |Replace text in active editor.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Find text in current file, in all opened files, or in files

[ FindInFies..  Al+F3 from desired folder.

¢-_:] Goko Line. .. Cr+5 | Goto to the desired line in active editor.
Advanced k| Advanced Code Editor options
Advanced » Description

Comment selected code or put single line com-

L) Cemmens S Cy ment if there is no selection.

Uncomment selected code or remove single line

N comment if there is no selection.

%=  [Indent shift+Ctr+I | Indent selected code.

=% Outdent shift+Ctr4+U | Outdent selected code.

Ad| Lowercase Ctrl+alt+L | Changes selected text case to lowercase.
ad| Uppercase Ctrl+alt+0 | Changes selected text case to uppercase.
@ Titlecase Ctrl+alk+T | Changes selected text case to titlercase.
Find Text

Dialog box for searching the document for the specified text. The search is per-
formed in the direction specified. If the string is not found a message is displayed.

Find Text (w3

Search for: init -
—Options —Direction
Case sensitivity @ Forward

Whole words only

Search frorm caret HaEErT
Selected text anly
Regular expression (0] 4 Cancel
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Replace Text

Dialog box for searching for a text string in file and replacing it with another text string.

-

-

[1] Replace Text =nEeR==
Search far; mikroE lektronika -
Beplace with: rnik.roE -
—ption —Direction

@ Forward

“Wwhole words only

Search from caret Backward

Selected text only

Beqular exprezsion k. Cancel

Find In Files

Dialog box for searching for a text string in current file, all opened files, or in files on

a disk.

The string to search for is specified in the Text to find field. If Search in directories option
is selected, The files to search are specified in the Files mask and Path fields.

Grep search

s

—Options

Case sensitive

Whaole wards

Text to find: (gl = E S e

-

Where
Zurrent file

All opened files
@ Search in directories

—Search directory options

Files mask: *.*

Path: Ci\Program filesh,

Include subdirectories

QK

Cancel
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Go To Line

Dialog box that allows the user to specify the line number at which the cursor should

be positioned.

Go To Line

Go To Line Muber

1]

QK Cancel

]

Regular expressions

By checking this box, you will be able to advance your search, through Regular

expressions.

Find Text @
Search for: unsignedyxz0int -
—Options —Direction

Case sensitivity @ Forward

Whale words only

Search frorm caret - Backward

Selected text only

+ Reqgular expression i (0] 4 Cancel

Related topics: Keyboard shortcuts, Edit Toolbar, Advanced Edit Toolbar
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View Menu Options

o

Toolbars 3

Debug Windows k

Routines List
Project Settings
Caode Explorer
Project Manager  Cerl+F11
Library Manager

Bookmarks

Messages

Macro Editor

Windows

File

Description

-

Toolbars

Show/Hide toolbars.

Debug Windows

Show/Hide debug windows.

o=

Roukines Lisk

Show/Hide Routine List in active editor.

Project Sektings

Show/Hide Project Settings window.

=

Code Explorer

Show/Hide Code Explorer window.

Project Manager Shift+Ctrl+F11

Show/Hide Project Manager window.

Library Manager

Show/Hide Library Manager window.

Bookmarks Show/Hide Bookmarks window.

Messages Show/Hide Error Messages window.

Macro Editor Show/Hide Macro Editor window.
Windaows Show Window List window.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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TOOLBARS

File Toolbar

N&-HS  HE &

File Toolbar is a standard toolbar with following options:

Icon

Description

L]

Opens a new editor window.

(.

Open source file for editing or image file for viewing.

Save changes for active window.

Save changes in all opened windows.

HDI

Close current editor.

B

Close all editors.

=

Print Preview.

Edit Toolbar

@

Ie

Edit Toolbar is a standard toolbar with following options:

Icon

Description

Undo last change.

Redo last change.

Cut selected text to clipboard.

Copy selected text to clipboard.

il |7 82 |3 | 2

Paste text from clipboard.
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Advanced Edit Toolbar
Lalatotal SRR o)

Advanced Edit Toolbar comes with following options:

15
1

o |

Icon Description

Comment selected code or put single line comment if there is no
fuad selection

Uncomment selected code or remove single line comment if there is no
L selection.
E Select text from starting delimiter to ending delimiter.
Erit Go to ending delimiter.

] |Gotoline.

Indent selected code lines.

Outdent selected code lines.

Generate HTML code suitable for publishing current source code on
ud the web.

Find/Replace Toolbar

P RPA P

Find/Replace Toolbar is a standard toolbar with following options:

Icon Description

Find text in current editor.

Find next occurence.

Find previous occurence.

Replace text.

[0 o o

Find text in files.
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Project Toolbar
i e A ES Vi 1 T A O

Project Toolbar comes with following options:

Icon

Description

i

Open new project wizard. wizard.

Open Project

-

Save Project

Add existing project to project group.

Remove existing project from project group.

Add File To Project

| | [T | i | O

Remove File From Project

i

Close current project.

Build Toolbar

Build Toolbar comes with following options:

Icon

Description

Build current project.

Build all opened projects.

4
=

i s | o5

Build and program active project.

Start programmer and load current HEX file.

Open assembly code in editor.

B | &

View statistics for current project.
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Debugger

@

T By eo ey o2 ] | & &

Debugger Toolbar comes with following options:

Description

Icon
=h Start Software Simulator.
5h Run/Pause debugger.

Ex Stop debugger.

1) Step into.

e Step over.

38 Step out.

g Run to cursor.

= Toggle breakpoint.

= Toggle breakpoints.
(i, Clear breakpoints.

" View watch window

; View stopwatch window

Styles Toolbar

Office 2003 Blue ]

Office 2003 Olive
Qffice =P
Chocolate

Arctic

Silverfomx

Soft gand il

Styles toolbar allows you to easily customize your workspace.
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Tools Toolbar
L INE= R =]

Tools Toolbar comes with following default options:

Icon Description

= Run USART Terminal
= EEPROM
A ASCII Chart

@' Seven segment decoder tool.

The Tools toolbar can easily be customized by adding new tools in Options(F12) window.

Related topics: Keyboard shortcuts, Integrated Tools, Debugger Windows
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PROJECT MENU OPTIONS

N Build Ctrl+F9

i

Edit Search Paths., ..

Clean Project Folder, ..

Build &ll Projects Shift+F2

Build + Program Chrl+F11

Add File To Project...

Femove File From Project

BT

Open Project Group...

Close Project Group

L4 0 (8

Sawve Projeck As, .,

Mew Project. .. ShiftCErl+n

Qpen Project,..  Shift+Cerl40

Recent Projects

Close Project

(8
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Project Description
“# Buid Ctrl+Fa [Build active project.
A% Build Al Shift+F9 | Build all projects.
% Build + Program CtkrH-F11 | Build and program active project.
| Wiews Assembly View Assembly.

Edit Search Paths...

Edit search paths.

|lean Project Folder. ..

Clean Project Folder

4dd File To Project. .,

Add file to project.

Remove File From Project

Remove file from project.

Mew Projeck, .,

Open New Project Wizard

Qpen Project,..  Shift+Ckrl+0

Open existing project.

Save Projeck

Save current project.

open Project Group...

Open project group.

Zlose Project Group

Close project group.

AR E R B

Save Project As,..

Save active project file with the different name.

Recent Projects

Open recently used project.

Zlnse Project

0

Close active project.

Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project

Manager, Project Settings
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RUN MENU OPTIONS

[gb, Start Debugger Fa
[ﬂg Stop Debugger Ckrl+F2
éaj Pause Debugoer F&
i} Step Into F7
'ﬁu Step Qver F&
08 Skep Quk Chrl+Fa
# Jurnp To Interrupk Fz
E  Toggle Breakpoint FS
2= Breakpoints Shift-+F4
'8l | Clear Breakpoints  Shift+Crl+FS
&t Wakch Window Shift+F5
Ef—j Yiew Stopwatch

Disassembly mode alk+D
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Run Description
é@ Skart Debugger Fa | Start Software Simulator.
=4 Stop Debugger Ctrl+F2 | Stop debugger.
|'_§:]_| Pause Debugger Fs |Pause Debugger.
g1 Skep Inko F7 |Step Into.
@4, Shep Over Fg |Step Over.

Step Ot iCtrl+Fg | Step Out.

Jurnp T Inkerrupk Fz |Jump to interrupt in current project.

Toaggle Ereakpaoint FS | Toggle Breakpoint.

ShowHide Breakpoints  Shift+F4 | Breakpoints.

YWakch Window Shift+F5 | Show/Hide Watch Window

£
(=
l‘@ Clear Breakpoints  shift+Ctrl+FS | Clear Breakpoints.
e

Yieww Stopwatch Show/Hide Stopwatch Window

Toggle between Pascal source and dis-

Disassembly mode CrrlHD assembly.

Related topics: Keyboard shortcuts, Debug Toolbar
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TOOLS MENU OPTIONS

S

|
E
Al

El

mE Programmrer F11
SART Terminal ChEl+T
EEPROM Editor

Aacii Chart

Seven Segrment Convertor

]| Export Code To HTML

LCD Cuskar Characker
() GLCD Bitmap Editor

LIDP Terrminal
& Options Fl12

Tools Description

% mE Programmer F11 |Run mikroElektronika Programmer
Bl UsaRT Terminal trl+T |Run USART Terminal
5 EEPROM Editar Run EEPROM Editor
A Asci Chart Run ASCII Chart
@' Seven Segment Conwvertor Run 7 Segment Display Decoder

Export Code To HTML

Generate HTML code suitable for publishing
source code on the web.

LD Cusktom Character

Generate your own custom Lcd characters

k_h GLCD Bitmap Editor Generate bitmap pictures for Glcd
LDP Terminal UDP communication terminal.
S Options F1z |Open Options window

Related topics: Keyboard shortcuts, Tools Toolbar
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HELP MENU OPTION

&) Help F1

Check For Updates
mikroElekkronika Support Forums
mikroElekkronika Web Page

- How To Reqgister

Ahout
Help Description
@ Help F1 |Open Help File.
Quick Help.
Check For Updates Check if new compiler version is available.

Open mikroElektronika Support Forums in a
default browser.

Open mikroElektronika Web Page in a
default browser.

mikroElekkronika Support Farums

mikroElekkronika Web Page

' How Tao Reqister Information on how to register

About Open About window.

Related Topics:Keyboard shortcuts
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KEYBOARD SHORTCUTS

Below is a complete list of keyboard shortcuts available in mikroPascal PRO for AVR
IDE. You can also view keyboard shortcuts in the Code Explorer window, tab Keyboard.

IDE Shortcuts

F1 Help
Ctrl+N New Unit
Ctri+O Open
Ctrl+Shift+O Open Project
Ctrl+Shift+N Open New Project
Ctrl+K Close Project
CtrlI+F9 Compile
Shift+F9 Compile All
Ctrl+F11 Compile and Program
Shift+F4 Compile and Program
Ctrl+Shift+F5 Clear breakpoints
F11 Start AVRFlash Programmer
F12 Preferences

Basic Editor Shortcuts
F3 Find, Find Next
Shift+F3 Find Previous
Alt+F3 Grep Search, Find in Files
Ctrl+A Select All
CtrlI+C Copy
Ctrl+F Find
CtrI+R Replace
Ctrl+P Print
Ctrl+S Save unit
Ctrl+Shift+S Save All
Ctrl+Shift+V Paste
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Ctrl+X Cut
Ctrl+Y Delete entire line
Ctrl+Z Undo
Ctrl+Shift+Z Redo

Advanced Editor Shortcuts
Ctrl+Space Code Assistant
Ctrl+Shift+Space Parameters Assistant
Ctrl+D Find declaration
Ctrl+E Incremental Search
Ctrl+L Routine List
Ctrl+G Goto line
Ctrl+J Insert Code Template
Ctrl+Shift+. Comment Code
Ctrl+Shift+, Uncomment Code
Ctrl+number Goto bookmark
Ctrl+Shift+number Set bookmark
Ctrl+Shift+ Indent selection
Ctrl+Shift+U Unindent selection
TAB Indent selection
Shift+TAB Unindent selection
Alt+Select Select columns
Ctrl+Alt+Select Select columns
Ctri+Alt+L Convert selection to lowercase
CtrlI+Alt+U Convert selection to uppercase
Ctri+AlIt+T Convert to Titlecase
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Software Simulator Shortcuts
F2 Jump To Interrupt
F4 Run to Cursor
F5 Toggle Breakpoint
F6 Run/Pause Debugger
F7 Step into
F8 Step over
F9 Debug
Ctrl+F2 Reset
Ctrl+F5 Add to Watch List
CtrlI+F8 Step out
Alt+D Dissasembly view
Shift+F5 Open Watch Window
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IDE OVERVIEW

The mikroPascal PRO for AVR is an user-friendly and intuitive environment:

n] R PRl for AVFIE T Ew
B Edit Yerw Project fun Tooks |Hep
ke FERERR-.-) LD D S a@m BOAEL R PR
B (680 (LR [ (| en @y 06 o @ 1) G | e (5 [ Otioe 2000BRe -
= Led.mpas P R O uteary Mansger " Wch Vakues 7B
[ begin B 0 (e ) BN R 60 &, oo of | w 5@
Delay_ms (500) 2 // You can change the moving speed here 3 g : o
| A R remoe ™
50 St wasabln o bt =t
|& begin o . o
] Saach for vasistle by acveniy name: =
RHEL i= 'miXEGELENTEORAKA'} o £
BAEZ 1% 'EASTAVRSA': &
naEd 1= Legdbint: B
TATA 1= exmmplets - ) S
. ol {k oo0l 4
[&] 0% LR
Lod_Cid (LED_CLEAR) 3 /F Clear dispiay 1 105 e
Led_Cmd (LCD_CURSOR_OFT) 2 £/ cusser off @ 07 OeE
50 LCD_Que (1,6, exed): /4 Write text in first roew el H et0i>
LED_Oue {2, 6, txcd) 2 /7 Weits text in second Eow 2 m outiee
Delay_me (2000} 5] & e
Led_Cmd (LED_CLEAR) 3 /4 Clear display O] 18 eo0m
m 0 Tt
1.C0 I U] 107 otz
LED_but (2, 4, txci}s i 1 18 o073
Delay_ms(500) H [0} 1 o074
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b
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fe sbLCDOEN: st g =
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N Insert ChmikroPascal PRO for AVR\E

- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code Assistant,
Parameters Assistant, Spell Checker, Auto Correct for common typos and Code Tem
plates (Auto Complete).

- The Code Explorer (with Keyboard shortcut browser and Quick Help browser) is at your
disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings window

- Library manager enables simple handling libraries being used in a project

- The Error Window displays all errors detected during compiling and linking.

- The source-level Software Simulator lets you debug executable logic step-by-step by
watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create a project.

- Help files are syntax and context sensitive.
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- Like in any modern Windows application, you may customize the layout of
mikroPascal PRO for AVR to suit your needs best.

- Spell checker underlines identifiers which are unknown to the project. In this way it helps
the programmer to spot potential problems early, much before the project is compiled.

- Spell checker can be disabled by choosing the option in the Preferences dialog (F12).
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CUSTOMIZING IDE LAYOUT

Docking Windows

You can increase the viewing and editing space for code, depending on how you
arrange the windows in the IDE.

Step 1: Click the window you want to dock, to give it focus.

] % LedBlinking.mppay
4007 Sources

o LedBlinking. mpas

i {7 Binaries

-7 Project level defines

i) Image Files

{77 Qukput Files

Step 2: Drag the tool window from its current location. A guide diamond appears.
The four arrows of the diamond point towards the four edges of the IDE.
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Step 3: Move the pointer over the corresponding portion of the guide diamond. An
outline of the window appears in the designated area.

Step 4: To dock the window in the position indicated, release the mouse button.

Tip: To move a dockable window without snapping it into place, press CTRL while
dragging it.

Saving Layout

Once you have a window layout that you like, you can save the layout by typing the
name for the layout and pressing the Save Layout Icon E .

To set the layout select the desired layout from the layout drop-down list and click
the Set Layout Icon .

To remove the layout from the drop-down list, select the desired layout from the list
and click the Delete Layout Icon .

Diebug Layout

<Default Layout:
Code Layout

Debug Layout
layout
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Auto Hide

Auto Hide enables you to see more of your code at one time by minimizing tool windows
along the edges of the IDE when not in use.

- Click the window you want to keep visible to give it focus.
- Click the Pushpin Icon Z£ on the title bar of the window.

[l ]
E=| Project Manager ]
) W ; L=
— — —
A-\% FirstProject.mppay 2= [E=] Project Mana 5=
4 -] Sources il = - -
g secondProject. mpas |— —| b % —
[ Binaries 4| 4 13)_7 FirstPro g gE] E
1 Project level defines N 44 E_IDLIFI % P
] Image Filas ElE % Tl %.
) Oukput Files [ Binary = at
[ Other Files [ Proje =
1 Imag é
[ Cutp 2
- 7tk -
EREEEEEEEEEEEE EEEE A = =
IIIIIIIIIIIIIIIIIIIII’
w

When an auto-hidden window loses focus, it automatically slides back to its tab on the edge
of the IDE. While a window is auto-hidden, its name and icon are visible on a tab at the edge
of the IDE. To display an auto-hidden window, move your pointer over the tab. The window
slides back into view and is ready for use.
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ADVANCED CODE EDITOR

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.
General code editing is the same as working with any standard text-editor, including
familiar Copy, Paste and Undo actions, common for Windows environment.

Advanced Editor Features

- Adjustable Syntax Highlighting

- Code Assistant

- Code Folding

- Parameter Assistant

- Code Templates (Auto Complete)
- Auto Correct for common typos

- Spell Checker

- Bookmarks and Goto Line

- Comment / Uncomment

You can configure the Syntax Highlighting, Code Templates and Auto Correct from
the Editor Settings dialog. To access the Settings, click Tools » Options from the
drop-down menu, click the Show Options Icon g or press F12 key.
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Options

==

IV Editor

Project Files

W Restore Last Opened Praject

W Save Breakpaints

Editor Settings

" Restore all Opened Files

W Save Bookmarks

TF Opened File Is Externally Modified
[C‘ Prampt For action

@ Relnad file, but do not prompk

() Ignore externally made changes

AUt Save

W Enable Auto Save
Highlighter

[ Highlight: beqin..end pairs
W Highlight: brackets
Speling

W Check speling

Timeout Interval: 3

minutes

Comment skyle
®

@ {f {single line)

Advanced Editor Options

3 Open options dialog

Code Folding
W Enable code falding

I Show Ident Guides

Apply Cancel

Code Assistant

If you type the first few letters of a word and then press Ctrl+Space, all valid identifiers match-
ing the letters you have typed will be prompted in a floating panel (see the image below). Now
you can keep typing to narrow the choice, or you can select one from the list using the key-
board arrows and Enter.

sp

wariahle
wvariable
wariahle

sfr GPDR: byte
sfr SPeR: byte
sfr SPCR: byte
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Code Folding

Code folding is IDE feature which allows users to selectively hide and display sec-
tions of a source file. In this way it is easier to manage large regions of code within
one window, while still viewing only those subsections of the code that are relevant
during a particular editing session.

While typing, the code folding symbols (|| and ) appear automatically. Use the
folding symbols to hide/unhide the code subsections.

h?egin

PORTL :=0;

PORTE :=0;

Led Init():

LoD Out(1,1,txt[0]);
LCD_out{Z,1,txt[1]):
delay ms(1000] ;

Led Cmd(l):

LCD_Ouril,1,txt[1]):
LCD _Out(Z,4,txt[Z2]):
delay ms(500) ;

end.

hegin |_|

If you place a mouse cursor over the tooltip box, the collapsed text will be shown in
a tooltip style box.

hegin [?ﬂ
i o
begin

PORTL := 0;

PORTE := 0;

Led Indit ()

LCD_out (1,1,txt[0]);
LCD out(2,1,txc[1]);
delay _ms (1000) ;

Led Cmd (1)

LD out(1,1,.txt[1]):
LeD out (2,4, txt[2]);
delay ms(500) ;

end;
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Parameter Assistant

The Parameter Assistant will be automatically invoked when you open parenthesis
“(” or press Shift+Ctrl+Space. If the name of a valid function precedes the parenthe-
sis, then the expected parameters will be displayed in a floating panel. As you type
the actual parameter, the next expected parameter will become bold.

channel : byte
ADC Res

Code Templates (Auto Complete)

You can insert the Code Template by typing the name of the template (for instance,
whiles), then press Ctrl+J and the Code Editor will automatically generate a code.

You can add your own templates to the list. Select Tools » Options from the drop-
down menu, or click the Show Options Icon g‘ and then select the Auto Com-
plete Tab. Here you can enter the appropriate keyword, description and code of your
template.

Autocomplete macros can retreive system and project information:

- $DATES - current system date

- $TIMES - current system time

- ¢DEVICES - device(MCU) name as specified in project settings
- $DEVICE CLOCKS - clock as specified in project settings

- $COMPILERS - current compiler version

These macros can be used in template code, see template ptemplate provided with
mikroPascal PRO for AVR installation.

Auto Correct

The Auto Correct feature corrects common typing mistakes. To access the list of rec-
ognized typos, select Tools » Options from the drop-down menu, or click the Show
Options Icon g‘ and then select the Auto Correct Tab. You can also add your
own preferences to the list.

Also, the Code Editor has a feature to comment or uncomment the selected
code by simple click of a mouse, using the Comment Icon .} | and Uncom-
ment Icon {1 | from the Code Toolbar.
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Spell Checker

The Spell Checker underlines unknown objects in the code, so they can be easily
noticed and corrected before compiling your project.

Select Tools » Options from the drop-down menu, or click the Show Options
Icon g and then select the Spell Checker Tab.

Bookmarks

Bookmarks make navigation through a large code easier. To set a bookmark, use
Ctrl+Shift+number. To jump to a bookmark, use Ctrl+number.

Goto Line

The Goto Line option makes navigation through a large code easier. Use the short-
cut Ctrl+G to activate this option.

Comment / Uncomment

Also, the Code Editor has a feature to comment or uncomment the selected
code by simple click of a mouse, using the Comment Icon {1 and Uncom-
ment Icon {1 from the Code Toolbar.
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CODE EXPLORER

The Code Explorer gives clear view of each item declared inside the source code.
You can jump to a declaration of any item by right clicking it. Also, besides the list of
defined and declared objects, code explorer displays message about first error and
it's location in code.

Code Explarer [
=gl
QUses
4 [@main
- @ LCD RS
@ LCD_EM
- @ LCD D4
@ LCD_DS
- @ LCD D6
@ LCDh D7
@ LCD_RS_Direction
@ LCD_EMN_Direction
~ @ LCD_D4_Direction
@ LCD_DS_Direction
- @ LCD_DA_Direction
@ LCD_D7_Direction
S vau |
@tz
S o'y o]
@ twtd
@
GMove_Dela\;

Icon Description

Tg’ Expand/Collapse all nodes in tree.

e Locate declaration in code.
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ROUTINE LIST

Routine list diplays list of routines, and enables filtering routines by name. Routine list win-
dow can be accessed by pressing Ctrl+L.

You can jump to a desired routine by double clicking on it.

[0 Liwary tosnsger
IR ] o] ]

0= L e e e T e e e o e e e =T
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PROJECT MANAGER

Project Manager is IDE feature which allows users to manage multiple projects.
Several projects which together make project group may be open at the same time.
Only one of them may be active at the moment.

Setting project in active mode is performed by double click on the desired project
in the Project Manager.

Project Manager =]
g | 2 | B 20 ey | [P | S0
.11_-{‘_, LedBlinking.mppay
4. Sources
% LedElinking.mpas
[ Binaries
1 Project level defines
1 Image Files
-] Qutpuk Files
5| LedBlinking. hex
£=| LedBlinking, asm
% LedBlinking. |st
(1 Other Files

Following options are available in the Project Manager:
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Following options are available in the Project Manager:

Icon Description

Save project Group.

Open project group.

Close the active project.

Close project group.

Add project to the project group.

Remove project from the project group.

Add file to the active project.

Remove selected file from the project.

Build the active project.

[ | U] O | (| Cs | 08| G5 | 58 | P

Run mikroElektronika's Flash programmer.

For details about adding and removing files from project see Add/Remove Files
from Project.

Related topics: Project Settings, Project Menu Options, File Menu Options, Project
Toolbar, Build Toolbar, Add/Remove Files from Project
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PROJECT SETTINGS WINDOW

Following options are available in the Project Settings Window:

- Device - select the appropriate device from the device drop-down list.
- Oscillator - enter the oscillator frequency value.

I—lﬂ
Project Settings

Name: | 4TMEGALE -

oo I

Value: | 10.000000| MHz
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LIBRARY MANAGER

Library Manager enables simple handling libraries being used in a project. Library
Manager window lists all libraries (extencion .mc1) which are instantly stored in the
compiler Uses folder. The desirable library is added to the project by selecting check

box next to the library name.

In order to have all library functions accessible, simply press the button Check All

"] and all libraries will be selected. In case none library is needed in a project,

press the button Clear All "] and all libraries will be cleared from the project.

Only the selected libraries will be linked.

Library banager [

» ] aDc

> [7] Butkon

Ol _Type

- [¥] cam_sPI

- [] Compact_Flash_FaT16
> [T] Compact_Flash
> [7] Conversions

- [ EEFROM

- [ FLASH

L[] Gled_Fants

- [¥] Gled

> [0 kevpaddxd
&[T Led_Constants
2 [ Led

> [] Manchesker

- [ Mmc_FaT16

> [ Mmc

> 0] One_Wire

- [¥] Part_Expandsr
2 [ psz

> [T P

- O] et

- [ rs4as

> [7] software_I2C
> [7] Software_SPI
> [7] Software_UART
> [0 sound

- ] sP1_lcd

- [7] 5PI_Led

- ] SPI_Leds

- [¥] SPI_TR9R3C

- [C] Teeeac

> [ Time

> [T] Trigonometry

- 0] Tw
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Icon Description
= Refresh Library by scanning files in "Uses" folder.Useful when new
= libraries are added by copying files to "Uses" folder.
Y Rebuild all available libraries. Useful when library sources are available and
e need refreshing.
W Include all available libraries in current project.
i No libraries from the list will be included in current project.
= Restore library to the state just before last project saving.

Related topics: mikroPascal PRO for AVR Libraries, Creating New Library
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ERROR WINDOW

In case that errors were encountered during compiling, the compiler will report them and won’t gener-
ate a hex file. The Error Window will be prompted at the bottom of the main window by default.

The Error Window is located under message tab, and displays location and type of errors the
compiler has encountered. The compiler also reports warnings, but these do not affect the out-
put; only errors can interefere with the generation of hex.

Messages =]
Errors ‘Warnings Hinks
Line Message Mo,  Message Text Lnik
o 1 mP&VR.exe -DEG -pATMEGALE -MSF -¥ -DL -011111114 -fod -..,
0 132 Carnpilation Started CPROGRAM FILES|MIKROELEKTRONIKAMIKROPASCAL PRO FOR AVRY...
43 304 Swntax error: Expected ") buk "end" Found Sound.mpas
45 301 "procedure"is not valid idenkifier Sound.mpas
45 304 Syntax error: Expected "end" but "procedure Found Sound.mpas
45 304 Syntax error: Expected ;" buk "Melody” Found Sound.mpas
45 304 Swntax error: Expected "." but (" Found Sound.mpas
i} 102 Finishied {with errors): 29 Moy 2008, 09:35:07 Sound. mppasy

Double click the message line in the Error Window to highlight the line where the error was
encountered.

Related topics: Error Messages
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STATISTICS

After successful compilation, you can review statistics of your code. Click the Statistics

Icon [fid .

Memory Usage Windows
Provides overview of RAM and ROM usage in the form of histogram.

RAM MEMORY
Rx Memory Space

Displays Rx memory space usage in form of histogram.

Statistics

4 - Memory Usage

RAM Memory Usage (locations)

| 50% ot 32 | 16 Free RxDsta RAM
16 Uzed RxData RAM

- ROM Allocation
4 Procedures

‘- Locations
- HTHL

Free RxData Rahd Uszed RxData R
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Data Memory Space

Displays Data memory space usage in form of histogram.

4 - Memory Uzage

1,015 Free data RAM
9 Used data RAM

- AOM Allocation
4 - Procedures

- Size

- Locations

Special Function Registers

Summarizes all Special Function Registers and their addresses.

4 -Memory Usage
4 RAM Special function registers [SFR)
Rl ata
% Address Register
SFR 0x00
GPR 0401 A1

4 ROM
‘.. FOM Allacation D42 A2

4 Procedures 0:03 R3
o Size 0:04 R4
- Locations 005 RS
= HTHL 0406 Rt
007 R7
0x08 R&
003 R3
004 R10
0x0B R11
0:0C R12
000 R13
0x0E R14
0:0F R15
010 R16
011 R17
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General Purpose Registers

Summarizes all General Purpose Registers and their addresses. Also displays sym-
bolic names of variables and their addresses.

Statistics

4 - Memory Uszage

General purpose registers [GPR]
Address Register
Ox60 E: [_Lib i ]
0«62 DefDevicedddress  [__Lib SPIGled_DefDevicedddiess)
. FIOM Allocation 063 spifontwd Lk SPIGIed_spitontw]
4 - Procedures 064 spifontH  [__Lib_SPIGIcd_spifontH]
é---Size 065 spifontDef  [_spifontDief]
- Locations 0467 Sp_Ad Ph o [Spi_Rd Pl
“ HTML

Inaccessible color  [FARG_SPI_Gled_H_Line+3)

Inaccessible loc  [SPI_Gled_H_Line_loc_L0)

Inaccessible y_poz  [FARG_SPI_Gled_H_Line+2)

Inaccessible «_start  [FARG_SPI_Glod_H_Line+0]

Inaccessible #_end  [FARG_SPI_Gled_H_Line+1)

Inaccessible data_out [FARG_SPI1_Read+0]

Inaccessible colar  [FARG_SPI_Gled_W_Line+3)

Inaccessible loc  [SPI_Gled %_Line_loc_L0)

Inaccessible #_poz  [FARG_SPI_Gled_V_Line+2)

Inaccessible y_stat  [FARG_SPI_Gled V_Line+0]

Inaccessible y end [FARG_SPI_Glcd ¥ _Line+1] I
Inaccessible Flatrl _SPI_Gled =

ROM MEMORY
ROM Memory Usage

Displays ROM memory usage in form of histogram.

Statistics

4 - Memory Uszage
4 600 Free ROM
9,734 Used RO

ROM Memory Usage (ytes)

.. ROM Allacation
4 - Procedures

Size

. Locations
“ HTML

Fres ROM Lized ROM
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ROM Memory Allocation
Displays ROM memory allocation.
Statistics =
4 Memery Usage 020000  0x0CI4ZA ~
Ox0004  0x0C3400 ‘_W
0x0008 0x0C2400 I
0x000C  0x0CS9400
0x0010  0x0CI400
0Ox0014  0x0C3400
. 0x0018 0x0C2400
H = 0x001C 0x0CS9400
Bk Al aticr 0x0020  0x009400
4 -Procedures 0x0024  0x0C5400
Size 0x00Z8  0x0C9400
i Locations 0x00ZC  0x0C9400
- HTML 0x0030  0x0CI400
0Ox0034  0x0C3400
0x0038 0x0C2400
0x002C  0x0CS9400
0x0040  0x0CI400
Ox0044d  0x0C3400
0x0048 0x0C2400
0x004C  0x0CS9400
0x0050  0x0CI400
Ox15FZ OxZZES
Ox15F4 OxlBEZ
Ox1E5F& 0x00ED
0xLEFS  0x0A9E
Ox15FA OxFlF7
Ox15FC Oxlast
4 »
Procedures Windows
Provides overview procedures locations and sizes.
Procedures Size Window
Displays size of each procedure.
Statistics B
4 - Memory Uzage |
4-Ram ROM usage by procedure (ROM locations)
- RxData ; : i !
'g::' Delay_1us £ : - : : :
'GPH HrMUI_1 Bx16 §
4 Ao Expanch RSP: _j E:Ad
L ROM Allacation . er_. ea. e
4 Procedures Expander_Set_DirectionPortB
= Expander_Wiite_PortB
i Locations SPH _Init_Advanced
o HTML SPI_Gled__Line

SPI_Glod_Set_Paoe
SPI_Strobe
SPI_Gled_Set_Side
Expander_Wiite_Byte
SP|_Glcd_Rectangle
SPI_Glod_Read_Data
SPI_Glod_Fil
SPI_Glod_Image
SPI_Glod_Line

main

200 300
ROM locations
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Procedures Locations Window

Displays how functions are distributed in microcontroller’'s memory.

4 - Memory Uzage

HTML Window

Display statistics in default web browser.

4 -Memory Usage
You can generate statistics in HTML format too. it is suitable for printing and for documenting your
project.

Press the button bellow to generate HTML statistics and to open them in the default web browser

- ROM Allacation
4 - Procedures iews HTML stalistics
Size
- Locations
-~ HTML
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INTEGRATED TOOLS

USART Terminal

The mikroPascal PRO for AVR includes the USART communication terminal for
RS232 communication. You can launch it from the drop-down menu Tools » USART
Terminal or by clicking the USART Terminal Icon Eli from Tools toolbar.

RS232 Terminal =]
—Settings —Communication
Corn Port: Echo Send '?'la
' Q600 7 : i [ F
Baud: Append: © CR Send as 8N (oo Logaing |
Stop Bits: (9N Stap Bit e LF Send as number
. Clear Histo
Check Parity R‘_ecewe data a - -
: - @ ASCII 1 HEX ) DEC
Data bits: |Eight -4
Command Connected to COM3 -
R_IS Q_TR Sent: Echo
9 off @ off
" on " on

Connect | Lisconmect

—Statu
Send Receive CTS DsR
[*] [*] [~ ©
—Log File
o
Read from:
Mrite to:

W Append to W Create file
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ASCII Chart

The ASCII Chart is a handy tool, particularly useful when working with Lcd display.
You can launch it from the drop-down menu Tools » ASCII chart or by clicking the
View ASCII Chart lcon | from Tools toolbar.

Ascii Chart [

of1|2|3|4 | 5|6 |7 |8 |9 |A|B|C|D|E F

MNUL SOH STX ETx EOT EMNOQ ACK BEL |BS HT LF ¥T FF CR |50  SI

0
u] 1 2 3 4 5 =] 7 g El 10 11 12 13 14 15
4 |PLE DC1 DC2 DC3 DC4 NAK SYN ETB CAN EM SUB ESC FS GS RS US
16 17 18 19 20 21 22 23 24 25 26 27 25 29 30 3l
o |SPC ! " # % % N N A T T I I I
32 33 a4 35 36 37 1] 39 40 41 42 43 44 45 46 47
g|?|1[2|3[4|5 (6|7 (8|09 :|; |[<|=[>]?
45 49 50 51 52 53 54 =) 56 57 55 59 (=11 (=} 62 63
4|® A B C D E F G H I 1 K L M N O

64 | 65 | 66 | 67 | B8 69 | Y0 | 7l | YE | V3 V4 | Y5 Ve | Y7 Ve | 79
5 P O R S5 T Uu ¥ W X Y |2 [ b, ] =

g0 | 81 | 82 | 83 | 8 | 85 | 86 92 | 93 [ 94 | 95

6 N a b ¢ d e f | m ©n O

96 | 97 | 9% | 99 | 100 | 101 | 102 108 | 109 | 110 111
7 P q r s t u v | ¥ ~ DEL

112 | 113 | 114 115 | 116 | 117 | 118 124 | 125 | 126 | 127
8 E ’ F R . T E 2

128 | 129 | 130 | 151 | 132 | 133 | 134 | 135 | 136 | 157 | 138 | 139 | 140 | 141 [ 142 | 143

1 » u » - _ _ - T H y o= 3 ili

]

144 | 145 | 146 | 147 | 148 | 149 | 150 | 151 | 152 | 153 | 154 | 155 | 156 | 157 | 158 | 159
A i ¢ | £ | o | ¥ i g BRI “ a0 - B

160 | 161 | 162 | 163 | 164 | 165 | 166 | 167 | 168 | 169 | 170 | 171 | 172 | 173 [ 174 | 175
gl £/ " w9 -, t]0o » v e % i

176 [ 177 | 178 | 179 | 180 | 151 | 152 | 183 | 184 | 185 | 186 | 187 | 185 | 189 [ 190 | 191
C AlA A A A A |E C E E E E I 1 I 1

192 | 193 | 194 | 195 | 195 | 197 | 195 | 199 | 200 | 201 | 202 | 203 | 204 | 205 | 206 | 207
D b N ] ] ] ] 0 ® @ u u u u Y u] n

208 [ 209 | 210 | 211 | 212 | 213 | 214 215 | 216 | 217 | 218 | 219 | 220 | 221 | 222 | 223
e |2 4 a/a a & a|c¢c|e | 6 |&| &8 i i i|T
224 | 225 | 226 | 227 | 220 | 229 | 230 | 231 | 232 | 233 | 234 | 235 | 236 | 237 | 236 | 239
F a A o o6 | 46 o o6 | +|&e 0 o 0| a v p| @
290 | 241 | 242 | 243 | 244 | 245 | 246 | 247 | 248 | 299 | 250 | 251 | 252 | 253 | 254 | 258
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EEPROM Editor

The EEPROM Editor is used for manipulating MCU's EEPROM memory. You can
launch it from the drop-down menu Tools » EEPROM Editor. When Use this EEPROM
definition is checked compiler will generate Intel hex file project_name.ihex that con-
tains data from EEPROM editor.

When you run mikroElektronika programmer software from mikroPascal PRO for AVR
IDE - project name.hex file will be loaded automatically while inex file must be
loaded manually.

mikraElektronika EEFROM Tool |
i//' E E PROM Editor [[]use Eeprom in project Help

Device: EEPROM Size: EEPROM Fill: EEPROM File

Custom = vislzB‘ftes ¥alue: Ox FF | Fill | | Load | | Save |

EEPROM Data

[IE) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PV RV
[IEl rF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PR
[IX) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF R R
[IEl rF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF PR
[2) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF ¥

[T}{) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF ST RV
(i) FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FRPVE R
[T} FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF YRRV <
EEPROM Edit:

Input Format: Edit Yalue:

n EEPROM Address: i —

| Dec Hex No: Ox Edit

@ Hex Start Address: 0% FFFF

- Float Il Size:

= oa | AutoInc | Byte ) Word @ DWord

) String
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7 Segment Display Decoder

The 7 Segment Display Decoder is a convenient visual panel which returns deci-
mal/hex value for any viable combination you would like to display on 7seg. Click on
the parts of 7 segment image to get the requested value in the edit boxes. You can
launch it from the drop-down menu Tools » 7 Segment Decoder or by clicking the
Seven Segment Icon |E| from Tools toolbar.

Seven Segment Editor B

Common cathode:
0w

Common anode:
Decoding Farmat:
' Decimal
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UDP Terminal

The mikroPascal PRO for AVR includes the UDP Terminal. You can launch it from
the drop-down menu Tools » UDP Terminal.

UDP Communication Terminal -7 |[=]
Settings
|P &ddress: |192.16%.20.25
Port: 10001
Send:
| riikroE lektranik a Send
Append: [ CR [~ Send as typing
[~ LF [~ Send as number
mikroE lektronik.a -
P b
Clear
Receive
& ASCII " HE= " DEC

Clear
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Graphic Lcd Bitmap Editor

The mikroPascal PRO for AVR includes the Graphic Lcd Bitmap Editor. Output is the
mikroPascal PRO for AVR compatible code. You can launch it from the drop-down menu
Tools > Glcd Bitmap Editor.

|mikrcEIektrcnilca Graphic LCD Bitmap generator

File lnaded: truck.bmp

Pickure preview — 128x64 pix J bw
[ LoadBMPFictors |

[ Create CODE |

EE——
[ invertPIcTURE |

GLCD Size | controller

'
s GLCD Picture name: truck.bmp
#¢ GLCD Model: KS@1iA8 128x64

o

m| »

Copy CODE to Clipboard

const truck_bmp aEray[1824] of hyte = ¢

»

- 8. B8, - - - - » 8. 8. B, 12, 12, 12, 12.
12. 1@, 18, 18, 18, 18, 18, 2. 9?7, 2. 2. 9, - 2. - -
2. 9. 9, - 9. 9. 2, » 9. 2.137.137,137.137.137.137.
137.13%7.137,132.137.137,137,. 2, 2. 2. 2. 2. 9. 2. 9. 2.
‘J‘B, %, 1%.25%, 1%.193, 63,25%. g. g, g. g. g, g. g. g,

ver: 2,01 - 27012005 System status: Win NT like OS
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Lcd Custom Character

mikroPascal PRO for AVR includes the Lcd Custom Character. Output is mikroPas-
cal PRO for AVR compatible code. You can launch it from the drop-down menu
Tools > Lcd Custom Character.

.__“ LCD custom character E!—F—'
B & -
e = = = = =
hx{ Hx10 Save.. Load... Fill all Clear all Invert
Font ————— Preview:

* Bw 7+ curzor line
By 10+ cursor line

CGRAM address:

Char: Il:I 3"
Char data row: Il:I 3"

GENERATE

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 63



CHAPTER 2
Environment mikroPASCAL PRO for AVR

MACRO EDITOR

A macro is a series of keystrokes that have been 'recorded' in the order performed.
A macro allows you to 'record' a series of keystrokes and then 'playback’, or repeat,
the recorded keystrokes.

Macros &
o b |1 | &

Mame

Macrod

1| 1] ' b

The Macro offers the following commands:

Icon Description

o Starts 'recording' keystrokes for later playback.

Ei? Stops capturing keystrokesthat was started when the Start Recordig com-
mand was selected.

;@3’ Allows a macro that has been recorded to be replayed.
= New macro.
G Delete macro.

Related topics: Advanced Code Editor, Code Templates
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OPTIONS

Options menu consists of three tabs: Code Editor, Tools and Output settings

Code editor

The Code Editor is advanced text editor fashioned to satisfy needs of professionals.

Tools

The mikroPascal PRO for AVR includes the Tools tab, which enables the use of shortcuts to

external programs, like Calculator or Notepad.
You can set up to 10 different shortcuts, by editing ToolO - Tool9.

Tool Mame: Taold

File Name: Press button to open File dialog

Parameters:

Macio: s5HEX_FILE_MAE Fullpath andnams of the o, +  Insatt

F11 -

$ Clear ol fields |

Output
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Output settings

By modifying Output Settings, user can configure the content of the output files.
You can enable or disable, for example, generation of ASM and List file.

Also, user can choose optimization level, and compiler specific settings, which include case sensitiv-
ity, dynamic link for string literals setting (described in mikroPascal PRO for AVR specifics).

Build all files as library enables user to use compiled library (+ .mc1) on any AVR MCU (when this
box is checked), or for a selected AVR MCU (when this box is left unchecked).

For more information on creating new libraries, see Creating New Library.

Optiong @

Cukput Setkings

W Generate ASM file
¥ Indude HEX opcodes
¥ Include ROM constants
¥ Include ROM Addresses

W Generate list File
V' Indude debug info

W Incdude source lines in oukput Files

Optimization level:

Four =

Compiler

W Case sensitive
W' Drynamic link For string literals

W Build all files as library

oK Apply Cancel

66 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroPASCAL PRO for AVR Environment

REGULAR EXPRESSIONS
Introduction

Regular Expressions are a widely-used method of specifying patterns of text to
search for. Special metacharacters allow you to specify, for instance, that a particu-
lar string you are looking for, occurs at the beginning, or end of a line, or contains n
recurrences of a certain character.

Simple matches

Any single character matches itself, unless it is a metacharacter with a special
meaning described below. A series of characters matches that series of characters
in the target string, so the pattern "short" would match "short" in the target string.
You can cause characters that normally function as metacharacters or escape
sequences to be interpreted by preceding them with a backslash "\ .

For instance, metacharacter "~" matches beginning of string, but "\~" matches
character "~", and "\\" matches "\", etc.

Examples :

unsigned matches string 'unsigned'
\ “unsigned matches string '“unsigned'’

Escape sequences

Characters may be specified using a escape sequences: "\n" matches a newline,
"\ t" a tab, etc. More generally, \xnn, where nn is a string of hexadecimal digits,
matches the character whose ASCII value is nn.

If you need wide (Unicode) character code, you can use '\x{nnnn}', where 'nnnn'
- one or more hexadecimal digits.

\xnn - char with hex code nn

\x{nnnn) - char with hex code nnnn (one byte for plain text and two bytes for Unicode)
\t - tab (HT/TAB), same as \x09

\n - newline (NL), same as \x0a

\r - car.return (CR), same as \x0d

\£ - form feed (FF), same as \x0c

\a - alarm (bell) (BEL), same as \x07

\e - escape (ESC) , same as \x1b

Examples:

unsigned\x20int matches 'unsigned int' (note space in the middle)
\tunsigned matches 'unsigned' (predecessed by tab)
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Character classes

You can specify a character class, by enclosing a list of characters in [ 1, which will
match any of the characters from the list. If the first character after the [ " is "~",
the class matches any character not in the list.

Examples:

count[aeiou]r finds strings 'countar', 'counter', etc. but not 'countbr',
"countcr', etc.

count[*aeiou]r finds strings 'countbr', 'countcr', etc. but not 'countar’,

'counter', efc.

Within a list, the "-" character is used to specify a range, so that a-z represents all
characters between "a" and "z", inclusive.

If you want "-" itself to be a member of a class, put it at the start or end of the list,
or precede it with a backslash.
If you want '], you may place it at the start of list or precede it with a backslash.

Examples:

[-az] matches 'a', 'z' and '-'
[az-] matches 'a', 'z'and '-’
[a\-z] matches 'a', 'z'and '-'

[a-z] matches all twenty six small characters from 'a' to 'z’
[\n-\x0D] matches any of #10,#11,#12, #13.

[\d-t] matches any digit, '-' or 't'.
[1-a] matches any char from ']'.."a".
Metacharacters

Metacharacters are special characters which are the essence of regular expres-
sions. There are different types of metacharacters, described below.

Metacharacters - Line separators

~ - start of line

$ - end of line

\2 - start of text

\z - end of text

. - any character in line
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Examples:

~PORTA - matches string ' porT2a ' only if it's at the beginning of line
PORTAS - matches string ' porT2 ' only if it's at the end of line
~PORTAS - matches string ' porTa ' only if it's the only string in line
PORT . r - matches strings like 'PORTA', 'PORTB', 'PORT1' and SO On

The "~ metacharacter by default is only guaranteed to match beginning of the input
string/text, and the "$" metacharacter only at the end. Embedded line separators
will not be matched by ~" or "s".

You may, however, wish to treat a string as a multi-line buffer, such that the "~ will match
after any line separator within the string, and "$" will match before any line separator.
Regular expressions works with line separators as recommended at
http://www.unicode.org/unicode/reports/tr18/

Metacharacters - Predefined classes

\w - an alphanumeric character (including " ")

\w - a nonalphanumeric character

\d - a numeric character

\D - a non-numeric character

\s - any space (same as [\t\n\r\£])

\s - a non space

You may use \w, \d and \s within custom character classes.

Example:

routi\de - matches strings like 'routile', 'routiée' and so on, but not 'routine’,
"routime' and so on.

Metacharacters - Word boundaries

Aword boundary ("\b") is a spot between two characters that has an alphanumeric char-
acter ("\w") on one side, and a nonalphanumeric character ("\w") on the other side (in
either order), counting the imaginary characters off the beginning and end of the string as
matching a "\w".

\b - match a word boundary)
\B - match a non-(word boundary)
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Metacharacters - Iterators

Any item of a regular expression may be followed by another type of metacharac-
ters - iterators. Using this metacharacters,you can specify number of occurences of
previous character, metacharacter or subexpression.

* - zero or more ("greedy"), similar to {0,}

+ - one or more ("greedy"), similar to {1,}

2 - zero or one ("greedy"), similar to {0,1}

{n} - exactly n times ("greedy")

{n,} - at least n times ("greedy")

{n,m} - at least n but not more than m times ("greedy")
*2 - zero or more ("non-greedy"), similar to {0,}?

+? - one or more ("non-greedy"), similar to {1,}?

22 - zero or one ("non-greedy"), similar to {0,1}?

{n}? - exactly n times ("non-greedy")

{n,}? - at least n times ("non-greedy")

{n,m}? - at least n but not more than m times ("non-greedy")

So, digits in curly brackets of the form, { n, m} , specify the minimum number of times to
match the item n and the maximum m. The form {n} is equivalent to {n,n} and matches
exactly n times. The form {n, } matches n or more times. There is no limit to the size of
n or m, but large numbers will chew up more memory and slow down execution.

If a curly bracket occurs in any other context, it is treated as a regular character.
Examples:

count.*r B- matches strings like 'counter', 'countelkjdflkj9r' and 'countr'
count.+r - matches strings like 'counter', 'countelkjd£1kj9r' but not 'countr’
count.?r - matches strings like 'counter', 'countar' and 'countr' but not
'countelkjOr’

counte{2}r - matches string 'counteer’

counte{2, }r - matches strings like 'counteer', 'counteeer', 'counteeer' etc.

counte{2,3}r - matches strings like 'counteer', Or 'counteeer' but not 'coun-
teeeer'’

A little explanation about "greediness". "Greedy" takes as many as possible, "non-
greedy" takes as few as possible.

For example, 'b+' and 'b*' applied to string 'abbbbc' return 'bbbb', 'b+?'
returns 'b', 'b*>' returns empty string, 'b{2,3}?' returns 'bb', 'b{2,3}"'
returns 'bbb'.
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Metacharacters - Alternatives

You can specify a series of alternatives for a pattern using " |" to separate them,
so that bit|bat|bot will match any of "bit", "bat", or "bot" in the target string
as would "b(i|a|o)t)". The first alternative includes everything from the last pat-
tern delimiter (" (", "[", or the beginning of the pattern) up to the first " | ", and the
last alternative contains everything from the last " | " to the next pattern delimiter.
For this reason, it's common practice to include alternatives in parentheses, to min-
imize confusion about where they start and end.

Alternatives are tried from left to right, so the first alternative found for which the entire
expression matches, is the one that is chosen. This means that alternatives are not nec-
essarily greedy. For example: when matching rou|rout against "routine", only the
"rou" part will match, as that is the first alternative tried, and it successfully match-
es the target string (this might not seem important, but it is important when you are
capturing matched text using parentheses.) Also remember that " | " is interpreted
as a literal within square brackets, so if you write [bit|bat|bot], you're really only
matching [biao|].

Examples:

rou(tine|te) - matches strings 'routine' Or 'route’.
Metacharacters - Subexpressions

The bracketing construct ( ... ) may also be used for define regular subexpres-
sions. Subexpressions are numbered based on the left to right order of their open-
ing parenthesis. First subexpression has number "1’

Examples:

(int) {8,10} matches strings which contain 8, 9 or 10 instances of the "int’
routi ([0-9]|a+)e matches 'routile', 'routile’ , 'routine’,
'routinne', 'routinnne' etc.

Metacharacters - Backreferences

Metacharacters \ 1 through \ 9 are interpreted as backreferences. \ matches pre-
viously matched subexpression #.

Examples:

(.)\1+ matches 'aaaa' and 'cc'.

(.+)\1+ matches 'abab' and '123123"

(['"1?) (\d+)\1 matches "13" (in double quotes), or "4 (in single quotes) or 77
(without quotes) etc
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MIKROPASCAL PRO FOR AVR COMMAND LINE OPTIONS

Usage: mPAvr.exe [ -<opts> [ -<opts>]] [<infile> [ -<opts>]] [ -<opts>]]
Infile can be of * .mpas and *.mcl type.

The following parameters and some more (see manual) are valid:

-p : MCU for which compilation will be done.

-ro : Set oscillator [in MHZ].

-sp : Add directory to the search path list.

-N : Output files generated to file path specified by filename.
-B : Save compiled binary files (+ .mc1) to 'directory’.

-0 : Miscellaneous output options.

-DBG : Generate debug info.

-1 : Check and rebuild new libraries.

-DL : Build all files as libraries.

-v : Dynamic link for string literals.

Example:
mPAvr.exe -MSF -DBG -pATMEGA1l6 -011111114 -fo8 -
N"C:\Lcd\Lcd.mppav" -SP"C:\Program

Files\Mikroelektronika\mikroPascal PRO for AVR\Defs\"
-SP"C:\Program Files\Mikroelektronika\mikroPascal PRO
for AVR\Uses\LTE64KW\" -SP"C:\Lcd\" "Lecd.mpas" "_Lib Math.mcl"
"__Lib MathDouble.mcl"
" _Lib System.mcl" "__ Lib Delays.mcl"
" _Lib LedConsts.mcl" "__Lib Lcd.mcl”

Parameters used in the example:

-Mst : Short Message Format; used for internal purposes by IDE.

-DBG : Generate debug info.

-pATMEGAL6 . MCU ATMEGA16 selected.

-011111114 : Miscellaneous output options.

-fo8 : Set oscillator frequency [in MHZ].

-N"C:\Lcd\ Lcd.mppav" -SP"C:\ Program
Files\Mikroelektronika\mikroPascal PRO for AVR\defs\" : Output files gen-
erated to file path specified by filename.

-SP"C:\ Program Files\Mikroelektronika\mikroPascal PRO for AVR\Defs\"
: Add directory to the search path list.

-SP"C:\ Program Files\Mikroelektronika\mikroPascal PRO for
AVR\Uses\ LTE64KW\ " : Add directory to the search path list.

-sp"c:\Lcd\ " : Add directory to the search path list.

"Lcd.mpas" " Lib Math.mcl" " Lib MathDouble.mcl"
" Lib System.mcl" " Lib Delays.mcl" " Lib LcdConsts.mcl"
" Lib Led.mcl" : Specify input files.
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PROJECTS

The mikroPascal PRO for AVR organizes applications into projects, consisting of a
single project file (extension .mcpav) and one or more source files (extension ).
mikroPascal PRO for AVR IDE allows you to manage multiple projects (see Project
Manager). Source files can be compiled only if they are part of a project.

The project file contains the following information:

- project name and optional description,

- target device,

- device flags (config word),

- device clock,

- list of the project source files with paths,
- image files,

- other files.

Note that the project does not include files in the same way as preprocessor does,
see Add/Remove Files from Project.

New Project

The easiest way to create a project is by means of the New Project Wizard, drop-

down menu Project » New Project or by clicking the New Project Icon .:L from

Project Toolbar.
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New Project Wizard Steps

Start creating your New project, by clicking Next button:

MNew Project Wizard

Welcome to the New Project
Wizard

This wizard helps you:

e Create a new project

s Select the device for your project

¢ Setup device clock and choose device flags
e Select desired memory model

e Add project files

Click Next to continue

Back Mext 5 Cancel

Step One - Select the device from the device drop-down list.

Mew Project Wifizard =3

Select the dewvice you want to use,

Device Mame: ATMEGALG -

4@ Back Mext 5 Cancel

74 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroPASCAL PRO for AVR

CHAPTER 2
Environment

Step Two - Enter the oscillator frequency value.

MNewy Project Wizard

(5]

Setup the clock, for example 11,0592 MHz.

Dewvice Clock: 11.0592EID| MHz

4@ Back

Next & Cancel

Step Three - Specify the location where your project will be saved.

MNews Project YYizard

553
Specify where your project will be saved,

Project File Name:

3\ Projecks|Fir stProjectiFirstPraject . mppav|

4 Back Next o

Cancel
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Step Four - Add project file to the project if they are avaiable at this point. You can
always add project files later using Project Manager.

MNews Project YYizard @

Add project files if they are available at this point.
vou can always add project files |ater using the Project Manager in IDE.

Add File To Project:

[n\Projects|FirstProjectDefinit. mpas E
Filz Mame
[\ProjectsiFir stPraject\Definit. mpas
Remove
Remove All
4 Back Next o Cancel
Step Five - Click Finish button to create your New Project:
MNews Project YYizard @

Step 575

You have successfully created a new project. Click Finish to save the changes
and to close the wizard.

=

N

4 Back _ Finish cancel

Related topics: Project Manager, Project Settings Customizing Projects
Edit Project
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CUSTOMIZING PROJECTS
Edit Project

You can change basic project settings in the Project Settings window. You can
change chip and oscillator frequency. Any change in the Project Setting Window
affects currently active project only, so in case more than one project is open, you have
to ensure that exactly the desired project is set as active one in the Project Manager.

Managing Project Group

mikroPascal PRO for AVR IDE provides covenient option which enables several
projects to be open simultaneously. If you have several projects being connected in
some way, you can create a project group.

The project group may be saved by clicking the Save Project Group Icon % from
the Project Manager window. The project group may be reopend by clicking the
Open Project Group Icon &% .All relevant data about the project group is stored in
the project group file (extension .mpg)

Add/Remove Files from Project
The project can contain the following file types:

- .mpas source files

- .mc1 binary files

- .pld project level defines files

image files

- .hex, .asmand .1st files, see output files. These files can not be added or removed
from project.

- other files
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Praject Manager &

%%L@L@ j_l & |GF E%
4-[74 TB963C_240x128.mppav
4] Sources
£ Te963C_240x128.mpas
% bitmap.mpas
=] Einaries
bitmapz .l
(1 Project level defines
=11 Image Files
sample.jpg
=i Cukput Files
2| TR963C_240x1258.hex
=] TRI63C_240x128.asm
% Te963C_Z40:128.Isk
=1 Other Files
£ DaTA - doc32ss.pdf

The list of relevant source files is stored in the project file (extension .mppav).

To add source file to the project, click the Add File to Project Icon .:‘J5 . Each added
source file must be self-contained, i.e. it must have all necessary definitions after
preprocessing.

To remove file(s) from the project, click the Remove File from Project Icon (= | .

See File Inclusion for more information.
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Project Level Defines
Project Level Defines (.p14) files can also be added to project. Project level define files

enable you to have defines that are visible in all source files in the project. One project
may contain several p1d files. A file must contain one definition per line, for example:

ANALOG
DEBUG
TEST

There are some predefined project level defines. See predefined project level defines

Related topics: Project Manager, Project Settings
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SOURCE FILES

Source files containing Pascal code should have the extension .mpas. The list of
source files relevant to the application is stored in project file with extension .mppav,
along with other project information. You can compile source files only if they are
part of the project.

Managing Source Files
Creating new source file

To create a new source file, do the following:

1. Select File » New Unit from the drop-down menu, or press Ctrl+N, or click the
New File Icon | | from the File Toolbar.

2. A new tab will be opened. This is a new source file. Select File » Save from the
drop-down menu, or press Ctrl+S, or click the Save File Icon |5 from the File
Toolbar and name it as you want.

If you use the New Project Wizard, an empty source file, named after the project with

extension .mpzs, will be created automatically. The mikroPascal PRO for AVR does

not require you to have a source file named the same as the project, it's just a mat-
ter of convenience.

Opening an existing file

Select File > Open from the drop-down menu, or press Ctrl+O, or click the Open File
Icon év from the File Toolbar. In Open Dialog browse to the location of the file
that you want to open, select it and click the Open button.

The selected file is displayed in its own tab. If the selected file is already open, its
current Editor tab will become active.

Printing an open file

1. Make sure that the window containing the file that you want to print is the
active window.

2. Select File » Print from the drop-down menu, or press Ctri+P.

3. In the Print Preview Window, set a desired layout of the document and click the
OK button. The file will be printed on the selected printer.
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Saving file

1. Make sure that the window containing the file that you want to save is the active
window.

2. Select File » Save from the drop-down menu, or press Ctrl+S, or click the Save
File Icon = from the File Toolbar.

Saving file under a different name

1. Make sure that the window containing the file that you want to save is the active
window.

2. Select File » Save As from the drop-down menu. The New File Name dialog will
be displayed.

3. In the dialog, browse to the folder where you want to save the file.

4. In the File Name field, modify the name of the file you want to save.

5. Click the Save button.

Closing file

1. Make sure that the tab containing the file that you want to close is the active tab.

2. Select File » Close from the drop-down menu, or right click the tab of the file that
you want to close and select Close option from the context menu.

4. If the file has been changed since it was last saved, you will be prompted to save
your changes.

Related topics:File Menu, File Toolbar, Project Manager, Project Settings,
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CLEAN PROJECT FOLDER
Clean Project Folder

This menu gives you option to choose which files from your current project you want
to delete.

Files marked in bold can be easily recreated by building a project. Other files should
be marked for deletion only with a great care, because IDE cannot recover them.

Clean Project Folder (3]

Below is the list of all files in the project folder. Files in bald are those
generated by the compiler and they can be easily recreated when the
project is rebuilt,

Select which files you want to remove from the project folder, Please
naote that selected files will be permanently deleted from yvour dislk if

- [¥] spiEthernet.asm ~
-[] SpiEthernet.mpas

-] =piEthernet. mpas.ini

-[7] spiEthernet.cp

-.[#] spiEthernet.dbg

-[¥] SpiEthernet.dct

- [¥] spiEthernet.dit

-] spiEthernet.hex

-[¥] SpiEthernet.lst

-] spiethernet . mel

- [ spiEthernet.mppay

-[¥] SpiEthernet.mcproj_callertable.txt
- [¥] spiEthernet.mil

- [ spiEthernet.user . dic

Clean Cancel

ChProgram FilesvhikroelektronikamikroPascal PRO for S4WRY
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Compilation

When you have created the project and written the source code, it's time to compile
it. Select Project » Build from the drop-down menu, or click the Build Icon |#% from
the Project Toolbar. If more more than one project is open you can compile all open
projects by selecting Project » Build All from the drop-down menu, or click the Build
All Icon _i‘:.h, from the Project Toolbar.

Progress bar will appear to inform you about the status of compiling. If there are some

errors, you will be notified in the Error Window. If no errors are encountered, the
mikroPascal PRO for AVR will generate output files.

Output Files
Upon successful compilation, the mikroPascal PRO for AVR will generate output files

in the project folder (folder which contains the project file .mppav). Output files are
summarized in the table below:

Format Description File Type
Intel HEX Intel style hex records. Use this file to program AVR MCU. | . hex
Binary mikro Compiled _Library. 3inary distril?ution of applica- el

tion that can be included in other projects.
List File Overview of AVR memory allotment: instruction Lot

addresses, registers, routines and labels.

Human readable assembly with symbolic names,

Assembler File extracted from the List File.

Assembly View

After compiling the program in the mikroPascal PRO for AVR, you can click the View
Assembly icon [l or select Project > View Assembly from the drop-down menu to
review the generated assembly code (.zsm file) in a new tab window. Assembly is
human-readable with symbolic names.

Related topics:Project Menu, Project Toolbar, Error Window, Project Manager, Project
Settings

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 83



CHAPTER 2
Environment mikroPASCAL PRO for AVR

Compiler Error Messages:

- "ss" is not valid identifier.

- Unknown type "2s".

- Identifier "<s" was not declared.

- Syntax error: Expected "<s" but "<s" found.

- Argument is out of range "%s".

- Syntax error in additive expression.

- File "%s" not found.

- Invalid command "2s".

- Not enough parameters.

- Too many parameters.

- Too many characters.

- Actual and formal parameters must be identical.

- Invalid ASM instruction: "=s".

- Identifier "=s" has been already declared in "2s".

- Syntax error in multiplicative expression.

- Definition file for "<s" is corrupted.

- ORG directive is currently supported for interrupts only.
- Not enough ROM.

- Not enough RAM.

- External procedure "<s" used in "2s" was not found.
- Internal error: "<s".

- Unit cannot recursively use itself.

- "2s" cannot be used out of loop.

- Supplied and formal parameters do not match ("2s" to "ss").
- Constant cannot be assigned to.

- Constant array must be declared as global.

- Incompatible types ("ss" to "ss").

- Too many characters ("%s").

- Soft_Uart cannot be initialized with selected baud rate/device clock.
- Main label cannot be used in modules.

- Break/Continue cannot be used out of loop.

- Preprocessor Error: "ss".

- Expression is too complicated.

- Duplicated label "<s™.

- Complex type cannot be declared here.

- Record is empty.

- Unknown type "2s".

- File not found "2s.

- Constant argument cannot be passed by reference.

- Pointer argument cannot be passed by reference.

- Operator "2s" not applicable to these operands "2s".
- Exit cannot be called from the main block.

- Complex type parameter must be passed by reference.
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- Error occured while compiling "%s".

- Recursive types are not allowed.

- Adding strings is not allowed, use "strcat" procedure instead.

- Cannot declare pointer to array, use pointer to structure which has array field.
- Return value of the function "<s" is not defined.

- Assignment to for loop variable is not allowed.

- "3s" is allowed only in the main program.

- Start address of "2s" has already been defined.

- Simple constant cannot have fixed address.

- Invalid date/time format.

- Invalid operator "ss".

- File "< is not accessible.

- Forward routine "=s" is missing implementation.

- ;" is not allowed before "else".

- Not enough elements: expected "=s", but "2s" elements found.
- Too many elements: expected "<s" elements.

- "external" is allowed for global declarations only.

- Destination size ("2s") does not match source size ("3s").

- Routine prototype is different from previous declaration.

- Division by zero.

- Uart module cannot be initialized with selected baud rate/device clock.
- 2 cannot be of "ss" type.

Warning Messages:

- Implicit typecast of integral value to pointer.

- Library "<s" was not found in search path.

- Interrupt context saving has been turned off.

- Variable "2s" is not initialized.

- Return value of the function "<s" is not defined.
- Identifier "<s" overrides declaration in unit "2s".

- Generated baud rate is "=s" bps (error = "3s" percent).
- Result size may exceed destination array size.
- Infinite loop.

- Implicit typecast performed from "2s" to "2s".

- Source size ("2s") does not match destination size ("3s").

- Array padded with zeros ("2s") in order to match declared size ("%s").
- Suspicious pointer conversion.

Hint Messages:

- Constant "<s" has been declared, but not used.

- Variable "=s" has been declared, but not used.
- Unit "ss" has been recompiled.
- Variable "=s" has been eliminated by optimizer.

- Compiling unit "2s".
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mikroPASCAL PRO for AVR

SOFTWARE SIMULATOR OVERVIEW

The Source-level Software Simulator is an integral component of the mikroPascal
PRO for AVR environment. It is designed to simulate operations of the AVR MCUs
and assist the users in debugging Pascal code written for these devices.

After you have successfully compiled your project, you can run the Software Simu-
lator by selecting Run > Start Debugger from the drop-down menu, or by clicking
the Start Debugger Icon E@ from the Debugger Toolbar. Starting the Software Sim-
ulator makes more options available: Step Into, Step Over, Step Out, Run to Cursor,
etc. Line that is to be executed is color highlighted (blue by default).

Note: The Software Simulator simulates the program flow and execution of instruc-

tion lines, but it cannot fully emulate AVR device behavior, i.e. it doesn’t update
timers, interrupt flags, etc.

Watch Window

The Software Simulator Watch Window is the main Software Simulator window which
allows you to monitor program items while simulating your program. To show the Watch
Window, select View > Debug Windows » Watch from the drop-down menu.

The Watch Window displays variables and registers of the MCU, along with their
addresses and values.

There are two ways of adding variable/register to the watch list:

- by its real name (variable's name in "Pascal" code). Just select desired
variable/register from Select variable from list drop-down menu and click the Add
Button == Add

- by its name ID (assembly variable name). Simply type name ID of the variable/reg-
ister you want to display into Search the variable by assemby name box and
click the Add Button == add

Variables can also be removed from the Watch window, just select the variable that

you want to remove and then click the Remove Button $# Remove

Add All Button 4 Add All  adds all variables.

Remove All Button & Remowve &ll removes all variables.
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You can also expand/collapse complex variables, i.e. struct type variables, strings...

Values are updated as you go through the simulation. Recently changed items are

colored red.
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Q:c00E0
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Q0020
Oe004E
0038
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Double clicking a variable or clicking the Properties Button

) Properties  opens

the Edit Value window in which you can assign a new value to the selected

variable/register. Also, you can choose the format of variable/register representation

between decimal, hexadecimal, binary, float or character. All representations except

float are unsigned by default. For signed representation click the check box next to

the Signed label.
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An item's value can be also changed by double clicking item's value field and typing

the new value directly.

[ Edit walue: ACD

Dec

Signed

Representation

He:x

o[ =)=
0100 0000 10000011 0001 ooioo0iio 1111
@ Bin Float Char
(0] H Cancel

Stopwatch Window

The Software Simulator Stopwatch Window is available from the drop-down menu,
View > Debug Windows » Stopwatch.

The Stopwatch Window displays a current count of cycles/time since the last Soft-
ware Simulator action. Stopwatch measures the execution time (number of cycles)
from the moment Software Simulator has started and can be reset at any time. Delta
represents the number of cycles between the lines where Software Simulator action

has started and ended.

Note: The user can change the clock in the Stopwatch Window, which will recalcu-
late values for the latest specified frequency. Changing the clock in the Stopwatch
Window does not affect actual project settings — it only provides a simulation.

Stopwatch

Current Count:

Delta:

Stopwatch:

Clock:

Cycles:

g

2

&

Reset To Zera

10

=]
Tirne:
9.60 us

2.40 us

9,60 us

MHz
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RAM Window

The Software Simulator RAM Window is available from the drop-down menu, View »
Debug Windows > RAM.

The RAM Window displays a map of MCU’s RAM, with recently changed items colored
red. You can change value of any field by double-clicking it.

RAM B
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0oz0f 00 00 OO0 OO 0O 0O OO0 OO0 0O 00 00 00 00 00 | 00 | 00  ceeeeanaaaniaaan
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Software Simulator Options

Name Description Function Key Toolbar
Icon
Start Debugger |Start Software Simulator. [F9] Eh:
Run/Pause . =
Debugger Run or pause Software Simulator. [F6] IE]_I
Stop Debugger [Stop Software Simulator. [Ctrl+F2] é—?g
Toggle breakpoint at the current cursor posi-
S tion. To view all breakpoints, select Run >
Bigikzomth View Breakpoints from the drop—down menu. |[F5] L
Double clicking an item in the Breakpoints
Window List locates the breakpoint.
Execute all instructions between the current
Run to cursor |, . ” [F4] el
instruction and cursor position.
Execute the current Pascal (single or
. multi—cycle) instruction, then halt. If the instruc-
Step Into tion is a routine call, enter the routine and halt [F7] k.
at the first instruction following the call.
. . Execute the current Pascal (single or
hep over multi—cycle) instruction, then halt. [F8] i
Step Out Execute all remaining instructions in the current [Ctri+F8] e

routine, return and then halt.

Related topics: Run Menu, Debug Toolbar
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CREATING NEW LIBRARY

mikroBasic PRO for AVR allows you to create your own libraries. In order to create
a library in mikroBasic PRO for AVR follow the steps bellow:

1.
2.

Create a new Pascal source file, see Managing Source Files
Save the file in one of the subfolders of the compiler's Uses folder (LTE64kW or
GT64kW, see note on the end of the page):

DriveName:\ Program Files\Mikroelektronika\mikroPascal PRO for
AVR\Uses\LTE64kW\ Lib Example.mpas

. Write a code for your library and save it.
.Add 1ib Example file in some project, see Project Manager. Recompile the

project.

If you wish to use this library for all MCUs, then you should go to Tools » Options
> Output settings, and check Build all files as library box.

This will build libraries in a common form which will work with all MCUs. If this box
is not checked, then library will be build for selected MCU.

Bear in mind that compiler will report an error if a library built for specific MCU is
used for another one.

.Conwmedf"e4_jdb4ExampTe.m01 should appear in ...\mikroBasic PRO

for AVR\Uses\LTE64kw\ folder.

. Open the definition file for the MCU that you want to use. This file is placed in the

compiler's Defs folder:
DriveName:\ Program Files\Mikroelektronika\mikroPascal PRO for
avR\ Defs\ and itis named MCU NAME.mlk, for example ATMEGA16.m1k

. Add the the following segment of code to <1.1BrRARTES> node of the definition file

(definition file is in XML format):
<LIB>
<ALIAS>Example Library</ALIAS>
<FILE> Lib Example</FILE>
<TYPE>REGULAR</TYPE>
</LIB>

8. Add Library to mlk file for each MCU that you want to use with your library.
9. Click Refresh button in Library Manager
10. Example Library should appear in the Library manager window.
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Multiple Library Versions

Library Alias represents unique name that is linked to corresponding Library .mc1
file. For example UART library for ATMEGA16 is different from UART library for
ATMEGA128 MCU. Therefore, two different UART Library versions were made, see
m1k files for these two MCUs. Note that these two libraries have the same Library
Alias (UART) in both mlk files. This approach enables you to have identical repre-
sentation of UART library for both MCUs in Library Manager.

Note: In the Uses folder, there should be two subfolders, LTE64kW and GT64kW,
depending on the Flash memory size of the desired MCU. See AVR Specifics for a
detailed information regarding this subject.

Related topics: Library Manager, Project Manager, Managing Source Files
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The following topics cover the specifics of mikroPascal PRO for AVR compiler:

- Pascal Standard Issues

- Predefined Globals and Constants
- Accessing Individual Bits

- Interrupts

- AVR Pointers

- Linker Directives

- Built-in Routines

- Code Optimization
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PASCAL STANDARD ISSUES

Divergence from the Pascal Standard

- Function recursion is not supported because of no easily-usable stack and limited
memory AVR Specific

Pascal Language Extensions

mikroPascal PRO for AVR has additional set of keywords that do not belong to the
standard Pascal language keywords:

- code

- data

-io

-rx

-sfr

- register
-at

- sbit
-bit

Related topics: Keywords, AVR Specific
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PREDEFINED GLOBALS AND CONSTANTS

To facilitate programming of AVR compliant MCUs, the mikroPascal PRO for AVR
implements a number of predefined globals and constants.

All AVR SFR registers are implicitly declared as global variables of volatile word.
These identifiers have an external linkage, and are visible in the entire project.
When creating a project, the mikroPascal PRO for AVR will include an appropriate
(* .mpas) file from defs folder, containing declarations of available SFR registers
and constants.

Math constants

In addition, several commonly used math constants are predefined in mikroPascal

PRO for AVR:

PI = 3.1415926
PT HALF = 1.5707963
TWO PI = 6.2831853
E = 2.7182818

For a complete set of predefined globals and constants, look for “Defs” in the
mikroPascal PRO for AVR installation folder, or probe the Code Assistant for specif-
ic letters (Ctrl+Space in the Code Editor).

Predefined project level defines

These defines are based on a value that you have entered/edited in the current proj-
ect, and it is equal to the name of selected device for the project.

If ATmega16 is selected device, then ATmega16 token will be defined as 1, so it can
be used for conditional compilation:

{ SIFDEF ATmegal6}
{ SENDIF}

Related topics: Project level defines
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ACCESSING INDIVIDUAL BITS

The mikroPascal PRO for AVR allows you to access individual bits of 8-bit variables.
It also supports sbit and bit data types

Accessing Individual Bits Of Variables

To access the individual bits, simply use the direct member selector (.) with a vari-
able, followed by one of identifiers B0, B1, .. , B7, or 0, 1, .. 7, with 7 being
the most significant bit :

// Clear bit 0 on PORTA
PORTA.BO := O0;

// Clear bit 5 on PORTB
PORTB.5 := 0;

There is no need of any special declarations. This kind of selective access is an
intrinsic feature of mikroPascal PRO for AVR and can be used anywhere in the
code. Identifiers B0-B7 are not case sensitive and have a specific namespace. You
may override them with your own members s80-87 within any given structure.

See Predefined Globals and Constants for more information on register/bit names.
sbit type

The mikroPascal PRO for AVR compiler has sbit data type which provides access
to bit-addressable SFRs. You can access them in several ways:

var LEDA : sbit at PORTA.BO;
var name : sbit at sfr-name.B<bit-position>;

var LEDB : sbit at PORTB.O;
var name : sbit at sfr-name.<bit-position>;
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bit type

The mikroPascal PRO for AVR compiler provides a bit data type that may be used for vari-
able declarations. It can not be used for argument lists, and function-return values.

var bf : bit; // bit variable

There are no pointers to bit variables:

var—otr——4bits // invalid

An array of type bit is not valid:

ver—errS——bits // invalid

Note :

- Bit variables can not be initialized.

- Bit variables can not be members of records.

- Bit variables do not have addresses, therefore unary operator @ (address of) is

not applicable to these variables.

Related topics: Predefined globals and constants
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INTERRUPTS

AVR derivates acknowledges an interrupt request by executing a hardware gener-
ated CALL to the appropriate servicing routine ISRs. ISRs are organized in IVT. ISR
is defined as a standard function but with the org directive afterwards which con-
nects the function with specific interrupt vector. For example org 0x000B is IVT
address of Timer/Counter 2 Overflow interrupt source of the ATMEGA16.

For more information on interrupts and IVT refer to the specific data sheet.

Function Calls from Interrupt

Calling functions from within the interrupt routine is allowed. The compiler takes care
about the registers being used, both in "interrupt” and in "main" thread, and performs
"smart" context-switching between them two, saving only the registers that have
been used in both threads. It is not recommended to use function call from interrupt.
In case of doing that take care of stack depth.

// Interrupt routine
procedure Interrupt(); org 0xl6;
begin

RS485Master Receive (dat);
end;

Most of the MCUs can access interrupt service routines directly, but some can not
reach interrupt service routines if they are allocated on addresses greater than 2K
from the IVT. In this case, compiler automatically creates Goto table, in order to jump
to such interrupt service routines.
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These principles can be explained on the picture below :

Interrupt Vector Interrupt Vector
Table Table

Goto table

Related topics: Pascal standard issues
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LINKER DIRECTIVES

mikroPascal PRO for AVR uses internal algorithm to distribute objects within mem-
ory. If you need to have a variable or a routine at the specific predefined address,
use the linker directives absolute and org.

Note: You must specify an even address when using the linker directives.
Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the vari-
able spans more than 1 word (16-bit), the higher words will be stored at the consec-
utive locations.

Directive absolute is appended to the declaration of a variable:

var x : word; absolute $32;
// Variable x will occupy 1 word (16 bits) at address $32

y : longint; absolute $34;
// Variable y will occupy 2 words at addresses $34 and $36

Be careful when using the absolute directive because you may overlap two vari-
ables by accident. For example:

var 1 : word; absolute $42;
// Variable 1 will occupy 1 word at address $42;

3j : longint; absolute $40;

// Variable will occupy 2 words at $40 and $42; thus,

// changing 1 changes jj at the same time and vice versa

Note: You must specify an even address when using the absolute directive.
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Directive org

Directive org specifies the starting address of a routine in ROM. It is appended to
the declaration of a routine. For example:

procedure proc(par : byte); org $200;

begin

// Procedure will start at address $200;

end;

org directive can be used with main routine too. For example:

program Led Blinking;

procedure some proc();
begin

end;
org 0x800; // main procedure starts at 0x800
begin

DDRB := OxFF;

while TRUE do

begin
PORTB := 0x00;
Delay ms (500);
PORTB := OXxFF;
Delay ms (500);
end;

end.

Note: You must specify an even address when using the org directive.
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BUILT-IN ROUTINES

The mikroPascal PRO for AVR compiler provides a set of useful built-in utility functions.

The pelay us and pelay ms routines are implemented as “inline”; i.e. code is generated in the
place of a call, so the call doesn’t count against the nested call limit.

The vdelay ms, Delay Cyc and Get Fosc kHz are actual Pascal routines. Their sources can be
found in Delays.mpas file located in the uses folder of the compiler.

- Lo

- Hi

- Higher

- Highest

- Inc

- Dec

- Delay _us

- Delay_ms
- Vdelay_ms
- Delay_Cyc
- Clock_Khz
- Clock_Mhz
- SetFunccCall

Lo

Prototype function Lo (number: longint): byte;

Returns Lowest 8 bits (byte)of number, bits 7..0.

Function returns the lowest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).

d := 0x1AC30F4;
tmp := Lo (d); // Equals 0xF4

Example
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Hi
Prototype function Hi (number: longint): byte;
Returns Returns next to the lowest byte of number, bits 8..15.
Function returns next to the lowest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d := 0x1AC30F4;
Xxample tmp := Hi(d); // Equals 0x30
Higher
Prototype function Higher (number: longint): byte;
Returns Returns next to the highest byte of number, bits 16..23.
Function returns next to the highest byte of number. Function does not interpret
bit patterns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d := 0x1AC30F4;
xample tmp := Higher(d); // Equals O0xAC
Highest
Prototype function Highest (number: longint): byte;
Returns Returns the highest byte of number, bits 24..31.
Function returns the highest byte of number. Function does not interpret bit pat-
terns of number — it merely returns 8 bits as found in register.
Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).
E I d := 0x1AC30F4;
Xxample tmp := Highest (d); // Equals 0x01
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Inc

Prototype procedure Inc(var par : longint);

Returns Nothing.

Description [Increases parameter par by 1.

Requires Nothing.
p = 4;

Example Inc(p); // p is now 5

Dec

Prototype procedure Dec (var par : longint);

Returns Nothing.

Description |Decreases parameter par by 1.

Requires Nothing.
p = 4;

Example Dec(p); // p is now 3

Delay_us

Prototype procedure Delay us(time in us: const longword);

Returns Nothing.
Creates a software delay in duration of time in us microseconds (a constant).
Range of applicable constants depends on the oscillator frequency.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example Delay us(1000); // One millisecond pause
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Delay_ms

Prototype procedure Delay ms(time in ms: const longword);

Returns Nothing.

Creates a software delay in duration of time_in_ms milliseconds (a constant).
Range of applicable constants depends on the oscillator frequency.

Description
This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.

Requires Nothing.

Example Delay ms (1000); // One second pause

Vdelay_ms

Prototype |procedure Vdelay ms(time in ms: word);

Returns Nothing.

Creates a software delay in duration of time_in_ms milliseconds (a variable).
Generated delay is not as precise as the delay created by Delay_ms.

Description
Note that Vdelay_ms is library function rather than a built-in routine; it is pre-
sented in this topic for the sake of convenience.

Requires Nothing.
pause := 1000;

Example //

Vdelay ms (pause); // ~ one second pause

Delay_Cyc

Prototype procedure Delay Cyc(Cycles div by 10: byte);

Returns Nothing.

Creates a delay based on MCU clock. Delay lasts for 10 times the input param-
eter in MCU cycles.

Description Note that Delay_Cyc is library function rather than a built-in routine; it is pre-
sented in this topic for the sake of convenience. There are limitations for
Cycles_div_by 10 value. Value Cycles_div_by 10 must be between 2 and 257.

Requires Nothing.

Example Delay Cyc(10); // Hundred MCU cycles pause
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Clock_KHz
Prototype [function Clock KHz(): word;
Returns Device clock in KHz, rounded to the nearest integer.
Function returns device clock in KHz, rounded to the nearest integer.
Description This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Nothing.
Example clk := Clock kHz();
Clock_MHz
Prototype |function Clock MHz (): byte;
Returns Device clock in MHz, rounded to the nearest integer.
Function returns device clock in MHz, rounded to the nearest integer.
Description This is an “inline” routine; code is generated in the place of the call, so the call
doesn’t count against the nested call limit.
Requires Nothing.
Example clk := Clock MHz();
SetFuncCall
Prototype procedure SetFuncCall (FuncName: string);
Returns Nothing.
Function informs the linker about a specific routine being called. SetFuncCall
has to be called in a routine which accesses another routine via a pointer.
Description
Function prepares the caller tree, and informs linker about the procedure usage,
making it possible to link the called routine.
Requires Nothing.
procedure first(p, g: byte);
begin
Example . éetFuncCall (second); // let linker know that we will call the
routine 'second'
end
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CODE OPTIMIZATION

Optimizer has been added to extend the compiler usability, cut down the amount of
code generated and speed-up its execution. The main features are:

Constant folding

All expressions that can be evaluated in the compile time (i.e. are constant) are
being replaced by their results. (3 + 5 -> 8);

Constant propagation

When a constant value is being assigned to a certain variable, the compiler recog-
nizes this and replaces the use of the variable by constant in the code that follows,
as long as the value of a variable remains unchanged.

Copy propagation

The compiler recognizes that two variables have the same value and eliminates one
of them further in the code.

Value numbering

The compiler "recognizes" if two expressions yield the same result and can there-
fore eliminate the entire computation for one of them.

"Dead code" ellimination

The code snippets that are not being used elsewhere in the programme do not affect
the final result of the application. They are automatically removed.

Stack allocation

Temporary registers ("Stacks") are being used more rationally, allowing VERY com-
plex expressions to be evaluated with a minimum stack consumption.

Local vars optimization

No local variables are being used if their result does not affect some of the global or
volatile variables.

Better code generation and local optimization

Code generation is more consistent and more attention is payed to implement spe-
cific solutions for the code "building bricks" that further reduce output code size.
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Types Efficiency

First of all, you should know that AVR ALU, which performs arithmetic operations, is
optimized for working with bytes. Although mikroPascal PRO is capable of handling
very complex data types, AVR may choke on them, especially if you are working on
some of the older models. This can dramatically increase the time needed for per-
forming even simple operations. Universal advice is to use the smallest possible
type in every situation. It applies to all programming in general, and doubly so with
microcontrollers. Types efficiency is determined by the part of RAM memory that is
used to store a variable/constant.
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Nested Calls Limitations

There are no Nested Calls Limitations, except by RAM size. A Nested call repre-
sents a function call to another function within the function body. With each function
call, the stack increases for the size of the returned address. Number of nested calls
is equel to the capacity of RAM which is left out after allocation of all variables.

Important notes:

- There are many different types of derivates, so it is necessary to be familiar with
characteristics and special features of the microcontroller in you are using.

- Some of the AVR MCUs have hardware multiplier. Due to this, be sure to pay atten
tion when porting code from one MCU to another, because compiled code can vary
by its size.

- Not all microcontrollers share the same instruction set. It is advisable to carefully
read the instruction set of the desired MCU, before you start writing your code.
Compiler automatically takes care of appropiate instruction set, and if unapropriate
asm instruction is used in in-line assembly, compiler will report an error.

- Program counter size is MCU dependent. Thus, there are two sets of libraries :

- MCUs with program counter size larger than 16 bits (flash memory size larger than
128kb)

- MCUs with program counter size less or equal 16 bits (flash memory size smaller
than 128kb)

- Assembly SPM instruction and its derivates must reside in Boot Loader section of
program memory.

- Part of flash memory can be dedicated to Boot Loader code. For details, refer to
AVR memory organization.

Related topics: mikroPascal PRO for AVR specifics, AVR memory organization
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AVR Memory Organization

The AVR microcontroller's memory is divided into Program Memory and Data
Memory. Program Memory (ROM) is used for permanent saving program being exe-
cuted, while Data Memory (RAM) is used for temporarily storing and keeping inter-
mediate results and variables.

Program Memory (ROM)

Program Memory (ROM) is used for permanent saving program (CODE) being exe-
cuted, and it is divided into two sections, Boot Program section and the Application
Program section. The size of these sections is configured by the BOOTSZ fuse.
These two sections can have different level of protection since they have different
sets of Lock bits.

Depending on the settings made in compiler, program memory may also used to
store a constant variables. The AVR executes programs stored in program memory
only. code memory type specifier is used to refer to program memory.

A

Program
Memory
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Data Memory
Data memory consists of :

- Rx space

- 1/0 Memory

- Extended 1/0 Memory (MCU dependent)
- Internal SRAM

Rx space consists of 32 general purpose working 8-bit registers (R0-R31). These
registers have the shortest (fastest) access time, which allows single-cycle Arith-
metic Logic Unit (ALU) operation.

I/O Memory space contains addresses for CPU peripheral function, such as Control
registers, SPI, and other I/O functions.

Due to the complexity, some AVR microcontrollers with more peripherals have
Extended I/O memory, which occupies part of the internal SRAM. Extended 1/O
memory is MCU dependent.

Storing data in I/O and Extended 1/O memory is handled by the compiler only. Users
can not use this memory space for storing their data.

Internal SRAM (Data Memory) is used for temporarily storing and keeping interme-
diate results and variables (static link and dynamic link).

There are four memory type specifiers that can be used to refer to the data memo-
ry: rx, data, io, sfr and register.
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AVR memory
spaces

A

Register
Space

h 4
Y \

/O
Space

X

SRAM
(Data) Space

Related topics: Accessing individual bits, SFRs, Memory type specifiers
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MEMORY TYPE SPECIFIERS

The mikroPascal PRO for AVR supports usage of all memory areas. Each variable may be explic-
itly assigned to a specific memory space by including a memory type specifier in the declaration,
or implicitly assigned.

The following memory type specifiers can be used:

- code
- data
- X
-io

- sfr

Memory type specifiers can be included in variable declaration.

For example:

var data buffer : char; data; // puts data buffer in data ram
const txt = 'Enter parameter'; code; // puts text in program memory
code

Description |The code memory type may be used for allocating constants in program memory.

// puts txt in program memor
Example c P v

const txt = 'Enter parameter'; code;
data
Description [This memory specifier is used when storing variable to the internal data SRAM.
E I // puts data buffer in data ram
xample var data buffer : char; data;
rx
This memory specifier allows variable to be stored in the Rx space (Register file).
.. Note: In most of the cases, there will be enough space left for the user variables
Description |. ! . .
in the Rx space. However, since compiler uses Rx space for storing temporary
variables, it might happen that user variables will be stored in the internal data
SRAM, when writing complex programs.
Example // put? y iﬁ.Rx fpace
var y : char; rx;
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io

Description |This memory specifier allows user to access the /O Memory space.

// put io buff in io memory space

Example var io buff : byte; io;

sfr

This memory specifier in combination with (rx, io, data) allows user to access
Description |[special function registers. It also instructs compiler to maintain same identifier in
Pascal and assembly.

var io buff : byte; io; sfr; // put io buff in I/O memory space
var y : char; rx; sfr; // puts y in Rx space
Example
var temp : byte; data; sfr; and var temp : byte; sfr; are equiv-
alent, and put temp in Extended I/O Space.
register

If no other memory specifier is used (rx, io, sfr, code or data), the register
Description |[specifer places variable in Rx space, and instructs compiler to maintain same
identifier in C and assembly.

Example var y : char; register;

Note: If none of the memory specifiers are used when declaring a variable, data specifier will be
set as default by the compiler.

Related topics: AVR Memory Organization, Accessing individual bits, SFRs, Constants, Functions
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mikroPascal PRO for AVR
Language Reference

The mikroPascal PRO for AVR Language Reference describes the syntax,seman-
tics and implementation of mikroPascal PRO for AVR Language reference.

The aim of this referenceguide is to provide a more understandable description of
the mikroPascal PRO for AVR language references to the user.
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MIKROPASCAL PRO FOR AVR LANGUAGE REFERENCE

- Lexical Elements
Whitespace
Comments
Tokens
Literals
Keywords
Identifiers
Punctuators
- Program Organization
Program Organization
Scope and Visibility
Units
- Variables
- Constants
- Labels
- Functions and Procedures
Functions
Procedures
- Types
Simple Types
Arrays
Strings
Pointers
Records
Types Conversions
Implicit Conversion
Explicit Conversion
- Operators
Introduction to Operators
Operators Precedence and Associativity
Arithmetic Operators
Relational Operators
Bitwise Operators
Boolean Operators
- Expressions
Expressions
- Statements
Introduction to Statements
Assignment Statements
Compound Statements (Blocks)
Conditional Statements
If Statement
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Case Statement
Iteration Statements (Loops)
For Statement
While Statement
Repeat Statement
Jump Statements
Break and Continue Statements
Exit Statement
Goto Statement
asm Statement
Directives
Compiler Directives
Linker Directives

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 119



CHAPTER 5
Language Reference mikroPASCAL PRO for AVR

LEXICAL ELEMENTS OVERVIEW

The following topics provide a formal definition of the mikroPascal PRO for AVR lex-
ical elements. They describe different categories of word-like units (tokens) recog-
nized by mikroPascal PRO for AVR.

In the tokenizing phase of compilation, the source code file is parsed (i.e. broken
down) into tokens and whitespace. The tokens in mikroPascal PRO for AVR are
derived from a series of operations performed on your programs by the compiler.

Whitespace

Whitespace is a collective name given to spaces (blanks), horizontal and vertical
tabs, newline characters and comments. Whitespace can serve to indicate where
tokens start and end, but beyond this function, any surplus whitespace is discarded.
For example, two sequences

var 1 : char;
J ¢ word;
and
var
i : char;
J : word;

are lexically equivalent and parse identically to give nine tokens:

var
i
char
’

J
word
’

Whitespace in Strings

The ASCII characters representing whitespace can occur within string literals, in
which case they are protected from the normal parsing process (they remain a part
of the string). For example,

Whitespace in Strings

some string := 'mikro foo';
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parses into four tokens, including a single string literal token:

some string

'mikro foo!

’

Comments

Comments are pieces of a text used to annotate a program, and are technically
another form of whitespace. Comments are for the programmer’s use only. They are
stripped from the source text before parsing.

There are two ways to create comments in mikroPascal. You can use multi-line com-
ments which are enclosed with braces or (* and *):

{ All text between left and right brace
constitutes a comment. May span multiple lines. }

(* Comment can be

written in this way too. *)
or single-line comments:

// Any text between a double-slash and the end of the
// line constitutes a comment spanning one line only.

Nested comments

mikroPascal PRO for AVR doesn’t allow nested comments. The attempt to nest a
comment like this

{ 1 { identifier } : word; }

fails, because the scope of the first open brace “{ ” ends at the first closed brace
v} . This gives us

: word; }

which would generate a syntax error.
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Tokens

Token is the smallest element of the Pascal program that compiler can recognize.
The parser separates tokens from the input stream by creating the longest token
possible using the input characters in a left—to—right scan.

mikroPascal PRO for AVR recognizes the following kinds of tokens:

- keywords

- identifiers

- constants

- operators

- punctuators (also known as separators)

Token Extraction Example

Here is an example of token extraction. Take a look at the following example code
sequence:

end flag := 0;

First, note that end f1ag would be parsed as a single identifier, rather than as the
keyword end followed by the identifier f1ag.

The compiler would parse it as the following four tokens:

end flag // variable identifier
1= // assignment operator
0 // literal

// statement terminator

Note that := parses as one token (the longest token possible), not as token : fol-
lowed by token -.

122 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 5
mikroPASCAL PRO for AVR Language Reference

Literals
Literals are tokens representing fixed numeric or character values.

The data type of a constant is deduced by the compiler using such clues as numer-
ic value and format used in the source code.

Integer Literals

Integral values can be represented in decimal, hexadecimal, or binary notation.

In decimal notation, numerals are represented as a sequence of digits (without com-
mas, spaces, or dots), with optional prefix + or - operator to indicate the sign. Values

default to positive (6258 is equivalent to +6258).

The dollar-sign prefix ($) or the prefix Ox indicates a hexadecimal numeral (for exam-
ple, $8F or 0x8F).

The percent-sign prefix (%) indicates a binary numeral (for example, $01010000).

Here are some examples:

11 // decimal literal

S11 // hex literal, equals decimal 17
0x11 // hex literal, equals decimal 17
%11 // binary literal, equals decimal 3

The allowed range of values is imposed by the largest data type in mikroPascal
PRO for AVR — longint. Compiler will report an error if the literal exceeds
2147483647 ($7FFFFFFF).

Floating Point Literals

A floating-point value consists of:

- Decimal integer

- Decimal point

- Decimal fraction

- e or E and a signed integer exponent (optional)

You can omit either the decimal integer or decimal fraction (but not both).

Negative floating constants are taken as positive constants with the unary operator
minus (-) prefixed.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 123



CHAPTER 5
Language Reference mikroPASCAL PRO for AVR

mikroPascal PRO for AVR limits floating-point constants to range +1.17549435082
*10-38 .. £6.80564774407 * 1038.

Here are some examples:

0. // = 0.0

-1.23 // = -1.23
23.45e6 // = 23.45 * 1076
2e-5 // = 2.0 * 107-5
3E+10 // = 3.0 * 10710
.09E34 // = 0.09 * 10734

Character Literals
Character literal is one character from the extended ASCII character set, enclosed
with apostrophes.

Character literal can be assigned to variables of the byte and char type (variable of
byte will be assigned the ASCII value of the character). Also, you can assign char-
acter literal to a string variable.

Note: Quotes (" ") have no special meaning in mikroPascal PRO for AVR.

String Literals

String literal is a sequence of characters from the extended ASCII character set,
written in one line and enclosed with apostrophes. Whitespace is preserved in string
literals, i.e. parser does not “go into” strings but treats them as single tokens.

Length of string literal is a number of characters it consists of. String is stored internal-
ly as the given sequence of characters plus a final null character. This null character
is introduced to terminate the string, it does not count against the string’s total length.

String literal with nothing in between the apostrophes (null string) is stored as a sin-
gle null character.

You can assign string literal to a string variable or to an array of char.

Here are several string literals:

'Hello world!' // message, 12 chars long
'Temperature is stable' // message, 21 chars long

! ! // two spaces, 2 chars long
'C!' // letter, 1 char long

L)

// null string, 0 chars long

The apostrophe itself cannot be a part of the string literal, i.e. there is no escape
sequence. You can use the built-in function Chr to print an apostrophe: Chr(39).
Also, see String Splicing.
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Keywords

Keywords are the words reserved for special purposes and must not be used as normal
identifier names.

Beside standard Pascal keywords, all relevant SFRs are defined as global variables and rep-
resent reserved words that cannot be redefined (for example: WO, TMR1, T1CON, etc).
Probe the Code Assistant for specific letters (Ctrl+Space in Editor) or refer to Predefined

Globals and Constants.

Here is the alphabetical listing of keywords in Pascal:

- absolute - end - name - reintroduce
- abstract - except - near - repeat

- and - export -nil - requires
- array - exports - nodefault - safecall
- as - external - not - sbit

- asm - far - object - sealed

- assembler - file - of - set

- at - final - on - shl

- automated - finalization - operator - shr

- bdata - finally - org - small

- begin - for - out - stdcall

- bit - forward - overload - stored

- case - goto - override - string

- cdecl - helper - package - threadvar
- class - idata - packed -to

- code -1if - pascal -try

- compact -ilevel - pdata - type

- const - implementation -platform -unit

- constructor - implements - private -until

- contains -in = procedure - uses

- data - index - program -var

- default - inherited - property -virtual

- deprecated -initialization - protected -volatile
- destructor -inline - public -while

- dispid - interface - published -with

- dispinterface -1is - raise -write

- div - label - read -writeonly
- do - library - readonly - xdata

- downto - message - record - XOr

- dynamic - mod - register

Also, mikroPascal PRO for AVR includes a number of predefined identifiers used in libraries.
You can replace them by your own definitions, if you plan to develop your own libraries. For
more information, see mikroPascal PRO for AVR Libraries.
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IDENTIFIERS

Identifiers are arbitrary names of any length given to functions, variables, symbolic
constants, user-defined data types and labels. All these program elements will be
referred to as objects throughout the help (don't get confused about the meaning of
object in object-oriented programming).

Identifiers can contain the letters a to z and A to Z, underscore character “_”, and
digits from 0 to 9. The only restriction is that the first character must be a letter or an
underscore.

Case Sensitivity
Pascal is not case sensitive, so Sum, sum, and suM are an equivalent identifier.
Uniqueness and Scope

Although identifier names are arbitrary (according to the stated rules), if the same
name is used for more than one identifier within the same scope then error arises.
Duplicated names are illegal within same scope. For more information, refer to
Scope and Visibility.

Identifier Examples

Here are some valid identifiers:

temperature V1
Pressure

no hit
dat2string
SUM3

_vtext..

and here are some invalid identifiers:

Ttemp // NO -- cannot begin with a numeral

shigher // NO -- cannot contain special characters

XOr // NO -- cannot match reserved word

323.07.04 // NO -- cannot contain special characters (dot)
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PUNCTUATORS
The mikroPascal punctuators (also known as separators) are:

- [ ] — Brackets

- () — Parentheses
-,—Comma

- ; — Semicolon

- : = Colon
-.—Dot

Brackets

Brackets [ ] indicate single and multidimensional array subscripts:

var alphabet : array| 1..30] of byte;
//
alphabet[ 3] := 'c';

For more information, refer to Arrays.
Parentheses

Parentheses ( ) are used to group expressions, isolate conditional expressions and
indicate function calls and function declarations:

d :=c* (a + b); // Override normal precedence

if (d = z) then ... // Useful with conditional statements
func () ; // Function call, no arguments
function func2(n : word); //

Function declaration with parametersFor more information, refer to Operators
Precedence and Associativity, Expressions and Functions and Procedures.

Comma

Comma (, ) separates the arguments in function calls:

LCD Out (1, 1, txt);
Further, the comma separates identifiers in declarations:
var i, j, k : byte;

The comma also separates elements of array in initialization lists:

const MONTHS : array[ 1..12] of byte =
(31,28,31,30,31,30,31,31,30,31,30,31);
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Semicolon

Semicolon (;) is a statement terminator. Every statement in Pascal must be termi-
nated with a semicolon. The exceptions are: the last (outer most) end statement in
the program which is terminated with a dot and the last statement before end which
doesn't need to be terminated with a semicolon.

For more information, see Statements.

Colon

Colon (:) is used in declarations to separate identifier list from type identifier. For

example:

var
i, 3 : byte;
k : word;

In the program, use the colon to indicate a labeled statement:
start: nop;

goto start;

For more information, refer to Labels.

Dot

Dot (.) indicates an access to a field of a record. For example:
person.surname := 'Smith';

For more information, refer to Records.

Dot is a necessary part of floating point literals. Also, dot can be used for accessing
individual bits of registers in mikroPascal.
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PROGRAM ORGANIZATION

Pascal imposes quite strict program organization. Below you can find models for
writing legible and organized source files. For more information on file inclusion and
scope, refer to Units and Scope and Visibility.

Organization of Main Unit

Basically, the main source file has two sections: declaration and program body. Dec-
larations should be in their proper place in the code, organized in an orderly man-
ner. Otherwise, the compiler may not be able to comprehend the program correctly.

When writing code, follow the model presented below. The main unit should look like this:

program { program name }
uses { 1include other units }

//****************************~)<***************************

//* Declarations (globals):

//****************************~)<***************************

{ constants declarations }
const ...

{ types declarations }

type

{ wvariables declarations }

var Name[ , Name2...] : [ "] type; [ absolute 0x123;] [ external;]
[ volatile;] [ register;] [ sfr;]

{ labels declarations }
label

{ procedures declarations }

procedure procedure name (parameter list);
{ local declarations }
begin

end;
{ functions declarations }

function function name (parameter list) : return type;
{ local declarations }

begin

end
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//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

//* Program body:

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

begin
{ write your code here }
end.

Organization of Other Units

Units other than main start with the keyword unit. Implementation section starts with
the keyword implementation. Follow the model presented below:

unit { unit name }
uses { 1include other units }

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

//* Interface (globals):

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

{ constants declarations }
const

{ types declarations }
type

{ wvariables declarations }
var Name[ , Name2...] : [ "] type; [ absolute 0x123;] [ external;]
[ volatile;] [ register;] [ sfr;]

{ procedures prototypes }
procedure procedure name ([ var] [ const] ParamName : [ "] type; [ var]
[ const] ParamName2, ParamName3 : [ *] type);

{ functions prototypes }
function function name ([ var] [ const] ParamName : [ "] type; [ var]
[ const] ParamName2, ParamName3 : [ "] type) : [ "] type;

//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

//* Implementation:
//*k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k**k***********************

implementation

{ constants declarations }
const

{ types declarations }
type
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{ wvariables declarations }
var Name[ , Name?2...] : [ "] type; [ absolute 0x123;] [ external;]
[ volatile;] [ register;] [ sfr;]

{ labels declarations }
label

{ procedures declarations }

procedure procedure name ([ var] [ const] ParamName : [ "] type; [ var
[ const] ParamName2, ParamName3 : [ "] type); [ ilevel 0x123;] [ over-
load;] [ forward;]

{ local declarations }

begin

end;

{ functions declarations }
function function name ([ var] [ const] ParamName : [ *] type; [ var
[ const] ParamName2, ParamName3 : [ "] type) : [ "] type; [ ilevel 0x123;]
[ overload;] [ forward;]

{ local declarations }

begin

end;
end.

Note: constants, types and variables used in the implementation section are inac-
cessible to other units. This feature is not applied to the procedures and functions in
the current version, but it will be added to the future ones.

Note: Functions and procedures must have the same declarations in the interface
and implementation section. Otherwise, compiler will report an error.
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SCOPE AND VISIBILITY

Scope

The scope of an identifier is a part of the program in which the identifier can be used
to access its object. There are different categories of scope, which depends on how
and where identifiers are declared:

Place of declaration Scope

Scope extends from the point where it is declared to the
end of the current block, including all blocks enclosed
within that scope. Identifiers in the outermost scope (file
scope) of the main unit are referred to as globals, while
other identifiers are locals.

Identifier is declared
in the declaration of a
program, function, or
procedure

Identifier is declared |Scope extends the interface section of a unit from the
in the interface sec- point where it is declared to the end of the unit, and to
tion of a unit any other unit or program that uses that unit.

Identifier is declared in
the implementation sec-|Scope extends from the point where it is declared to the
tion of a unit, but not end of the unit. The identifier is available to any function
within the block of any |or procedure in the unit.

function or procedure

Visibility
The visibility of an identifier is that region of the program source code from which

legal access to the identifier’s associated object can be made.

Scope and visibility usually coincide, though there are circumstances under which
an object becomes temporarily hidden by the appearance of a duplicate identifier,
i.e. the object still exists but the original identifier cannot be used to access it until
the scope of the duplicate identifier is ended.

Technically, visibility cannot exceed scope, but scope can exceed visibility.
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UNITS

In mikroPascal PRO for AVR, each project consists of a single project file and one
or more unit files. Project file, with extension .mppav contains information about the
project, while unit files, with extension .mpas, contain the actual source code.

Units allow you to:

- break large programs into encapsulated parts that can be edited separately,
- create libraries that can be used in different projects,
- distribute libraries to other developers without disclosing the source code.

Each unit is stored in its own file and compiled separately. Compiled units are linked
to create an application. In order to build a project, the compiler needs either a
source file or a compiled unit file (.mcl file) for each unit.

Uses Clause

mikroPascal PRO for AVR includes units by means of the uses clause. It consists of
the reserved word uses, followed by one or more comma-delimited unit names, fol-
lowed by a semicolon. Extension of the file should not be included. There can be at
most one uses clause in each source file, and it must appear immediately after the
program (or unit) name.

Here’s an example:
uses utils, strings, Unit2, MyUnit;

For the given unit name, the compiler will check for the presence of .mc1 and .mpas
files, in order specified by the search paths.

- If both .mpas and .mc1 files are found, the compiler will check their dates and
include the newer one in the project. If the .mpas file is newer than .mc1, a new
library will be written over the old one;

- If only .mpzs file is found, the compiler will create the .mc1 file and include it in the
project;

- Ifonly .mc1 file is present, i.e. no source code is available, the compiler will include
it as it is found;

- If none found, the compiler will issue a “File not found” warning.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 133



CHAPTER 5
Language Reference mikroPASCAL PRO for AVR

Main Unit

Every project in mikroPascal PRO for AVR requires a single main unit file. The main
unit file is identified by the keyword program at the beginning; it instructs the com-
piler where to “start”.

After you have successfully created an empty project with the Project Wizard, the
Code Editor will display a new main unit. It contains the bare-bones of the Pascal
program:

program MyProject;
{ main procedure }
begin

{ Place program code here }
end.

Nothing should precede the keyword program except comments. After the program
name, you can optionally place the uses clause.

Place all global declarations (constants, variables, types, labels, routines) before the
keyword begin.

Other Units

Units other than main start with the keyword uni+. Newly created blank unit contains
the bare-bones:

unit MyUnit;
implementation

end.

Other than comments, nothing should precede the keyword unit. After the unit
name, you can optionally place the uses clause.

Interface Section

Part of the unit above the keyword implementation is referred to as interface sec-
tion. Here, you can place global declarations (constants, variables, labels and types)
for the project.

You do not define routines in the interface section. Instead, state the prototypes of
routines (from implementation section) that you want to be visible outside the unit.
Prototypes must match the declarations exactly.
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Implementation Section

Implementation section hides all irrelevant innards from other units, allowing encap-
sulation of code.

Everything declared below the keyword implementation is private, i.e. has its
scope limited to the file. When you declare an identifier in the implementation sec-
tion of a unit, you cannot use it outside the unit, but you can use it in any block or
routine defined within the unit.

By placing the prototype in the interface section of the unit (above the implementa-
tion) you can make the routine public, i.e. visible outside of unit. Prototypes must
match the declarations exactly.
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VARIABLES

Variable is object whose value can be changed during the runtime. Every variable is
declared under unique name which must be a valid identifier. This name is used for
accessing the memory location occupied by a variable.

Variables are declared in the declaration part of the file or routine — each variable needs
to be declared before being used. Global variables (those that do not belong to any
enclosing block) are declared below the uses statement, above the keyword begin.

Specifying a data type for each variable is mandatory. Syntax for variable declaration is:

var identifier list : type;

identifier list is a comma-delimited list of valid identifiers and type can be any
data type.

For more details refer to Types and Types Conversions. For more information on
variables’ scope refer to the chapter Scope and Visibility.

Pascal allows shortened syntax with only one keyword var followed by multiple vari-
able declarations. For example:

var i, j, k : byte;
counter, temp : word;
samples : array[ 100] of word;

Variables and AVR

Every declared variable consumes part of RAM. Data type of variable determines
not only allowed range of values, but also the space variable occupies in RAM. Bear
in mind that operations using different types of variables take different time to be
completed. mikroPascal PRO for AVR recycles local variable memory space — local
variables declared in different functions and procedures share the same memory
space, if possible.

There is no need to declare SFRs explicitly, as mikroPascal PRO for AVR automatically
declares relevant registers as global variables of vo1ztile word see SFR for details.
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Constants

Constant is a data whose value cannot be changed during the runtime. Using a con-
stant in a program consumes no RAM. Constants can be used in any expression,
but cannot be assigned a new value.

Constants are declared in the declaration part of a program or routine. You can
declare any number of constants after the keyword const:

const constant name [ : type] = value;

Every constant is declared under unique constant name which must be a valid
identifier. It is a tradition to write constant names in uppercase. Constant requires
you to specify va1lue, which is a literal appropriate for the given type. type is option-
al and in the absence of type, the compiler assumes the “smallest” of all types that
can accommodate value.

Note: You cannot omit type when declaring a constant array.

Pascal allows shorthand syntax with only one keyword const followed by multiple
constant declarations. Here’s an example:

const
MAX : longint = 10000;
MIN = 1000; // compiler will assume word type
SWITCH = 'n'; // compiler will assume char type
MSG = 'Hello'; // compiler will assume string type

MONTHS : array[ 1..12] of byte =
(31,28,31,30,31,30,31,31,30,31,30,31);
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Labels

Labels serve as targets for goto statements. Mark the desired statement with a label
and colon like this:

label identifier : statement

Before marking a statement, you must declare a label. Labels are declared in dec-
laration part of unit or routine, similar to variables and constants. Declare labels
using the keyword 1zbel :

label labell, ..., labeln;

Name of the label needs to be a valid identifier. The label declaration, marked state-
ment, and goto statement must belong to the same block. Hence it is not possible
to jump into or out of a procedure or function. Do not mark more than one statement
in a block with the same label.

Here is an example of an infinite loop that calls the Beep procedure repeatedly:

label loop;
loop:

Beep;

goto loop;

Note: label should be followed by end of line (CR) otherwise compiler will report an error:
label loop;

loop: Beep; // compiler will report an error
loop: // compiler will report an error

138 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 5
mikroPASCAL PRO for AVR Language Reference

FUNCTIONS AND PROCEDURES

Functions and procedures, collectively referred to as routines, are subprograms
(self-contained statement blocks) which perform a certain task based on a number
of input parameters. When executed, a function returns a value while procedure
does not.

mikroPascal PRO for AVR does not support inline routines.

Functions

A function is declared like this:

function function name (parameter list) : return type;
{ local declarations }
begin

{ function body }
end;

function name represents a function’s name and can be any valid identifier.
return type is a type of return value and can be any simple type. Within parenthe-
ses, parameter list is aformal parameter list very similar to variable declaration.
In Pascal, parameters are always passed to a function by the value — to pass an
argument by address, add the keyword var ahead of identifier.

Local declarations are optional declarations of variables and/or constants, local
for the given function. Function body is a sequence of statements to be executed
upon calling the function.

Calling a function

Afunction is called by its name, with actual arguments placed in the same sequence
as their matching formal parameters. The compiler is able to coerce mismatching
arguments to the proper type according to implicit conversion rules. Upon a function
call, all formal parameters are created as local objects initialized by values of actu-
al arguments. Upon return from a function, a temporary object is created in the place
of the call and it is initialized by the value of the function result. This means that func-
tion call as an operand in complex expression is treated as the function result.

In standard Pascal, a function name is automatically created local variable that
can be used for returning a value of a function. mikroPascal PRO for AVR also
allows you to use the automatically created local variable result to assign the return
value of a function if you find function name to be too ponderous. If the return value
of a function is not defined the compiler will report an error.
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Function calls are considered to be primary expressions and can be used in situa-
tions where expression is expected. A function call can also be a self-contained
statement and in that case the return value is discarded.

Example

Here’s a simple function which calculates =" based on input parameters x and n (n

> 0):
function power(x, n : byte) : longint;
var 1 : byte;
begin

i := 0; result := 1;

if n > 0 then

for i := 1 to n do result := result*x;

end;

Now we could call it to calculate 312 for example:
tmp := power (3, 12);

Procedures

Procedure is declared like this:

procedure procedure name (parameter list);
{ local declarations }

begin
{ procedure body }

end;

procedure name represents a procedure’s name and can be any valid identifier.
Within parentheses, parameter 1ist is a formal parameter list very similar to vari-
able declaration. In Pascal, parameters are always passed to a procedure by the
value — to pass an argument by address, add the keyword var ahead of identifier.

Local declarations are optional declaration of variables and/or constants, local for
the given procedure. pProcedure body is a sequence of statements to be executed
upon calling the procedure.

Calling a procedure

A procedure is called by its name, with actual arguments placed in the same
sequence as their matching formal parameters. The compiler is able to coerce mis-
matching arguments to the proper type according to implicit conversion rules. Upon
procedure call, all formal parameters are created as local objects initialized by the
values of actual arguments.

Procedure call is a self-contained statement.
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Example

Here’s an example procedure which transforms its input time parameters, preparing
them for output on Lcd:

procedure time prep(var sec, min, hr : byte);

begin
sec := ((sec and S$F0) shr 4)*10 + (sec and $O0F);
min := ((min and S$FO0) shr 4)*10 + (min and S$OF);
hr := ((hr and S$F0) shr 4)*10 + (hr and $O0F);

end;

A function can return a complex type. Follow the example bellow to learn how to
declare and use a function which returns a complex type.

Example:

This example shows how to declare a function which returns a complex type.
program Example;

type TCircle = record // Record
CenterX, CenterY: word;
Radius: byte;

end;

var MyCircle: TCircle; // Global variable

function DefineCircle(x, y: word; r: byte): TCircle; // DefineCircle
function returns a Record

begin
result.CenterX := x;
result.CenterY := y;
result.Radius = r;
end;

begin

MyCircle := DefineCircle (100, 200, 30); //
Get a Record via function call

MyCircle.CenterX := DefineCircle (100, 200, 30).CenterxXx + 20; //
Access a Record field via function call

// |- \ | ————- \

// |

// Function returns TCircle Access to one
field of TCircle
end.
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Forward declaration

A function can be declared without having it followed by it's implementation, by hav-
ing it followed by the forward procedure. The effective implementation of that func-
tion must follow later in the unit. The function can be used after a forward declara-
tion as if it had been implemented already. The following is an example of a forward
declaration:

program Volume;

var Volume : word;
function First(a, b : word) : word; forward;
function Second(c : word) : word;
var tmp : word;
begin
tmp := First (2, 3);
result := tmp * c;
end;
function First(a, b : word) : word;
begin
result := a * Dby
end;
begin
Volume := Second(4);
end.
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TYPES

Pascal is strictly typed language, which means that every variable and constant
need to have a strictly defined type, known at the time of compilation.

The type serves:

- to determine correct memory allocation required,
- to interpret the bit patterns found in the object during subsequent accesses,
- in many type-checking situations, to ensure that illegal assignments are trapped.

mikroPascal PRO for AVR supports many standard (predefined) and user-defined
data types, including signed and unsigned integers of various sizes, arrays, strings,
pointers and records.

Type Categories
Types can be divided into:

- simple types
- arrays

- strings

- pointers

- records
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mikroPASCAL PRO for AVR

SIMPLE TYPES

Simple types represent types that cannot be divided into more basic elements and
are the model for representing elementary data on machine level. Basic memory
unit in mikroPascal PRO for AVR has 16 bits.

Here is an overview of simple types in mikroPascal PRO for AVR:

Type Size Range

byte, char |8-bit 0..255

short 8-bit -127 .. 128

word 16-bit 0 .. 65535

integer 16-bit -32768 .. 32767

dword 32-bit 0 .. 4294967295

longint 32—bit -2147483648 .. 2147483647
bit 1-bit Oor1

sbit 1-bit 0or1

You can assign signed to unsigned or vice versa only using the explicit conversion.
Refer to Types Conversions for more information.
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ARRAYS

An array represents an indexed collection of elements of the same type (called the
base type). Because each element has a unique index, arrays, unlike sets, can
meaningfully contain the same value more than once.

Array Declaration

Array types are denoted by constructions in the following form:

array| index start .. index end] of type

Each of the elements of an array is numbered from index start through
index end. The specifier index start can be omitted along with dots, in which

case it defaults to zero.

Every element of an array is of - ype and can be accessed by specifying array name
followed by element’s index within brackets.

Here are a few examples of array declaration:

var
weekdays : array[ 1..7] of byte;
samples : array| 50] of word;
begin
// Now we can access elements of array variables, for example:
samples[ 0] := 1;
if samples[ 377 = 0 then ...

Constant Arrays

Constant array is initialized by assigning it a comma-delimited sequence of values
within parentheses. For example:

// Declare a constant array which holds number of days in each month:
const MONTHS : array[ 1..12] of byte =
(31,28,31,30,31,30,31,31,30,31,30,31);

The number of assigned values must not exceed the specified length. The opposite
is possible, when the trailing “excess” elements are assigned zeroes.

For more information on arrays of char, refer to Strings.
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Multi-dimensional Arrays

Multidimensional arrays are constructed by declaring arrays of array type. These
arrays are stored in memory in such way that the right most subscript changes
fastest, i.e. arrays are stored “in rows”. Here is a sample 2-dimensional array:

m : arrayl 5] of arrayl 10] of byte; // 2-dimensional array of size
5x10

A variable m is an array of 5 elements, which in turn are arrays of 10 byte each.
Thus, we have a matrix of 5x10 elements where the first element is [ 0][ 0] and
last one is 1 4]1[ 9] . The first element of the 4th row would be [ 31[ 0] .
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STRINGS

A string represents a sequence of characters equivalent to an array of char. It is
declared like this:

string name : string] length]

The specifier length is a number of characters the string consists of. String is stored
internally as the given sequence of characters plus a final null character which is
introduced to terminate the string. It does not count against the string’s total length.

A null string (' ') is stored as a single null character.

You can assign string literals or other strings to string variables. String on the right
side of an assignment operator has to be shorter or of equal length than the one on
the right side. For example:

var
msgl : stringl 20] ;

msg2 : stringl 19];

begin
msgl := 'This is some message';
msg?2 := 'Yet another message';
msgl := msg2; // this is ok, but vice versa would be illegal

Alternately, you can handle strings element-by—element. For example:
var s : string] 5] ;

s := 'mik';
{

char literal 'm'

)]
-

char literal 'i'

char literal 'k'

)]
-

)]
- -

zZero
undefined
undefined

o nnns o0
BB b
w n n n n

g w NP O

S

}

Be careful when handling strings in this way, since overwriting the end of a string will
cause an unpredictable behavior.
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String Concatenating

mikroPascal PRO for AVR allows you to concatenate strings by means of plus oper-
ator. This kind of concatenation is applicable to string variables/literals, character
variables/literals. For control characters, use the non-quoted hash sign and a
numeral (e.g. #13 for CR).

Here is an example:

var msg : stringf 20] ;
res txt : stringf 5];
res, channel : word;
begin
/...

// Get result of ADC
res := Adc Read(channel);

// Create string out of numeric result
WordToStr (res, res txt);

// Prepare message for output
msg := 'Result is ' + // Text "Result is"
res_txt ; // Result of ADC

/] ...

Note: In current version plus operator for concatenating strings will accept at most
two operands.

Note

mikroPascal PRO for AVR includes a String Library which automatizes string relat-
ed tasks.
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POINTERS

A pointer is a data type which holds a memory address. While a variable accesses
that memory address directly, a pointer can be thought of as a reference to that
memory address.

To declare a pointer data type, add a carat prefix (~) before type. For example, in
order to create a pointer to an integer, write:

~“integer;
In order to access data at the pointer’'s memory location, add a carat after the vari-
able name. For example, let's declare variable p which points to a word, and then

assign value 5 to the pointed memory location:

var p : “word;

A pointer can be assigned to another pointer. However, note that only the address,
not the value, is copied. Once you modify the data located at one pointer, the other
pointer, when dereferenced, also yields modified data.

Pointers to program memory space are declared using the keyword const:
program const ptr;

// constant array will be stored in program memory

const b array: arrayl 5] of byte = (1,2,3,4,5);
const ptr: “byte; // ptr 1is pointer to program memory space
begin
ptr := @b _array; // ptr now points to b arrayl 0]
PO := ptr”";
ptr 1= ptr + 3; // ptr now points to b array| 3]
PO := ptr”";
end.

Function Pointers

Function pointers are allowed in mikroPascal PRO for AVR. The example shows
how to define and use a function pointer:

Example:

Example demonstrates the usage of function pointers. It is shown how to declare a
procedural type, a pointer to function and finally how to call a function via pointer.
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program Example;

type TMyFunctionType = function (paraml, param2: byte; param3: word)
word; // First, define the procedural type
var MyPtr: "TMyFunctionType;
// This 1is a pointer to previously defined type
Sample: word;

function Funcl (pl, p2: byte; p3: word): word;// Now, define few
functions which will be pointed to. Make sure that parameters match
the type definition

begin

result := pl and p2 or p3; // return something
end;
function Func2 (abc: byte; def: byte; ghi: word): word; // Another

function of the same kind. Make sure that parameters match the type
definition
begin

result := abc * def + ghi; // return something
end;

function Func3 (first, yellow: byte; monday: word): word// Yet anoth-
er function. Make sure that parameters match the type definition
begin

result := monday - yellow - first; // return something
end;

// main program:

begin
MyPtr := @Funcl; ,// MyPtr now points to Funcl
Sample := MyPtr~ (1, 2, 3); // Perform function call via
pointer, call Funcl, the return value 1is 3
MyPtr := @Func2; // MyPtr now points to Func2
Sample := MyPtr~ (1, 2, 3); // Perform function call via
pointer, call Func2, the return value 1is 5
MyPtr := @Func3; // MyPtr now points to Func3
Sample := MyPtr~ (1, 2, 3); // Perform function call via
pointer, call Func3, the return value is 0
end.
@ Operator

The @ operator returns the address of a variable or routine, i.e. @ constructs a point-
er to its operand. The following rules are applied to @:

- If X'is a variable, @x returns the address of x.
- If 7 is a routine (a function or procedure), @ returns F’s entry point (the result is of
longint)
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Records

A record (analogous to a structure in some languages) represents a heterogeneous
set of elements. Each element is called a field. The declaration of the record type
specifies a name and type for each field. The syntax of a record type declaration is

type recordTypeName = record
fieldListl : typel;

fieldListn : typen;
end;

where recordTypeName is a valid identifier, each type denotes a type, and each
fieldList is a valid identifier or a comma-delimited list of identifiers. The scope of
a field identifier is limited to the record in which it occurs, so you don’t have to worry
about naming conflicts between field identifiers and other variables.

Note: In mikroPascal PRO for AVR, you cannot use the record construction direct-
ly in variable declarations, i.e. without type.

For example, the following declaration creates a record type called Tpot:

type
TDot = record
X, y : real;

end;

Each Tpot contains two fields: x and y coordinates. Memory is allocated when you
declare the record, like this:

var m, n: TDot;
This variable declaration creates two instances of TDot, called m and n.

A field can be of previously defined record type. For example:

// Structure defining a circle:

type
TCircle = record
radius : real;
center : TDot;

end;
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Accessing Fields
You can access the fields of a record by means of dot (.) as a direct field selector.
If we have declared variables circiel and circle2 of previously defined type

TCircle:

var circlel, circle2 : TCircle;

we could access their individual fields like this:

circlel.radius := 3.7;
circlel.center.x := 0;
circlel.center.y := 0

You can also commit assignments between complex variables, if they are of the
same type:

circle2 := circlel; // This will copy values of all fields
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TYPES CONVERSIONS

Conversion of variable of one type to a variable of another type is typecasting. mikroPas-
cal PRO for AVR supports both implicit and explicit conversions for built-in types.

Implicit Conversion
Compiler will provide an automatic implicit conversion in the following situations:

- statement requires an expression of particular type (according to language defini
tion), and we use an expression of different type,

- operator requires an operand of particular type, and we use an operand of differ
ent type,

- function requires a formal parameter of particular type, and we pass it an object of
different type,

- result does not match the declared function return type.

Promotion

When operands are of different types, implicit conversion promotes the less com-
plex type to more complex type taking the following steps:

byte/char =~ word
short ~* integer
short -+ longint
integer =+ longint
integer =~ real

Higher bytes of extended unsigned operand are filled with zeroes. Higher bytes of
extended signed operand are filled with bit sign (if number is negative, fill higher
bytes with one, otherwise with zeroes). For example:

var a : byte; b : word;

a := SFF;

b := a; // a is promoted to word, b becomes S$SO00FF
Clipping

In assignments and statements that require an expression of particular type, desti-
nation will store the correct value only if it can properly represent the result of
expression, i.e. if the result fits in destination range.

If expression evaluates to a more complex type than expected, excess of data will
be simply clipped (higher bytes are lost).
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Explicit Conversion

Explicit conversion can be executed at any point by inserting type keyword (byte,
word, short, integer, longint or real) ahead of an expression to be converted. The
expression must be enclosed in parentheses. Explicit conversion can be performed
only on the operand right of the assignment operator.

Special case is conversion between signed and unsigned types. Explicit conversion
between signed and unsigned data does not change binary representation of data
— it merely allows copying of source to destination.

For example:

var a : byte; b : short;

b := -1;
a := byte(b); // a is 255, not 1

// This 1is because binary representation remains
// 11111111; it's just interpreted differently now

You can’t execute explicit conversion on the operand left of the assignment operator:
word (b) := a; // Compiler will report an error
Conversions Examples

Here is an example of conversion:

var a, b, c : byte;

d : word;
a := 241;
b := 128;
c := a + b; // equals 113
c := word(a + Db);: // equals 113
d :=a + b; // equals 369
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OPERATORS

Operators are tokens that trigger some computation when being applied to variables
and other objects in an expression.

There are four types of operators in mikroPascal PRO for AVR:

- Arithmetic Operators
- Bitwise Operators

- Boolean Operators

- Relational Operators
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Operators Precedence and Associativity

There are 4 precedence categories in mikroPascal PRO for AVR. Operators in the same
category have equal precedence with each other.

Each category has an associativity rule: left-to-right (- ), or right-to-left (). In the
absence of parentheses, these rules resolve the grouping of expressions with operators
of equal precedence.

Precedence |Operands|Operators Associativity
4 1 d not + - -
3 2 * / div  mod and shl shr |-
2 2 - or  xor .
1 2 = <> < > <= >= >

Arithmetic Operators

Arithmetic operators are used to perform mathematical computations. They have numer-
ical operands and return numerical results. Since the char operators are technically bytes,
they can be also used as unsigned operands in arithmetic operations.

All arithmetic operators associate from left to right.

Operator Operation Operands Result
byte, short, word, byte, short,word,
+ addition integer, longint, integer, longint,
dword, real dword, real
byte, short, word, byte, short,word,
- subtraction integer, longint, integer, longint,
dword, real dword, real
byte, short, word, word, integer,
* multiplication integer, longint, longint, dword,
dword, real real

byte, short, word,
/ division, floating-point |integer, longint, real
dword, real

.. byt h t
division, rounds down |[byte, short, word, yte, Short,

div . ) . word, integer,
to nearest”neger integer, longint,dword longint, dword
modulus, returns the _— - B _— -
remainder of integer YRS BROER, WOTd YEes mnorh

mod divisi tb integer, longint, word, integer,

|wswn(canno e dword longint, dword

used with floatin points)

156 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 5
mikroPASCAL PRO for AVR Language Reference

Division by Zero

If O (zero) is used explicitly as the second operand (i .c. = div 0), the compiler
will report an error and will not generate code.

But in case of implicit division by zero: x div v, where y is 0 (zero), the result will
be the maximum integer (i.e 255, if the result is byte type; 655356, if the result is word
type, etc.).

Unary Arithmetic Operators

Operator - can be used as a prefix unary operator to change sign of a signed value.
Unary prefix operator + can be used, but it doesn’t affect data.

For example:
b = -a;
Relational Operators

Use relational operators to test equality or inequality of expressions. All relational
operators return TRUE or FALSE.

Operator Operation

= equal

<> not equal

> greater than

< less than

>= greater than or equal
<= less than or equal

All relational operators associate from left to right.
Relational Operators in Expressions

Precedence of arithmetic and relational operators is designated in such a way to
allow complex expressions without parentheses to have expected meaning:

a+ 5> c¢c - 1.0/ e // = (a + 5) >= (¢ - (1.0 / e))
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Bitwise Operators

Use bitwise operators to modify individual bits of numerical operands. Operands
need to be either both signed or both unsigned.

Bitwise operators associate from left to right. The only exception is the bitwise com-
plement operator not which associates from right to left.

Bitwise Operators Overview

Operator Operation

g bitwise AND; compares pairs of bits and generates a 1 result if both
bits are 1, otherwise it returns 0

. bitwise (inclusive) OR; compares pairs of bits and generates a 1
result if either or both bits are 1, otherwise it returns 0
bitwise exclusive OR (XOR); compares pairs of bits and generates a

XOor . . . .
1 result if the bits are complementary, otherwise it returns 0

not bitwise complement (unary); inverts each bit

. bitwise shift left; moves the bits to the left, discards the far left bit
and assigns 0 to the right most bit.

iy bitwise shift right; moves the bits to the right, discards the far right bit
and if unsigned assigns 0 to the left most bit, otherwise sign extends

Logical Operations on Bit Level

and| 0 | 1 or| 0|1
0(0]O o0 1
1101 1 (11

xor( 0 | 1 not| 0 | 1
001 110
11110

Bitwise operators and, or, and xor perform logical operations on the appropriate pairs of
bits of their operands. not operator complements each bit of its operand. For example:

158 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 5
mikroPASCAL PRO for AVR Language Reference

$1234 and $5678 // equals $1230
{ because

$1234 : 0001 0010 0011 0100
$5678 : 0101 0110 0111 1000

and : 0001 0010 0011 0000

. that is, $1230 }// Similarly:

$1234 or $5678 // equals $567C
$1234 xor $5678 // equals $444C
not $1234 // equals SEDCB

Unsigned and Conversions

If a number is converted from less complex to more complex data type, the upper
bytes are filled with zeroes. If a number is converted from more complex to less
complex data type, the data is simply truncated (the upper bytes are lost).

For example:
var a : byte; b : word;
a := S$SAA;
b := SFOFO;
b := b and a;
{

a is extended with zeroes; b becomes $00A0 }
Signed and Conversions

If number is converted from less complex data type to more complex, upper bytes
are filled with ones if sign bit is 1 (number is negative); upper bytes are filled with
zeroes if sign bit is 0 (number is positive). If number is converted from more com-
plex data type to less complex, data is simply truncated (upper bytes are lost).

For example:

var a : byte; b : word;
a := -12;
b := S$T0FF;
b := b and a;

{ a is sign extended, with the upper byte equal to S$FF;
b becomes $70F4 }

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 159



CHAPTER 5
Language Reference mikroPASCAL PRO for AVR

Bitwise Shift Operators

Binary operators sh1 and shr move the bits of the left operand by a number of posi-
tions specified by the right operand, to the left or right, respectively. Right operand
has to be positive and less than 255.

With shift left (sh1), left most bits are discarded, and “new” bits on the right are
assigned zeroes. Thus, shifting unsigned operand to the left by n positions is equiv-

alent to multiplying it by 2" if all discarded bits are zero. This is also true for signed
operands if all discarded bits are equal to the sign bit.

With shift right (shr), right most bits are discarded, and the “freed” bits on the left
are assigned zeroes (in case of unsigned operand) or the value of the sign bit (in
case of signed operand). Shifting operand to the right by n positions is equivalent to

dividing it by 2N.
Boolean Operators

Although mikroPascal PRO for AVR does not support boolean type, you have
Boolean operators at your disposal for building complex conditional expressions.
These operators conform to standard Boolean logic and return either TrUE (all ones)
or FALSE (zero):

Operator |Operation

and logical AND

or logical OR

xor logical exclusive OR (XOR)
not logical negation

Boolean operators associate from left to right. Negation operator not associates
from right to left.
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EXPRESSIONS

An expression is a sequence of operators, operands and punctuators that returns a value.

The primary expressions include: literals, constants, variables and function calls.
More complex expressions can be created from primary expressions by using oper-
ators. Formally, expressions are defined recursively: subexpressions can be nested
up to the limits of memory.

Expressions are evaluated according to certain conversion, grouping, associativity
and precedence rules which depend on the operators in use, presence of parenthe-
ses and data types of the operands. The precedence and associativity of the oper-
ators are summarized in Operator Precedence and Associativity. The way operands
and subexpressions are grouped does not necessarily specify the actual order in
which they are evaluated by mikroPascal PRO for AVR.
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STATEMENTS

Statements define algorithmic actions within a program. Each statement needs to
be terminated with a semicolon (;). In the absence of specific jump and selection
statements, statements are executed sequentially in the order of appearance in the
source code.

The most simple statements are assignments, procedure calls and jump statements.
These can be combined to form loops, branches and other structured statements.

Refer to:

- Assignment Statements

- Compound Statements (Blocks)
- Conditional Statements

- lteration Statements (Loops)

- Jump Statements

- asm Statement
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Assignment Statements

Assignment statements have the form:

variable := expression;

The statement evaluates expression and assigns its value to variable. All the rules
of implicit conversion are applied. variable can be any declared variable or array
element, and expression can be any expression.

Do not confuse the assignment with relational operator = which tests for equality. Also
note that, although similar, the construction is not related to the declaration of constants.

Compound Statements (Blocks)

Compound statement, or block, is a list of statements enclosed by keywords begin
and end:

begin
statements
end;

Syntactically, a block is considered to be a single statement which is allowed to be
used when Pascal syntax requires a single statement. Blocks can be nested up to
the limits of memory.

For example, the while loop expects one statement in its body, so we can pass it a
compound statement:

while i < n do

begin
temp := a[ i] ;
al 1] = M[ 1] ;
bl 1] := temp;
i :=1 + 1;
end;

Conditional Statements

Conditional or selection statements select one of alternative courses of action by
testing certain values. There are two types of selection statements:

- if

- case
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If Statement

Use if to implement a conditional statement. The syntax of i statement has the
form:

if expression then statementl [ else statement?2]

If expression evaluates to true then statement1 executes. If expression is false
then statement2 executes. The expression must convert to a boolean type; other-
wise, the condition is ill-formed. The e1se keyword with an alternate statement
(StatementQ)iSOpﬁonaL

There should never be a semicolon before the keyword c1se.
Nested if statements

Nested if statements require additional attention. A general rule is that the nested
conditionals are parsed starting from the innermost conditional, with each else
bound to the nearest available if on its left:

if expressionl then
if expression2 then statementl
else statement2

The compiler treats the construction in this way:

if expressionl then

begin
if expression2 then statementl
else statement2

end

In order to force the compiler to interpret our example the other way around, we
have to write it explicitly:

if expressionl then
begin
if expression2 then statementl
end
else statement2
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Case statement

Use the case statement to pass control to a specific program branch, based on a
certain condition. The case statement consists of a selector expression (a condition)
and a list of possible values. The syntax of the case statement is:

case selector of
value 1 : statement 1

value n : statement n
[ else default statement]
end;

selector is an expression which should evaluate as integral value. va1ues can be
literals, constants, or expressions, and statements can be any statements.

The c1se clause is optional. If using the else branch, note that there should never
be a semicolon before the keyword c1se.

First, the se1ector expression (condition) is evaluated. Afterwards the case state-
ment compares it against all available values. If the match is found, the statement
following the match evaluates, and the case statement terminates. In case there are
multiple matches, the first matching statement will be executed. If none of values
matches selector, then default statement in the else clause (if there is some) is
executed.

Here’s a simple example of the case statement:

case operator of

'*' : result := nl * n2;
'/'" : result := nl / n2;
'+' : result := nl + n2;
'-'" : result := nl - n2
else result := 0;
end;

Also, you can group values together for a match. Simply separate the items by commas:

case reg of
0: opmode := 0;
1,2,3,4: opmode := 1
5,6,7: opmode := 2;
end;
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In mikroPascal PRO for AVR, values in the case statement can be variables too:
case byte variable of

byte varl: opmode := 0; // this will be compiled correctly

byte var2:
opmode := 1; // avoid this case, compiler will parse
// a variable followed by colon sign as label

byte var3: // adding a comment solves the parsing problem

opmode := 2;
end;

Nested Case statement

Note that the case statements can be nested — values are then assigned to the
innermost enclosing case statement.
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ITERATION STATEMENTS

Iteration statements let you loop a set of statements. There are three forms of iter-
ation statements in mikroPascal PRO for AVR:

- for
- while
- repeat

You can use the statements break and continue to control the flow of a loop state-
ment. break terminates the statement in which it occurs, while continue begins exe-
cuting the next iteration of the sequence.
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For Statement

The for statement implements an iterative loop and requires you to specify the num-
ber of iterations. The syntax of the for statement is:

for counter := initial value to final value do statement
// or
for counter := initial value downto final value do statement

counter is a variable which increments (or decrements if you use downto) with each
iteration of the loop. Before the first iteration, counter is setto initial value and
will increment (or decrement) until it reaches final value. With each iteration,
statement will be executed.

initial value and final value should be expressions compatible with count-
er; statement can be any statement that does not change the value of counter.

Here is an example of calculating scalar product of two vectors, a and b, of length
n, using the for statement:

for i := 0 to n-1 do
s := s + al i] * p[ 1] ;
Endless Loop

The for statement results in an endless loop if final_value equals or exceeds the
range of the counter’s type.

More legible way to create an endless loop in Pascal is to use the statement while
TRUE do.
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While Statement

Use the while keyword to conditionally iterate a statement. The syntax of the while
statement is:

while expression do statement
statement iS executed repeatedly as long as expression evaluates true. The test
takes place before the statement is executed. Thus, if expression evaluates false

on the first pass, the loop does not execute.

Here is an example of calculating scalar product of two vectors, using the while

statement:

s := 0; 1 := 0;

while i < n do

begin
s := s + a[i] * bl 1i];
i =1 + 1;

end;

Probably the easiest way to create an endless loop is to use the statement:

while TRUE do ...;
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Repeat Statement

The repeat statement executes until the condition becomes false. The syntax of the
repeat statement is:

repeat statement until expression

statement IS executed repeatedly as long as expression evaluates true. The
expression is evaluated after each iteration, so the loop will execute statement at
least once.

Here is an example of calculating scalar product of two vectors, using the repeat
statement:

repeat
begin
s = s + ai] * [ i];
i :=1 + 1;
end;
until 1 = n;
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JUMP STATEMENTS

A jump statement, when executed, transfers control unconditionally. There are four
such statements in mikroPascal PRO for AVR:

- break

- continue
- exit

- goto
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Break and Continue Statements
Break Statement

Sometimes, you might need to stop the loop from within its body. Use the break
statement within loops to pass control to the first statement following the innermost
loop (for, while, or repeat block).

For example:

Led Out (1,1, '"Insert CF card');

// Wait for CF card to be plugged; refresh every second
while TRUE do
begin
if Cf Detect() = 1 then break;
Delay ms (1000);
end;

// Now we can work with CF card ...
Led Out (1,1, 'Card detected ),

Continue Statement
You can use the continue statement within loops to “skip the cycle”™

- continue statement in for loop moves program counter to the line with keyword for

- continue statement in while loop moves program counter to the line with loop con
dition (top of the loop),

- continue statement in repeat loop moves program counter to the line with loop
condition (bottom of the loop).

// continue jumps here
for i := ... do
begin
continue;
end;
// continue jumps here
while condition do
begin
continue;

end;
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begin
continue;

// continue jumps here
until condition;

Exit Statement

The exit statement allows you to break out of a routine (function or procedure). It
passes the control to the first statement following the routine call.

Here is a simple example:

procedure Procl();
var error: byte;
begin
// we're doing something here
if error = TRUE then exit;
// some code, which won't be executed if error is true
end;

Note: If breaking out of a function, return value will be the value of the local variable
result at the moment of exit.
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Goto Statement

Use the goto statement to unconditionally jump to a local label — for more informa-
tion, refer to Labels. Syntax of goto statement is:

goto label name;

This will transfer control to the location of a local label specified by 1abe1l name. The
goto line can come before or after the label.

The label declaration, marked statement and goto statement must belong to the
same block. Hence it is not possible to jump into or out of a procedure or function.

You can use goto to break out from any level of nested control structures. Never jump into
a loop or other structured statement, since this can have unpredictable effects.

Use of goto statement is generally discouraged as practically every algorithm can
be realized without it, resulting in legible structured programs. One possible appli-
cation of goto statement is breaking out from deeply nested control structures:

for (...) do
begin
for (...) do
begin

if (disaster) then goto Error;

end;
end;

Error: // error handling code
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asm Statement

mikroPascal PRO for AVR allows embedding assembly in the source code by
means of the asm statement. Note that you cannot use numerals as absolute
addresses for register variables in assembly instructions. You may use symbolic
names instead (listing will display these names as well as addresses).

You can group assembly instructions with the asm keyword:

asm
block of assembly instructions

end;

If you plan to use a certain Pascal variable in embedded assembly only, be sure to
at least initialize it (assign it initial value) in Pascal code; otherwise, the linker will
issue an error. This is not applied to predefined globals such as PO.

For example, the following code will not be compiled because the linker won’t be
able to recognize the variable myvar:

program test;

var myvar : word;
begin
asm
MOV #10, WO
MOV w0, myvar
end;
end.

Adding the following line (or similar one ) above the asm block would let linker know
that variable is used:

myvar := 20;
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DIRECTIVES

Directives are words of special significance which provide additional functionality
regarding compilation and output.

The following directives are available for use:

- Compiler directives for conditional compilation,
- Linker directives for object distribution in memory.
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Compiler Directives

mikroPascal PRO for AVR treats comments beginning with a “$” immediately fol-
lowing an opening brace as a compiler directive; for example, { st1.sE} . The compil-
er directives are not case sensitive.

You can use a conditional compilation to select particular sections of code to com-
pile, while excluding other sections. All compiler directives must be completed in the
source file in which they have begun.

Directives $DEFINE and SUNDEFINE

Use directive sper1nE to define a conditional compiler constant (*f129”). You can
use any identifier for a flag, with no limitations. No conflicts with program identifiers
are possible because the flags have a separate name space. Only one flag can be
set per directive.

For example:
{ SDEFINE Extended format}
Use sunperINE to undefine (“clear”) previously defined flag.

Note: Pascal does not support macros; directives sper1nE and suNDEFINE do not cre-
ate/destroy macros. They only provide flags for directive $1rpEF to check against.

Directives $IFDEF..$ELSE

Conditional compilation is carried out by the s1rDEF directive. s1FDEF tests whether
a flag is currently defined or not, i.e. whether a previous sper1nE directive has been
processed for that flag and is still in force.

Directive s1rpEF is terminated with the sEnp1F directive, and can have an optional
SELSE clause:

{ SIFDEF flag}

<block of code>
{ SELSE}

<alternate block of code>
{ SENDIF}

First, strpEF checks if flag is defined by means of sperinE. If SO, only <block of
code> will be compiled. Otherwise, <alternate block of code> will be compiled.
sENDTF ends the conditional sequence. The result of the preceding scenario is that only
one section of code (possibly empty) is passed on for further processing.
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The processed section can contain further conditional clauses, nested to any depth;
each s1rpEr must be matched with a closing $ENDIF.

Here is an example:

// Uncomment the appropriate flag for your application:
//{ SDEFINE resolutionl0}
//{ SDEFINE resolutionl?2}

{ SIFDEF resolutionl0}
// <code specific to 10-bit resolution>
{ SELSE}
{ SIFDEF resolutionl?2}
// <code specific to 12-bit resolution>
{ SELSE}
// <default code>
{ SENDIF}
{ SENDIF}

Include Directive $I

The $1 parameter directive instructs mikroPascal PRO for AVR to include the named
text file in the compilation. In effect, the file is inserted in the compiled text right after
the { 1 filename} directive. If flename does not specify a directory path, then, in
addition to searching for the file in the same directory as the current unit, mikroPas-
cal PRO for AVR will search for file in order specified by the search paths.

To specify a filename that includes a space, surround the file name with quotation
marks:{ $1T "My file"} .

There is one restriction to the use of include files: An include file can't be specified
in the middle of a statement part. In fact, all statements between the begin and end
of a statement part must exist in the same source file.

Predefined Flags

The compiler sets directives upon completion of project settings, so the user does-
n't need to define certain flags.
Here is an example:

{ SIFDEF ATMEGA1lG6} // If ATmegal6 MCU is selected
{ SIFDEF ATMEGA128} // IF ATmegal28 MCU is selected

In some future releases of the compiler, the JTAG flag will be added also.

See also predefined project level defines.
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Linker Directives

mikroPascal PRO for AVR uses internal algorithm to distribute objects within mem-
ory. If you need to have a variable or a routine at the specific predefined address,
use the linker directives absolute and org.

Note: You must specify an even address when using the linker directives.
Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the vari-
able spans more than 1 word (16-bit), the higher words will be stored at the consec-
utive locations.

Directive absolute is appended to the declaration of a variable:

var x : word; absolute $32;
// Variable x will occupy 1 word (16 bits) at address $32

y : longint; absolute $34;
// Variable y will occupy 2 words at addresses $34 and $36

Be careful when using the absolute directive because you may overlap two vari-
ables by accident. For example:

var 1 : word; absolute $42;
// Variable 1 will occupy 1 word at address $42;

j3j : longint; absolute $40;

// Variable will occupy 2 words at $40 and $42; thus,

// changing 1 changes jj at the same time and vice versa
Note: You must specify an even address when using the absolute directive.
Directive org

Directive org specifies the starting address of a routine in ROM. It is appended to
the declaration of a routine. For example:

procedure proc (par : byte); org $200;
begin
// Procedure will start at address $200;

end;
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org directive can be used with main routine too. For example:
program Led Blinking;

procedure some proc();
begin

end;
org 0x800; // main procedure starts at 0x800
begin

DDRB := OxFF;

while TRUE do

begin
PORTB := 0x00;
Delay ms (500);
PORTB := OXxFF;
Delay ms (500);
end;

end.

Note: You must specify an even address when using the org directive.
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mikroPascal PRO for AVR provides a set of libraries which simplify the initialization
and use of AVR compliant MCUs and their modules:

Use Library manager to include mikroPascal PRO for AVR Libraries in you project.
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Hardware AVR-specific Libraries

- ADC Library

- CANSPI Library

- Compact Flash Library

- EEPROM Library

- Flash Memory Library

- Graphic Lcd Library

- Keypad Library

- Led Library

- Manchester Code Library
- Multi Media Card library
- OneWire Library

- Port Expander Library

- PS/2 Library

- PWM Library

- PWM 16 bit Library

- RS-485 Library

- Software 12C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Graphic Lcd Library
- SPI Lcd Library

- SPI Lcd8 Library

- SPI1 T6963C Graphic Lcd Library
- T6963C Graphic Lcd Library
- TWI Library

- UART Library

Miscellaneous Libraries

- Button Library

- Conversions Library
- Math Library

- String Library

- Time Library

- Trigonometry Library

See also Built-in Routines.
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LIBRARY DEPENDENCIES

Certain libraries use (depend on) function and/or variables, constants defined in

other libraries.
Image below shows clear representation about these dependencies.

For example, SPI_Glcd uses Glcd_Fonts and Port_Expander library which

uses SPI library.
This means that if you check SPI_Gilcd library in Library manager, all libraries on

which it depends will be checked too.
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Related topics: Library manager, AVR Libraries
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ADC LIBRARY

ADC (Analog to Digital Converter) module is available with a number of AVR micros. Library function

ADC Read is included to provide you comfortable work with the module in single-ended mode.

ADC_Read
Prokﬂype function ADC Read( channel : byte ) : word;
Returns 10-bit or 12-bit (MCU dependent) unsigned value from the specified channel.

Description

Initializes AVR ’s internal ADC module to work with XTAL frequency prescaled by
128. Clock determines the time period necessary for performing A/D conversion.

Parameter channel represents the channel from which the analog value is to be
acquired. Refer to the appropriate datasheet for channel-to-pin mapping.

Requires Nothing.
var tmp : word;
Exan“ﬂe tmp := ADC_Read(2); // Read analog value from channel 2

Library Example

Library Example

This example code reads analog value from channel 2 and displays it on PORTB and PORTC.

program ADC on LEDs;

var adc rd : word;
begin
DDRB := OxFF; // Set PORTB as output
DDRC := OxFF; // Set PORTC as output
while TRUE do
begin
adc_rd := ADC Read(2); // get ADC value from 2nd channel
PORTB := adc_rd; // display adc rd[ 7..0]
PORTC := Hi(adc rd); // display adc_rd 9..8]
end;
end.
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HW Connection
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CANSPI LIBRARY

The SPI module is available with a number of the AVR compliant MCUs. The mikroPascal PRO
for AVR provides a library (driver) for working with mikroElektronika's CANSPI Add-on boards
(with MCP2515 or MCP2510) via SPI interface.

The CAN is a very robust protocol that has error detection and signalization, self-checking and
fault confinement. Faulty CAN data and remote frames are re-transmitted automatically, similar
to the Ethernet.

Data transfer rates depend on distance. For example, 1 Mbit/s can be achieved at network
lengths below 40m while 250 Kbit/s can be achieved at network lengths below 250m. The greater
distance the lower maximum bitrate that can be achieved. The lowest bitrate defined by the stan-
dard is 200Kbit/s. Cables used are shielded twisted pairs.

CAN supports two message formats:

- Standard format, with 11 identifier bits and
- Extended format, with 29 identifier bits

Note:

- Consult the CAN standard about CAN bus termination resistance.

- An effective CANSPI communication speed depends on SPI and certainly is slow
er than “real” CAN.

- CANSPI module refers to mikroElektronika's CANSPI Add-on board connected to
SPI module of MCU.

- Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with
the appropriate SPI_Read routine.

External dependencies of CANSPI Library

The following variables must be

defined in all projects using Description: Example :
Sound Library:

var CanSpi CS : sbit; sfr; . . var CanSpi CS : sbit at
external; Chip Select line. PORTB.BO;
var CanSpi Rst : sbit; sfr; Reset line var CanSpi Rst : sbit at
external; ' PORTB.B2;
var CanSpi CS Bit Direction : [Direction of the Chip [var canspi €S Bit Direction
sbit; sfr; external; Select pin_ : sbit at DDRB.BO;
var CanSpi Rst Bit Direction Direction of the var CanSpi Rst Bit Direction
: sbit; sfr; external; Reset pin_ : sbit at DDRB.B2;
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Library Routines

- CANSPISetOperationMode
- CANSPIGetOperationMode
- CANSPIInitialize

- CANSPISetBaudRate

- CANSPISetMask

- CANSPISetFilter

- CANSPIread

- CANSPIWrite

The following routines are for an internal use by the library only:

- RegsToCANSPIID
- CANSPIIDToRegs

Be sure to check CANSPI constants necessary for using some of the functions.

CANSPISetOperationMode

Prokﬂype procedure CANSPISetOperationMode (mode: byte; WAIT: byte);

Returns Nothing.

Sets the CANSPI module to requested mode.
Parameters :

- mode: CANSPI module operation mode. Valid values: cansPI 0P MODE

Description | constants (see CANSPI constants).

- wa1T: CANSPI mode switching verification request. If watT = 0, the call is non
blocking. The function does not verify if the CANSPI module is switched to request-
ed mode or not. Caller must use CANSPIGetOperationMode to verify correct oper-
tion mode before performing mode specific operation. If watT = 0, the call is
blocking — the function won't “return” until the requested mode is set.

The CANSPI routines are supported only by MCUs with the SPI module.

Requires . I
q MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.
// set the CANSPI module into configuration mode (wait inside
Example CANSPISetOperationMode until this mode is set)

CANSPTSetOperationMode(CANSPTAMODEACONFTG, O0xFF) ;
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CANSPIGetOperationMode

Prokﬂype function CANSPIGetOperationMode (): byte;
Returns Current operation mode.

The function returns current operation mode of the CANSPI module. Check
Description |canspr op MoDE constants (see CANSPI constants) or device datasheet for

operation mode codes.

The CANSPI routines are supported only by MCUs with the SPI module.
Requires MCU has to be properly connected to mikroElektronika's CANSPI Extra Board

or similar hardware. See connection example at the bottom of this page.

// check whether the CANSPI module is in Normal mode and if it

is do something.

if (CANSPIGetOperationMode () = CANSPI MODE NORMAL) then
Example beqi - -

egin
ena;

CANSPIinitialize

Prototype

procedure CANSPIInitialize(SJW: byte; BRP: byte; PHSEGl: byte;
PHSEG2: byte; PROPSEG: byte; CAN CONFIG FLAGS: byte);

Returns

Nothing.

Description

Initializes the CANSPI| module.
Stand-Alone CAN controller in the CANSPI module is set to:

- Disable CAN capture

- Continue CAN operation in Idle mode

- Do not abort pending transmissions

- Fcan clock: 4*Tcy (Fosc)

- Baud rate is set according to given parameters

- CAN mode: Normal

- Filter and mask registers IDs are set to zero

- Filter and mask message frame type is set according to can coNFIG FLAGS value

SAM, SEG2PHTS, WAKFIL and DBEN bits are set according tocan conrIc FLaGs value.

Parameters:

- sgw as defined in CAN controller's datasheet

- BrP as defined in CAN controller's datasheet

- pHSEG1 as defined in CAN controller's datasheet

- pHSEG2 as defined in CAN controller's datasheet

- proPsEG as defined in CAN controller's datasheet

- CAN CONFIG FLAGS is formed from predefined constants (see CANSPI constants)
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Global variables :

- canspi cs: Chip Select line

- Canspi Rst: Resetline

- Canspi Cs Bit Direction: Direction of the Chip Select pin
- Canspi Rst Bit Direction: Direction of the Reset pin

. must be defined before using this function.
Requires

The CANSPI routines are supported only by MCUs with the SPI module.

The SPI module needs to be initialized. See the SPI1_Init and
SPI1_Init_Advanced routines.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or
similar hardware. See connection example at the bottom of this page.

// CANSPI module connections

var CanSpi CS : sbit at PORTB.BO;
CanSpi CS Direction : sbit at DDRB.BO;
CanSpi Rst : sbit at PORTB.B2;
CanSpi Rst Direction : sbit at DDRB.B2;

// End CANSPI module connections

var Can Init Flags: byte;

Can_Init Flags := CAN CONFIG_ SAMPLE THRICE and // form value to
E I be used
Xxample CAN CONFIG _PHSEG2 PRG ON and // with
CANSPIInitialize
CAN CONFIG XTD MSG and
CAN CONFIG DBL BUFFER ON and
CAN CONFIG VALID XTD MSG;

Spi Rd Ptr := @SPI1 Read; // Pass pointer to SPI Read func-

tion of used SPI module
SPI1 Init(); // initialize SPI module
CANSPIInitialize(1,3,3,3,1,Can _Init Flags); // initialize

external CANSPI module
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CANSPISetBaudRate

procedure CANSPISetBaudRate (SJW: byte; BRP: byte; PHSEGl: byte;

Proknype PHSEG2: byte; PROPSEG: byte; CAN CONFIG FLAGS: byte);

Returns Nothing.
Sets the CANSPI module baud rate. Due to complexity of the CAN protocol,
you can not simply force a bps value. Instead, use this function when the
CANSPI module is in Config mode.
saM, sec2praTs and WAKEFIL bits are set according to cAN CONFIG FLAGS
value. Refer to datasheet for details.

e Parameters:
Description

- SJW as defined in CAN controller's datasheet

- BRP as defined in CAN controller's datasheet

- PHSEGH1 as defined in CAN controller's datasheet

- PHSEGZ2 as defined in CAN controller's datasheet

- PROPSEG as defined in CAN controller's datasheet

- CAN_CONFIG_FLAGS is formed from predefined constants (see CANSPI
constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// set required baud rate and sampling rules
var can config flags: byte;

CANSPISetOperationMode (CANSPI MODE CONFIG, O0xFF) ; //
set CONFIGURATION mode (CANSPI module mast be in config mode for
baud rate settings)
Example can config flags := CANSPI CONFIG SAMPLE THRICE and

CANSPI CONFIG PHSEG2 PRG ON and

CANSPI CONFIG STD MSG and

CANSPI CONFIG DBL BUFFER ON and

CANSPI CONFIG VALID XTD MSG and

CANSPI CONFIG LINE FILTER OFF;
CANSPISetBaudRate(1l, 1, 3, 3, 1, can config flags);
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CANSPISetMask

procedure CANSPISetMask (CAN MASK: byte; wval: longint; CAN CON-

Prototype FIG FLAGS: byte);

Returns Nothing.

Configures mask for advanced filtering of messages. The parameter value is
bit-adjusted to the appropriate mask registers.

Parameters:

- can_mask: CANSPI module mask number. Valid values: canspI Mask
constants (see CANSPI constants)
- val: mask register value
- CAN CONFIG FLAGS: selects type of message to filter. Valid values:
CANSPI CONFIG ALL VALID MSG,
CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG STD MSG,
CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG XTD MSG.

Description

(see CANSPI constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// set the appropriate filter mask and message type value
CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF) ; //
set CONFIGURATION mode (CANSPI module must be in config mode for
mask settings)

Exan“ﬂe // Set all Bl mask bits to 1 (all filtered bits are relevant):
// Note that -1 is just a cheaper way to write OxFFFFFFFF.

// Complement will do the trick and fill it up with ones.
CANSPISetMask (CANSPI MASK Bl, -1, CANSPI CONFIG MATCH MSG TYPE
and CANSPI CONFIG XTD MSG) ;
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CANSPISetFilter

procedure CANSPISetFilter (CAN FILTER: byte; wval: longint;

Prototype CAN CONFIG FLAGS: byte);
Returns Nothing.
Configures message filter. The parameter value is bit-adjusted to the appropri-
ate filter registers.
Parameters:
- can rI1LTER: CANSPI module filter number. Valid values: CANSPI_FILTER
Description constants (see CANSPI constants)

- val: filter register value
- CAN CONFIG FLAGS: selects type of message to filter. Valid values:

CANSPI CONFIG _ALL VALID MSG,
CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG STD MSG,

CANSPI CONFIG MATCH MSG TYPE and CANSPI CONFIG XTD MSG.
(see CANSPI constants)

The CANSPI module must be in Config mode, otherwise the function will be
ignored. See CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// set the appropriate filter value and message type
CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF);

// set CONFIGURATION mode (CANSPI module must be in config mode
Example for filter settings)

// Set id of filter Bl F1 to 3:
CANSPISetFilter (CANSPT FILTER B1 F1, 3, CANSPI CONFIG XTD MSG);
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CANSPIRead
Protot function CANSPIRead (var id: longint; var rd data: array| 8] of
rototype byte; data len: byte; var CAN RX MSG FLAGS: byte): byte;
Returns - 0 if nothing is received
- oxrr if one of the Receive Buffers is full (message received)
If at least one full Receive Buffer is found, it will be processed in the following way:
- Message ID is retrieved and stored to location provided by the id parameter
- Message data is retrieved and stored to a buffer provided by the rd data
parameter
- Message length is retrieved and stored to location provided by the data len
parameter
o - Message flags are retrieved and stored to location provided by the
Description

CAN RX MSG FLAGS parameter
Parameters:

- id: message identifier storage address

- rd data: data buffer (an array of bytes up to 8 bytes in length)
- data len: data length storage address.

- CAN RX MSG FLAGS: message flags storage address

The CANSPI module must be in a mode in which receiving is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.

MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// check the CANSPI module for received messages. If any was
received do something.
var msg rcvd, rx flags, data len: byte;

rd data: arrayl 8] of byte;

msg _id: longint;

CANSPISetOperationMode (CANSPliMODh'iNORMAL, OxXFF) ;

// set NORMAL mode (CANSPI module must be in mode in which

Example . . .
receive 1is possible)

rx flags := 0;

// clear message flags

if (msg _rcvd = CANSPIRead(msg_id, rd data, data len, rx flags)

begin

end;
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CANSPIWrite
Prototvpe function CANSPIWrite(id: longint; wvar wr data: arrayl 8] of byte;
yp data len: byte; CAN TX MSG FLAGS: byte): byte;

- 0 if all Transmit Buffers are busy

Returns . . . .
- 0xrr if at least one Transmit Buffer is available
If at least one empty Transmit Buffer is found, the function sends message in
the queue for transmission.
Parameters:

Description . o . . .

P - id:CAN message identifier. Valid values: 11 or 29 bit values, depending on
message type (standard or extended)
- wr data: data to be sent (an array of bytes up to 8 bytes in length)
- data len: data length. Valid values: 1 to 8
- CAN RX MSG FLAGS: message flags
The CANSPI module must be in mode in which transmission is possible. See
CANSPISetOperationMode.

Requires The CANSPI routines are supported only by MCUs with the SPI module.
MCU has to be properly connected to mikroElektronika's CANSPI Extra Board
or similar hardware. See connection example at the bottom of this page.

// send message extended CAN message with the appropriate ID and
data
var tx flags: byte;

rd data: arrayl 8] of byte;

msg id: longint;

Example CANSPISetOperationMode (CAN MODE NORMAL, OxFF);

// set NORMAL mode (CANSPI must be in mode in which transmission
is possible)

tx flags := CANSPI TX PRIORITY 0 ands CANSPI TX XTD FRAME;

// set message flags

CANSPIWrite (msg_id, rd data, 2, tx flags);

CANSPI Constants

There is a number of constants predefined in the CANSPI library. You need to be familiar with them

in order to be able to use the library effectively. Check the example at the end of the chapter.
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CANSPI_OP_MODE

The cansp1 orp moDE constants define CANSPI operation mode. Function
CANSPISetOperationMode expects one of these as it's argument:

const
CANSPI MODE BITS = 0xEO;
CANSPI MODE NORMAL = 0x00;
CANSPI MODE SLEEP = 0x20;
CANSPI MODE LOOP = 0x40;
CANSPI MODE LISTEN = 0x60;
CANSPI MODE CONFIG = 0x80;

CANSPI_CONFIG_FLAGS

// Use this to access opmode

bits

The CANSPI_CONFIG_FLAGS constants define flags related to the CANSPI mod-

ule configuration.

The functions CANSPIInitialize,

CANSPISetBaudRate,

CANSPISetMask and CANSPISetFilter expect one of these (or a bitwise combina-

tion) as their argument:

const
CANSPI CONFIG DEFAULT =

CANSPI CONFIG PHSEG2 PRG BIT =
CANSPI CONFIG PHSEGZ2 PRG ON =
CANSPI CONFIG PHSEG2 PRG OFF =

OxXFE;

0x01;
OXFF;
OXFE;

CANSPI CONFIG _LINE FILTER BIT = 0x02;

CANSPI CONFIG LINE FILTER ON =

OXFF;

CANSPI CONFIG LINE FILTER OFF = OxFD;

CANSPI CONFIG SAMPLE BIT =
CANSPI CONFIG SAMPLE ONCE =
CANSPI CONFIG SAMPLE THRICE =

CANSPI CONFIG MSG TYPE BIT -
CANSPI CONFIG STD MSG =
CANSPI CONFIG XTD MSG =

CANSPI CONFIG DBL BUFFER BIT =
CANSPI CONFIG DBL BUFFER ON =
CANSPI CONFIG DBL BUFFER OFF =

CANSPI CONFIG MSG BITS
CANSPI CONFIG ALL MSG =
CANSPI CONFIG VALID XTD MSG
CANSPI CONFIG VALID STD MSG
CANSPI CONFIG ALL VALID MSG

0x04;
OxXFE;
O0xXFB;

0x08;
OxXFE;
0xF7;

0x10;
OXFF;
OxXEF;

0x60;

0xFFz

0xDF;
0xBF;
0x9F;

//

//
//

//
//

//
//

//
//

//
//

//
//
//
//

11111111

XXXXXXX1
XXXXXXX0

XXXXXX1X
XXXXXXO0X

XXXXXIXX
XXXXXOXX

XXXXIXXX
XXXXOXXX

XXXIXXXX
XXXOXXXX

X11XXXXX
X10XXXXX
XO1XXXXX
XO0XXXXX
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You may use bitwise and to form config byte out of these values. For example:

init := CANSPI CONFIG SAMPLE THRICE and
CANSPI CONFIG PHSEG2 PRG ON and
CANSPI CONFIG STD MSG and
CANSPI CONFIG DBL BUFFER ON and
CANSPI CONFIG VALID XTD MSG and

CANSPI CONFIG LINE FILTER OFF;
CANSPIInitialize(1l, 1, 3, 3, 1, init); // initialize CANSPI

CANSPI_TX_MSG_FLAGS

CANSPI_TX_MSG_FLAGS are flags related to transmission of a CAN message:

const
CANSPI TX PRIORITY BITS = 0x03;
CANSPI TX PRIORITY 0 = 0OxXFC; // XXXXXX00
CANSPI TX PRIORITY 1 = 0xFD; // XXXXXX01
CANSPI TX PRIORITY 2 = OxFE; // XXXXXX10
CANSPI TX PRIORITY 3 = OxFF; // XXXXXX11
CANSPI TX FRAME BIT = 0x08;
CANSPI TX STD FRAME = OxFF; // XXXXX1XX
CANSPI TX XTD FRAME = 0xF7; // XXXXXOXX
CANSPI TX RTR BIT = 0x40;
CANSPI TX NO RTR FRAME = OxFF; // XLIXXXXXX
CANSPI TX RTR_FRAME = O0xBF; // XOXXXXXX

You may use bitwise and to adjust the appropriate flags. For example:
// form value to be used as sending message flag:
send config := CANSPI TX PRIORITY 0 and

CANSPI TX XTD FRAME and

CANSPI TX NO RTR FRAME;

CANSPIWrite (id, data, 1, send config);
CANSPI_RX_MSG_FLAGS

CANSPI Rx MsG FLAGS are flags related to reception of CAN message. If a particu-
lar bit is set then corresponding meaning is TRUE or else it will be FALSE.

const
CANSPI RX FILTER BITS 0x07; // Use this to access filter bits
CANSPI RX FILTER 1 = 0x00;
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CANSPI RX FILTER 2 = 0x01;
CANSPTI RX FILTER 3 = 0x02;
CANSPI RX FILTER 4 = 0x03;
CANSPI RX FILTER 5 = 0x04;
CANSPI RX FILTER 6 = 0x05;

CANSPI RX OVERFLOW 0x08; // Set if Overflowed else cleared
CANSPI_RX INVALID MSG = 0x10;// Set if invalid else cleared
CANSPI RX XTD FRAME = 0x20; // Set if XTD message else cleared

CANSPI RX RTR FRAME = 0x40; // Set if RTR message else cleared
CANSPI_RX_DBL_BUFFERED = 0x80; // Set if this message was hardware

double-buffered

You may use bitwise =nd to adjust the appropriate flags. For example:

if (MsgFlag and CANSPI RX OVERFLOW <> 0) then
begin

// Receiver overflow has occurred.
// We have lost our previous message.

end;

CANSPI_MASK

The CANSPI_MASK constants define mask codes. Function CANSPISetMask
expects one of these as it's argument:

const
CANSPI MASK Bl = 0;
CANSPI MASK B2 = 1;

CANSPI_FILTER

The CANSPI_FILTER constants define filter codes. Functions CANSPISetFilter
expects one of these as it's argument:

const
CANSPI FILTER Bl Fl =
CANSPI FILTER Bl F2 =
CANSPI FILTER B2 Fl =
CANSPI FILTER B2 F2 =
CANSPI FILTER B2 F3 =
CANSPI FILTER B2 F4 =

~.

. N

~.

~.

g W N PO
~

~.
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Library Example

This is a simple demonstration of CANSPI Library routines usage. First node initi-
ates the communication with the second node by sending some data to its address.
The second node responds by sending back the data incremented by 1. First node
then does the same and sends incremented data back to second node, etc.

Code for the first CANSPI node:

program Can Spi 1st;

var Can Init Flags, Can Send Flags, Can Rcv Flags : byte; // can
flags
Rx Data Len : byte; // received data length in bytes
RxTx Data : array{ 8] of byte; // can rx/tx data buffer
Msg Rcvd : byte; // reception flag
Tx _ID, Rx _ID : longint; // can rx and tx ID

// CANSPI module connections

var CanSpi CS : sbit at PORTB.BO;
CanSpi CS Direction : sbit at DDRB.BO;
CanSpi Rst : sbit at PORTB.B2;
CanSpi Rst Direction : sbit at DDRB.B2;

// End CANSPI module connections

begin
ADCSRA.7 := 0; // Set AN pins to Digital I/O
PORTC := O0;
DDRC := 255;

Can Init Flags := 0; //
Can_Send Flags := 0; // clear flags
Can Rcv _Flags := 0; //
Can Send Flags := CANSPI TX PRIORITY 0 and // form

value to be used
_CANSPI TX XTD FRAME and // with CANSPIWrite
_CANSPI TX NO RTR FRAME;

Can Init Flags := CANSPI CONFIG SAMPLE THRICE and // form
value to be used
_CANSPI CONFIG PHSEG2 PRG ON and// with CANSPIInit
_CANSPI CONFIG XTD MSG and
_CANSPI CONFIG DBL BUFFER ON and
_CANSPI CONFIG VALID XTD MSG;

SPI1 Init(); //
initialize SPI1 module
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CANSPIInitialize(1,3,3,3,1,Can Init Flags); //
Initialize external CANSPI module
CANSPISetOperationMode ( CANSPI MODE CONFIG, OxFF) ; /7

set CONFIGURATION mode
CANSPISetMask ( CANSPI MASK Bl,-1, CANSPI CONFIG XTD MSG);
// set all maskl bits to ones
CANSPISetMask ( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG);
// set all mask2 bits to ones
CANSPISetFilter (_CANSPI_FILTER_B2_F4 , 3, _CANSPI_CONFIG_XTD_MSG) ;
// set id of filter Bl F1 to 3

CANSPISetOperationMode (_CANSPI MODE NORMAL, OxFF)// set NORMAL mode

RxTx Datal 0] := 9; // set initial data to be sent
Tx ID := 12111; // set transmit ID
CANSPIWrite (Tx ID, RxTx Data, 1, Can_Send Flags); //

send initial message
while (TRUE) do

begin // endless loop
Msg Rcvd := CANSPIRead(Rx ID , RxTx Data , Rx Data Len,
Can_Rcv_Flags); // receive message
if ((Rx_ID = 3) and Msg Rcvd) then
// if message received check id
begin
PORTC = RxTx Datal 0] ;

// id correct, output data at PORTC
Inc (RxTx Datal 0] ) ;
// increment received data
Delay ms (10);

CANSPIWrite (Tx ID, RxTx Data, 1, Can Send Flags);

// send incremented data back
end;
end;

end.

Code for the second CANSPI node:

program Can Spi 2nd;

var Can Init Flags, Can _Send Flags, Can Rcv Flags : byte; // can
flags
Rx Data Len : byte; //
received data length in bytes
RxTx Data : array| 8] of byte; // CAN rx/tx data buffer
Msg Rcvd : byte; // reception flag
Tx_ID, Rx ID : longint; // can rx and tx ID

// CANSPI module connections
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var CanSpi CS : sbit at PORTB.BO;
CanSpi CS Direction : sbit at DDRB.BO;
CanSpi Rst : sbit at PORTB.BZ;
CanSpi Rst Direction : sbit at DDRB.B2;
// End CANSPI module connections

begin
PORTC 0; // clear PORTC
DDRC := 255; // set PORTC as output
Can_Init Flags := 0; //
Can_Send Flags 0; // clear flags
Can_Rcv_Flags 0; //
Can Send Flags := CANSPI TX PRIORITY 0 and //
form value to be used
_CANSPI TX XTD FRAME and // with CANSPIWrite
_CANSPI TX NO RTR FRAME;
Can Init Flags := CANSPI CONFIG SAMPLE THRICE and /7

Form value to be used
_CANSPI CONFIG PHSEG2 PRG ON and// with CANSPIInit
_CANSPI CONFIG XTD MSG and
_CANSPI CONFIG DBL BUFFER ON and
_CANSPI CONFIG VALID XTD MSG and
_CANSPI CONFIG LINE FILTER OFF;

SPI1 Init();
// initialize SPI1 module
Spi Rd Ptr 1= @SPI1 Read;
// Pass pointer to SPI Read function of used SPI module
CANSPIInitialize(1,3,3,3,1,Can Init Flags);
// initialize external CANSPI module
CANSPISetOperationMode (_CANSPI MODE CONFIG, O0xFF) ;
// set CONFIGURATION mode
CANSPISetMask( CANSPI MASK Bl,-1, CANSPI CONFIG XTD MSG) ;
// set all maskl bits to ones
CANSPISetMask( CANSPI MASK B2,-1, CANSPI CONFIG XTD MSG) ;
// set all mask2 bits to ones

CANSPISetFilter (_CANSPI_FILTER_BZ_F3 ,12111, _CANSPI_CONFIG_XTD_MSG) ;
// set id of filter Bl F1 to 3
CANSPISetOperationMode (_CANSPI_MODE_NORMAL, OxFF) ;
// set NORMAL mode
Tx ID = 3;
// set tx ID

while (TRUE) do
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begin
Msg Rcvd := CANSPIRead(Rx ID , RxTx Data , Rx Data Len,
Can_Rcv_Flags); // receive message
if ((Rx_ID = 12111) and Msg Rcvd) then
// if message received check id
begin
PORTC := RxTx Datal 0] ;
// id correct, output data at PORTC
Inc (RxTx Datal 0] ) ;
// increment received data
CANSPIWrite (Tx ID, RxTx Data, 1, Can_ Send Flags);
// send incremented data back
end;
end;

end.
HW Connection
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Example of interfacing CAN transceiver MCP2510 with MCU via SPI interface
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COMPACT FLASH LIBRARY

The Compact Flash Library provides routines for accessing data on Compact Flash
card (abbr. CF further in text). CF cards are widely used memory elements, com-
monly used with digital cameras. Great capacity and excellent access time of only
a few microseconds make them very attractive for the microcontroller applications.

In CF card, data is divided into sectors. One sector usually comprises 512 bytes.
Routines for file handling, the Cf_Fat routines, are not performed directly but suc-
cessively through 512B buffer.

Note: Routines for file handling can be used only with FAT16 file system.
Note: Library functions create and read files from the root directory only.

Note: Library functions populate both FAT1 and FAT2 tables when writing to files,
but the file data is being read from the FAT1 table only; i.e. there is no recovery if
the FAT1 table gets corrupted.

Note: If MMC/SD card has Master Boot Record (MBR), the library will work with the
first available primary (logical) partition that has non-zero size. If MMC/SD card has
Volume Boot Record (i.e. there is only one logical partition and no MBRs), the library
works with entire card as a single partition. For more information on MBR, physical
and logical drives, primary/secondary partitions and partition tables, please consult
other resources, e.g. Wikipedia and similar.

Note: Before writing operation, make sure not to overwrite boot or FAT sector as it
could make your card on PC or digital camera unreadable. Drive mapping tools,
such as Winhex, can be of great assistance.
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External dependencies of Compact Flash Library

The following variables
must be defined in all proj-

. Description: Example :
ects using Compact Flash P P
Library:

var CF Data Port var CF Data Port
byte; sfr; external; CompaCt Flash Data Port. byte at PORTD;
var . ‘ Direction of the Compact Flash |7>* . .
CF Data Port Direction Data Port CF Data Port Directio

byte; sfr; external; ata rFort. n : byte at DDRD;

var CF RDY sbit; sfr; Readv si i var CF _RDY sbit at
external; eady signal fine. PINB.B7;

var CF WE sbit; sfr; Write Enable sianal line var CF WE sbit at

external; ! '9 Ine. PORTB.BG;

var CF OE sbit; sfr; Output Enable sianal line var CF OE sbit at

external; P 9 ' PORTB.B5;

var CF CD1 sbit; sfr; Chip Detect signal line var CF CD1 sbit at
external; P g ’ PINB.B4;

var CF CEl sbit; sfr; Chip Enable sianal line var CF CEl sbit at
external; P '9 Ine. PORTB.RB3;

var CF A2 sbit; sfr; Address pin 2 var CF A2 sbit at

external; P ' PORTB.B2;

var CF Al sbit; sfr; Address pin 1 var CF Al sbit at

external; P : PORTB.B1;

var CF A0 sbit; sfr; Address pin 0 var CEF A0 sbit at

external; P : PORTB.BO;

var CF RDY direction
sbit; sfr; external;

Direction of the Ready pin.

var CF RDY direction
sbit at DDRB.B7;

var CF WE direction
sbit; sfr; external;

Direction of the Write Enable pin.

var CF WE direction
sbit at DDRB.B6;

var CF OE direction
sbit; sfr; external;

Direction of the Output Enable pin.

var CF OE direction
sbit at DDRB.B5;

var CF CDl direction
sbit; sfr; external;

Direction of the Chip Detect pin.

var CF CDl direction
sbit at DDRB.B4;

var CF CEl direction
sbit; sfr; external;

Direction of the Chip Enable pin.

var CF CEl direction
sbit at DDRB.B3;

var CF A2 direction
sbit; sfr; external;

Direction of the Address 2 pin.

var CF A2 direction
sbit at DDRB.B2;

var CF Al direction
sbit; sfr; external;

Direction of the Address 1 pin.

var CF Al direction
sbit at DDRB.B1;

var CF A0 direction
sbit; sfr; external;

Direction of the Address 0 pin.

var CF A0 direction
sbit at DDRB.BO;
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Library Routines

- Cf_Init

- Cf_Detect

- Cf_Enable

- Cf_Disable

- Cf_Read_lInit

- Cf_Read_Byte

- Cf_Write_Init

- Cf_Write_Byte

- Cf_Read_Sector
- Cf_Write_Sector

Routines for file handling:

- Cf_Fat_Init

- Cf_Fat_QuickFormat

- Cf_Fat_Assign

- Cf_Fat_Reset

- Cf_Fat_Read

- Cf_Fat_Rewrite

- Cf_Fat_Append

- Cf_Fat_Delete

- Cf_Fat_Write

- Cf_Fat_Set _File_Date
- Cf_Fat_Get_File_Date
- Cf_Fat_Get_File_Size
- Cf_Fat_Get_Swap_File

Cf_Init

Prototype procedure Cf Init()

Returns Nothing.

Description |Initializes ports appropriately for communication with CF card.

Global variables :

- CF pata port : Compact Flash data port
-cr rDY : Ready signal line

Requires -cr we : Write enable signal line

- cr O : Output enable signal line

- cr cpl : Chip detect signal line

-cr cel : Enable signal line

-Ccr a2 : Address pin 2
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- Ccr Al :Address pin 1

- cr 20 : Address pin 0

- CF Data port direction : Direction of the Compact Flash data direction port
- CF RDY direction : Direction of the Ready pin

- CF WE direction : Direction of the Write enable pin
- CF OE direction : Direction of the Output enable pin
Requires - CF CD1 direction : Direction of the Chip detect pin
- CF CEl direction : Direction of the Chip enable pin
- CF A2 direction : Direction of the Address 2 pin

- CF Al direction : Direction of the Address 1 pin

- CF A0 direction : Direction of the Address 0 pin

must be defined before using this function.

// set compact flash pinout
var CF Data Port : byte at PORTD;
var Cf Data Port Direction : byte at DDRD;

var CF RDY : sbit at PINB.B7;
var CF WE : sbit at PORTB.B6;
var CF OE : sbit at PORTB.B5;
var CF CDI1 : sbit at PINB.B4;
var CF CEl1 : sbit at PORTB.B3;

var CF7A2 : sbit at PORTB.B2;
var CF Al : sbit at PORTB.B1;
var CF A0 : sbit at PORTB.BRO;

Example var CF _RDY direction : sbit at DDRB.B7;
var CF WE direction : sbit at DDRB.BG6;
var CF OE direction : sbit at DDRB.B5;

var CF CDl direction : sbit at DDRB.B4;
var CF CEl direction : sbit at DDRB.B3;

var CF7A27direction : sbit at DDRB.B2;
var CFiAlidirection : sbit at DDRB.B1;
var CF A0 direction : sbit at DDRB.RO;

// end of cf pinout

// Init CF
begin

Cf Init();
end;
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Cf_Detect
Prototype |function CF Detect() : byte ;
- 1 - if CF card was detected
Returns .
- 0 - otherwise
Description |Checks for presence of CF card by reading the chip detect pin.
Requires The c_orrespondlng MCU ports must be appropriately initialized for CF card. See
Cf_Init.
// Wait until CF card is inserted:
Example while (Cf Detect() = 0) do
nop;
Cf_Enable
Prototype |procedure Cf Enable();
Returns Nothing.
Enables the device. Routine needs to be called only if you have disabled the
Description |device by means of the Cf_Disable routine. These two routines in conjunction
allow you to free/occupy data line when working with multiple devices.
Requires The cprrespondmg MCU ports must be appropriately initialized for CF card. See
Cf_Init.
// enable compact flash
Example Cf Enable();
Cf_Disable
Prototype |procedure Cf Disable();
Returns Nothing.
Routine disables the device and frees the data lines for other devices. To
Description [enable the device again, call Cf_Enable. These two routines in conjunction
allow you to free/occupy data line when working with multiple devices.
Requires The cprrespondmg MCU ports must be appropriately initialized for CF card. See
Cf_Init.
// disable compact flash
Example Cf Disable();
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Cf_Read_lInit

Prokﬂype procedure CfAReadilnit(address : dword; sector count : byte);

Returns Nothing.

Initializes CF card for reading.

o Parameters :
Description

- address: the first sector to be prepared for reading operation.
- sector count: number of sectors to be prepared for reading operation.

The corresponding MCU ports must be appropriately initialized for CF card. See
Cf_Init.

// initialize compact flash for reading from sector 590

Cf Read Init (590, 1);

Requires

Example

Cf_Read_Byte

Prototype function CF Read Byte() : byte;
Returns a byte read from Compact Flash sector buffer.
Returns
Note: Higher byte of the unsigned return value is cleared.
i Reads one byte from Compact Flash sector buffer location currently pointed to
Description . . . . . .
by internal read pointers. These pointers will be autoicremented upon reading.
The corresponding MCU ports must be appropriately initialized for CF card. See
. Cf_Init
Requires -
CF card must be initialized for reading operation. See Cf_Read_Init.
// Read a byte from compact flash:
Exanuﬂe var data : byte;
A$£a := Cf Read Byte();
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Cf_Write_Init

Prototype procedure Cf Write Init (address : dword; sectcnt : byte);

Returns Nothing.

Initializes CF card for writing.

i Parameters :
Description
- address: the first sector to be prepared for writing operation.
- sectent: number of sectors to be prepared for writing operation.
Requires The corresponding MCU ports must be appropriately initialized for CF card. See

Cf_Init.

// initialize compact flash for writing to sector 590
Cf Write Init (590, 1);

Example

Cf_Write_Byte

Prototype procedure Cf Write Byte(data_ : byte) ;

Returns Nothing.

Writes a byte to Compact Flash sector buffer location currently pointed to by writing
pointers. These pointers will be autoicremented upon reading. When sector buffer is
full, its content will be transfered to appropriate flash memory sector.

Description
Parameters :

- data : byte to be written.

The corresponding MCU ports must be appropriately initialized for CF card. See

Requires Cf_Init.
CF card must be initialized for writing operation. See Cf_Write_Init.
var data : byte;

Example daLa := OxAA;

Cf Write Byte (data);
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Cf_Read_Sector

Prototype procedure Cf Read Sector (sector number : dword; wvar buffer :
ypP arrayl 512] of byte);
Returns Nothing.

Reads one sector (512 bytes). Read data is stored into buffer provided by the
buffer parameter.

Description |Parameters :

- sector number: sector to be read.
- buf fer: data buffer of at least 512 bytes in length.

Requires The corresponding MCU ports must be appropriately initialized for CF card. See

Cf_Init.
// read sector 22
var data : array[ 512] of byte;
Example v J Y

Cf Read Sector (22, data);

Cf_Write_Sector

Protot procedure Cf Write Sector(sector number : dword; var buffer :
rotolype  |.rrayi 512] of byte) ;
Returns Nothing.
Writes 512 bytes of data provided by the buffer parameter to one CF sector.
Description Parameters :
- sector number: sector to be written to.
- buffer: data buffer of 512 bytes in length.
. The corresponding MCU ports must be appropriately initialized for CF card. See
Requires | it
// write to sector 22
Exanuﬂe var data : array[ 512] of byte;
Cf Write Sector (22, data);
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Cf_Fat_Init

Prototype |function Cf Fat Init(): byte;

- 0 - if CF card was detected and successfully initialized
Returns - 1 - if FAT16 boot sector was not found
- 255 - if card was not detected

Initializes CF card, reads CF FAT16 boot sector and extracts data needed by

Description the library.

Requires Nothing.

//init the FAT library
if (Cf Fat Init() = 0) then
Example begin

end

Cf_Fat_QuickFormat

function Cf Fat QuickFormat (var cf fat label : stringf 11])
byte;

Prototype

- 0 - if CF card was detected, successfully formated and initialized
Returns - 1 - if FAT16 format was unseccessful
- 255 - if card was not detected

Formats to FAT16 and initializes CF card.

Parameters :

- cf fat label:volume label (11 characters in length). If less than 11 charac
ters are provided, the label will be padded with spaces. If an empty string is
Description | passed, the volume will not be labeled.

Note: This routine can be used instead or in conjunction with the Cf_Fat_Init routine.
Note: If CF card already contains a valid boot sector, it will remain unchanged

(except volume label field) and only FAT and ROOT tables will be erased. Also,
the new volume label will be set.

Requires Nothing.

// format and initialize the FAT library
if (Cf Fat QuickFormat ('mikroE') = 0) then
Example begin

end;
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Cf_Fat_Assign

function Cf Fat Assign(var filename: array| 12] of char;
file cre attr: byte): byte;

- 0 if file does not exist and no new file is created.

- 1 if file already exists or file does not exist but a new file is created.

Assigns file for file operations (read, write, delete...). All subsequent file opera-
tions will be applied to the assigned file.

Prototype

Returns

Parameters :

- filename: name of the file that should be assigned for file operations. The file
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to the proper case automatically, so the user does
not have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between the file name and extension (i.e.
"MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the
string are considered to be file extension.

- file cre attr: file creation and attributs flags. Each bit corresponds to the
appropriate file attribut:

Description
Bit [ Mask Description

0 0x01 |Read only

1 0x02 |Hidden

2 0x04 [System

3 0x08 |Volum Label

4 0x10 |Subdirectory

5 0x20 |Arhive

6 0x40 | Device(internal use only,never found on disk).

File creation flag.If the file does not exist and this flag

7 0x80 |, ! . g .
- is set,a new file with specified name will be created.

Note:Long File Names (LFN) not suppoted

Requires CF card and CF library must be initialized for file operations. See Cf_Fat_Init.

// create file with archive attribut if it does not already exist
Cf Fat Assign ('MIKROOO07.TXT',0xAQ);

Example
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Cf_Fat_Reset

Prototype |procedure Cf Fat Reset (var size: dword);

Returns Nothing.

Opens currently assigned file for reading.

. Parameters :
Description

- size: buffer to store file size to. After file has been open for reading its size is
returned through this parameter.

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.

Requires
File must be previously assigned. See Cf _Fat_Assign.
var size : dword;

Example S
Cf Fat Reset(size);

Cf_Fat_Read

Prototype procedure Cf Fat Read(var bdata: byte);

Returns Nothing.

Reads a byte from currently assigned file opened for reading. Upon function
execution file pointers will be set to the next character in the file.

Description |Parameters :

- bdata: buffer to store read byte to. Upon this function execution read byte is -
returned through this parameter.

CF card and CF library must be initialized for file operations. See Cf_Fat_lInit.
Requires File must be previously assigned. See Cf_Fat_Assign.

File must be open for reading. See Cf_Fat_Reset.

var character : byte;
Example S
Cf Fat Read(character);
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Cf_Fat_Rewrite

Prototype |procedure Cf Fat Rewrite();

Returns Nothing.
Description Opens currently assigned file for writing. If the file is not empty its content will
be erased.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
The file must be previously assigned. See Cf_Fat_Assign.

// open file for writing
Cf Fat Rewrite();

Example

Cf_Fat_Append

Prototype |procedure Cf Fat Append();

Returns Nothing.

Opens currently assigned file for appending. Upon this function execution file
Description |pointers will be positioned after the last byte in the file, so any subsequent file
writing operation will start from there.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf_Fat_Assign.

// open file for appending

Example Cf Fat Append();

Cf_Fat_Delete

Prototype procedure Cf Fat Delete();

Returns Nothing.

Description |Deletes currently assigned file from CF card.

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf _Fat_Assign.

// delete current file

Example Cf Fat Delete();
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Cf_Fat_Write

procedure Cf Fat Write(var fdata: arrayl 512] of byte; data len:
word) ;

Prototype

Returns Nothing.

Writes requested number of bytes to currently assigned file opened for writing.

. Parameters :
Description

- fdata: data to be written.
- data len: number of bytes to be written.

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires File must be previously assigned. See Cf_Fat_Assign.

File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

var file contents : array| 42] of byte;

Example Cf Fat Write(file contents, 42); // write data to the assigned

file
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Cf_Fat_Set_File_Date

procedure Cf Fat Set File Date(year: word; month: byte; day:

PrOtOtype byte; hours: byte; mins: byte; seconds: byte);

Returns Nothing.

Sets the date/time stamp. Any subsequent file writing operation will write this
stamp to currently assigned file's time/date attributs.

Parameters :

Description |- year: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12

- day: day attribute. Valid values: 1-31

- hours: hours attribute. Valid values: 0-23

- mins: minutes attribute. Valid values: 0-59

- seconds: seconds attribute. Valid values: 0-59

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.
Requires File must be previously assigned. See Cf _Fat_Assign.

File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.

Example Cf Fat Set File Date(2005,9,30,17,41,0);
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Cf_Fat_Get_File_Date

procedure Cf Fat Get File Date(var year: word; wvar month: byte;
var day: byte; wvar hours: byte; var mins: byte);

Prototype

Returns Nothing.

Reads time/date attributes of currently assigned file.
Parameters :

- year: buffer to store year attribute to. Upon function execution year attribute is
returned through this parameter.

- month: buffer to store month attribute to. Upon function execution month attrib
ute is returned through this parameter.

- day: buffer to store day attribute to. Upon function execution day attribute is
returned through this parameter.

- hours: buffer to store hours attribute to. Upon function execution hours attrib
ute is returned through this parameter.

- mins: buffer to store minutes attribute to. Upon function execution minutes
attribute is returned through this parameter.

Description

CF card and CF library must be initialized for file operations. See Cf_Fat_Init.
Requires
File must be previously assigned. See Cf_Fat_Assign.

var year : word;

month, da hours, mins : byte;
Example ! I ’ 7

Cf Fat Get File Date(year, month, day, hours, mins);

Cf_Fat_Get_File_Size

roto e unction C at et 1le Size : word;
Prototyp functi Cf Fat Get File Size(): dword

Returns Size of the currently assigned file in bytes.

Description |This function reads size of currently assigned file in bytes.

CF card and CF library must be initialized for file operations. See Cf_Fat_|Init.

Requires
File must be previously assigned. See Cf _Fat_Assign.
var my file size : dword;

Example -
my file size := Cf Fat Get File Size();
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Cf_Fat_Get_Swap_File

function Cf Fat Get Swap File(sectors cnt: longint; var filename

PrOtOtype : stringf 11] ; fileiattr : byte): dword;

- Number of the start sector for the newly created swap file, if there was enough
Returns free space on CF card to create file of required size.
- 0 - otherwise.

This function is used to create a swap file of predefined name and size on the
CF media. If a file with specified name already exists on the media, search for
consecutive sectors will ignore sectors occupied by this file. Therefore, it is rec-
ommended to erase such file if it exists before calling this function. If it is not
erased and there is still enough space for a new swap file, this function will
delete it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to CF media as fast
as possible, by using the Cf _Read_Sector() and Cf_Write_Sector() functions
directly, without potentially damaging the FAT system. The swap file can be con-
sidered as a "window" on the media where the user can freely write/read data.
Its main purpose in the mikroPascal's library is to be used for fast data acquisi-
tion; when the time-critical acquisition has finished, the data can be re-written
into a "normal" file, and formatted in the most suitable way.

Parameters:

Description | sectors cnt:number of consecutive sectors that user wants the swap file to -
have.

- filename: name of the file that should be assigned for file operations. The file
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to the proper case automatically, so the user does
not have to take care of that.

Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between the file name and extension (i.e.
"MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the
string are considered to be file extension.

- file attr: file creation and attributs flags. Each bit corresponds to the appro
priate file attribut:
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Bit | Mask Description
0 0x01 [Read Only
1 0x02 [Hidden
2 0x04 [System
3 0208 [Volume Label
Description 4 0x10 |Subdirectory
5 0x20 |Archive
. w0 ]I%i\:wlgeognc;[;r;)al use only, never
7 0x80 |Not used

Note: Long File Names (LFN) are not supported.

Requires

CF card and CF library must be initialized for file operations. See Cf_Fat_lInit.

Example

// Try to create a swap file with archive atribute,

will be at least 1000 sectors.

// If it succeeds,

tor over UART

var size dword;

size

if (size <> 0)

begin
UART1
UART1
UART1
UART1
UART1
UART1

end

:= Cf Fat Get Swap File (1000,
then

Write
Write
Write
Write
Write
Write

OxAR) ;

Lo (size));
Hi(size)):;
Higher (size));
Highest (size));
OxAR) ;

it sends the No.

"mikroE.txt",

whose size

of start sec-

0x20) ;
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Library Example

The following example is a simple demonstration of CF(Compact Flash) Library
which shows how to use CF card data accessing routines.

program CF Fatl6 Test;
var

// set compact flash pinout
Cf Data Port : byte at PORTD;
Cf Data Port Direction : byte at DDRD;

CF RDY : sbit at PINB.B7;
CF WE : sbit at PORTB.B6;
CF OE : sbit at PORTB.B5;
CF CDl : sbit at PINB.B4;
CF CEl : sbit at PORTB.B3;

CF A2 : sbit at PORTB.B2;
CF Al : sbit at PORTB.BI1;
CF_A0 : sbit at PORTB.BO;

CF RDY direction : sbit at DDRB.B7;
CF WE direction : sbit at DDRB.BG6;
CF OE direction : sbit at DDRB.B5;
CF CD1 direction : sbit at DDRB.B4;
CF CEl direction : sbit at DDRB.B3;

CF A2 direction : sbit at DDRB.B2;
CF Al direction : sbit at DDRB.BI;
CF A0 direction : sbit at DDRB.BO;

// end of cf pinout

FAT TXT : stringl 20] ;
file contents : string 50];

filename : stringf 14] ; // File names
character : byte;
loop, loop2 : byte;

size : longint;

Buffer : arrayl 512] of byte;

[/ ——mm Writes string to USART
procedure Write Str(var ostr: arrayl 2] of byte);
var
i : byte;
begin
i = 0;
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while ostr[ i] <> 0 do begin
UART1 Write (ostr[ i]);

Inc (i),
end;
UART1 Write ($0A);
end;
[/———————————— Creates new file and writes some data to it
procedure Create New File;
begin
filename[ 7] := 'A';
Cf Fat Assign(filename, OxAO); // Will not find file and then
create file
Cf Fat Rewrite(); // To clear file and start with new data
for loop:=1 to 90 do // We want 5 files on the MMC card
begin
PORTC := loop;
file contents[ 0] := loop div 10 + 48;
file contents[ 1] := loop mod 10 + 48;
Cf Fat Write(file contents, 38); // write data to the assigned file
UART1 Write('.');
end;
end;
[/ ——mm Creates many new files and writes data to them
procedure Create Multiple Files;
begin
for loop2 := 'B' to 'Z' do
begin
UART1 Write(loop2); // this line can slow down the performance
filename[ 7] := loop2; // set filename
Cf Fat Assign(filename, O0xAO0); // find existing file or
create a new one
Cf Fat Rewrite; // To clear file and start with new data
for loop := 1 to 44 do
begin
file contents[ 0] := loop div 10 + 48;
file contents[ 1] := loop mod 10 + 48;

Cf Fat Write(file contents, 38); // write data to the
assigned file

end;
end;
end;
/) == ———————— Opens an existing file and rewrites it
procedure Open File Rewrite;
begin
filename[ 7] := 'C'; // Set filename for single-file tests

Cf_Fat_Assign(filename, 0);
Cf Fat Rewrite;
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for loop := 1 to 55 do
begin
file contents[ 0] := byte(loop div 10 + 48);
file contents[ 1] := byte(loop mod 10 + 48);
Cf Fat Write(file contents, 38); // write data to the assigned file
end;
end;
[/ =mmmmm - Opens an existing file and appends data to it
// (and alters the date/time stamp)
procedure Open File Append;
begin
filename[ 7] := 'B';

Cf_Fat_Assign(filename, 0);

Cf Fat Set File Date(2005,6,21,10,35,0);

Cf Fat Append;

file contents := ' for mikroElektronika 2005'; // Prepare file
for append

file contents[ 26] := 10; // LF

Cf Fat Write(file contents, 27); // Write data to assigned file
end;

)] ———— Opens an existing file, reads data from it and puts
it to USART
procedure Open File Read;

begin
filename[ 7] := 'B';
Cf_Fat_Assign(filename, 0);
Cf Fat Reset (size); // To read file, procedure returns

size of file
while size > 0 do begin
Cf Fat Read(character);

UART1 Write (character); // Write data to USART
Dec (size);
end;
end;
/) == ———————— Deletes a file. If file doesn't exist, it will first
be created
// and then deleted.
procedure Delete File;
begin
filename[ 7] := 'F';

Cf_Fat_Assign(filename, 0);
Cf Fat Delete;
end;

[/———————————— Deletes a file. If file doesn't exist, it will first
be created
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// and then deleted.
procedure Delete File;
begin
filenamel 7] := 'F';

Cf_Fat_Assign(filename, 0);
Cf Fat Delete;

end;

/) ==mmm———————— Tests whether file exists, and if so sends its cre-
ation date

// and file size via USART

procedure Test File Exist (fname : byte);

var

fsize: longint;

year: word;

month, day, hour, minute: byte;
outstr: arrayl 12] of byte;

begin

filename[ 7] := 'B'; //uncomment this line to search for
file that DOES exists
// filename[ 7] := 'F'; //uncomment this line to search for

file that DOES NOT exist
if Cf Fat Assign(filename, 0) <> 0 then begin

//--- file has been found - get its date
Cf Fat Get File Date(year,month,day,hour,minute);
WordToStr (year, outstr);
Write_Str(outstr);
ByteToStr (month, outstr);
Write_Str(outstr);
WordToStr (day, outstr);
Write_Str(outstr);
WordToStr (hour, outstr);
Write_Str(outstr);
WordToStr (minute, outstr);
Write_Str(outstr);
//--- get file size
fsize := Cf Fat Get File Size;
LongIntToStr (fsize, outstr);
Write_Str(outstr);

end
else begin
//--- file was not found - signal it

UART1 Write (0x55);
Delay ms(1000) ;
UART1 Write (0x55);
end;
end;

[/ ——mm Tries to create a swap file, whose size will be at
least 100
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// sectors (see Help for details)
procedure M Create Swap File;
var i : word;

begin
for i:=0 to 511 do
Buffer{ 1] := 1i;

size := Cf Fat Get Swap File (5000, 'mikroE.txt', 0x20); // see
help on this function for details

if (size <> 0) then
begin
LongIntToStr (size, fat txt);
Write_str(fat_txt);

for i:=0 to 4999 do

begin
Cf Write Sector(size, Buffer);
size := size+l;
UART1 Write('.');

end;

end;
end;

/) ———————————— Main. Uncomment the function(s) to test the desired
operation (s)
begin

FAT TXT := 'FAT16 not found';

file contents := 'XX CF FAT16 library by Anton Rieckert';

file contents[ 37] := 10; // newline

filename := 'MIKROOOXTXT';

// we will use PORTC to signal test end

DDRC := OxXFF;
PORTC := 0;
UART1 Init(19200); // Set up USART for file reading

delay ms(100);
UART1 Write Text(':Start:'");

// --- Init the FAT library
// --- use Cf Fat QuickFormat instead of init routine if a for-
mat is needed
if Cf Fat Init() = O then
begin
//--- test functions
//===== test group #1
Open File Read();
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Create Multiple Files();
[/ ===== test group #2

Open File Rewrite();
Open File Append();

Delete File;
//===== test group #3

Open File Read();

Test File Exist ('F');
M Create Swap File();
//--- Test termination
UART1 Write (0xAR);

end
else
begin

UART1 Write Text (FAT TXT);

end;

//--- signal end-of-test
UART1 Write Text (':End:'");

end.
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HW Connection
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EEPROM LIBRARY

EEPROM data memory is available with a number of AVR family. The mikroPascal PRO for AVR
includes a library for comfortable work with MCU's internal EEPROM.

Note: EEPROM Library functions implementation is MCU dependent, consult the appropriate MCU
datasheet for details about available EEPROM size and constrains.

Library Routines

- EEPROM_Read
- EEPROM_Write

EEPROM_Read

Prokﬂype function EEPROM Read(address: word) : byte;
Returns Byte from the specified address.

Reads data from specified address.
Description |Parameters :

- address: address of the EEPROM memory location to be read.
Requires Nothing.

var eeAddr : word;

temp : byte;
Example -

eeAddr := 2

temp := EEPROM Read (eeAddr);
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EEPROM_Write

Prototype procedure EEPROM Write (address: word; wrdata: byte);

Returns Nothing.

Writes wrdata to specified address.

Parameters :
Description |_ address: address of the EEPROM memory location to be written.
- wrdata: data to be written.

Note: Specified memory location will be erased before writing starts.

Requires Nothing.

var eeWrite : byte;
wrAddr : word;

Example address := 0x02;

wrdata := 0xAA;

EEPROM Write (wrAddr, eeWrite);

Library Example

This example demonstrates using the EEPROM Library with ATmega16 MCU.

First, some data is written to EEPROM in byte and block mode; then the data is read from the
same locations and displayed on PORTA, PORTB and PORTC.

program Eeprom;

var counter : byte; // loop variable
begin
DDRA := OXxFF;
DDRB := OXxFF;
DDRC := OXxFF;
for counter := 0 to 31 do // Fill data buffer
EEPROM Write (0x100 + counter, counter); // Write data to address

0x100+counter

EEPROM Write (0x02, 0xAA) ; // Write some data at address 2
EEPROM Write (0x150,0x55); // Write some data at address 0x150
Delay ms (1000); // Blink PORTA and PORTB diodes
PORTA := OxFF; // to indicate reading start

PORTB := OxFF;
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Delay ms (1000);
PORTA := 0x00;
PORTB := 0x00;
Delay ms (1000) ;

PORTA := EEPROM Read (0x02);
address 2 and display it on PORTO
PORTB := EEPROM Read (0x150);

address 0x150 and display it on PORTL
Delay ms (1000) ;

for counter := 0 to 31 do
block from address 0x100
begin
PORTC := EEPROM Read(0x100+counter);
data on PORT2
Delay ms (100);
end;
end.

// Read data from

// Read data from

// Read 32 bytes

// and display
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FLASH MEMORY LIBRARY

This library provides routines for accessing microcontroller Flash memory. Note that prototypes
differ for MCU to MCU due to the amount of Flash memory.

Note: Due to the AVR family flash specifics, flash library is MCU dependent. Since some AVR MCU's
have more or less than 64kb of Flash memory, prototypes may be different from chip to chip.
Please refer to datasheet before using flash library.

Note: Currently, Write operations are not supported. See mikroPascal PRO for AVR specifics for details.
Library Routines

- FLASH_Read_Byte

- FLASH_Read_Bytes

- FLASH_Read_Word

- FLASH_Read_Words
- Flash_Write

- Flash_Write_8

- Flash_Write_16

- Flash_Write_32

- Flash_Write_64

- Flash_Erase

- Flash_Erase 64

- Flash_Erase_1024

- Flash_Erase_Write

- Flash_Erase_Write 64
- Flash_Erase_Write-1024

FLASH_Read_Byte

// for MCUs with 64kb of Flash memory or less

function FLASH Read Byte (address : word) : byte;
Prototype

// for MCUs with Flash memory larger than 64kb

function FLASH Read Byte (address : dword) : byte;
Returns Returns data byte from Flash memory.

Description |Reads data from the specified address in Flash memory.

Requires Nothing.
// for MCUs with Flash memory larger than 64kb

var tmp : dword;
Example
begin
tmp := Flash Read(0x0D00) ;
end
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FLASH_Read_Bytes

// for MCUs with 64kb of Flash memory or less
procedure FLASH Read Bytes (address : word; buffer : “byte;
NoBytes : word);
Prototype
// for MCUs with Flash memory larger than 64kb
procedure FLASH Read Bytes (address : dword; buffer : “byte;
NoBytes : word)
Returns Nothing.
. Reads number of data bytes defined by NoBytes parameter from the specified
Description : . .
address in Flash memory to variable pointed by buffer.
Requires Nothing.
// for MCUs with Flash memory larger than 64kb
const F ADDRESS : long = 0x200;
var dat buff : arrayl 32] of word;
Example S
begin
FLASH Read Bytes (F ADDRESS, dat buff, 64);
end.

FLASH_Read_Word

// for MCUs with 64kb of Flash memory or less

function FLASH Read Word(address : word) : word;
Prototype

// for MCUs with Flash memory larger than 64kb

function FLASH Read Word(address : dword) : word;
Returns Returns data word from Flash memory.
Description |Reads data from the specified address in Flash memory.
Requires Nothing.

// for MCUs with Flash memory larger than 64kb

var tmp : word;
Example begin

tmp := Flash Read(0x0D00) ;
begin

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

231



CHAPTER 6
Libraries mikroPASCAL PRO for AVR

FLASH_Read_Words

// for MCUs with 64kb of Flash memory or less

procedure FLASH Read Words (address : word; buffer : “word;
NoWords : word);

Prototype
// for MCUs with Flash memory larger than 64kb
procedure FLASH Read Words (address : dword; buffer : “word;
NoWords : word);

Returns Nothing.

. Reads number of data words defined by NoWords parameter from the specified
Description

address in Flash memory to variable pointed by buffer.

Requires Nothing.

// for MCUs with Flash memory larger than 64kb
const F ADDRESS : dword = 0x200;
var dat buff : arrayl 32] of word;

Example S
begin

FLASH Read Words (F_ADDRESS,dat buff, 32);
end.

Library Example

The example demonstrates simple write to the flash memory for AVR, then reads the data and dis-
plays it on PORTB and PORTD.

program Flash MCU test;
const F ADDRESS : longint = 0x200;

const data : arrayl 32] of word = ( // constant table
0x0000,0x0001,0x0002,0x0003,0x0004,0x0005,0x0006,0x0007,
0x0008,0x0009,0x000A,0x000B, 0x000C, 0x000D, 0x000E, 0x000F,
0x0000,0x0100,0x0200,0x0300,0x0400,0x0500,0x0600,0x0700,
0x0800,0x0900, 0x0A00, 0x0B00O, 0x0C00, 0x0OD00, OxO0E00, 0x0F00
); org 0x200;

var counter : byte;
word : word;
dat buff : arrayl 32] of word;

begin
DDRD := OXxFF; // set direction to be output
DDRB := OXxFF; // set direction to be output
word := data [ 0] ; // link const table
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counter := 0;
while ( counter < 64 ) do // reading 64 bytes in loop
begin
PORTD := FLASH Read Byte(F ADDRESS + counter); //  demon-

stration of reading single byte

Inc (counter) ;

PORTB := FLASH Read Byte (F ADDRESS + counter); //  demon-
stration of reading single byte

Inc (counter) ;

Delay ms (200);

end;
FLASH Read Bytes(F_ADDRESS, @dat buff, 64); // demon-
stration of reading 64 bytes
for counter := 0 to 31 do
begin
PORTD := dat buff[ counter] ; // output low byte to PORTD
PORTB := word((dat buff[ counter] shr 8)); // output

higher byte to PORTB
Delay ms (200);

end;
counter := 0;
while (counter <= 63) do // reading 32 words in loop
begin
word ~ := FLASH Read Word(F_ADDRESS + counter); //  demon-
stration of reading single word
PORTD := word ; // output low byte to PORTD
PORTB := word(word shr 8); // output
higher byte to PORTB
counter := counter + 2;
Delay ms (200);
end;
FLASH Read Words (F_ADDRESS, @dat buff, 32); //  demon-
stration of reading 64 bytes
for counter := 0 to 31 do
begin
PORTD := dat buff[ counter] ; // output low byte to PORTD
PORTB := word((dat buff[ counter] shr 8)); // output

higher byte to PORTB
Delay ms (200);
end;

end.
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GRAPHIC LCD LIBRARY

The mikroPascal PRO for AVR provides a library for operating Graphic Lcd 128x64
(with commonly used Samsung KS108/KS107 controller).

For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.

External dependencies of Graphic Lcd Library

The following variables
must be defined in all

- ] Description: Example :
projects using Sound P P
Library:

var GLCD DataPort var GLCD DataPort
byte; sfr; external; Gled Data Port. byte at PORTC;

LCD D P Di . .
vartheh batabort DLrec Inirection of the Gled Data | V2" . ‘
tion : byte; sfr; Port GLCD DataPort Direction
external; ort. : byte at DDRC;

var GLCD CS1 : sbit; var GLCD CS1 : sbit at

Chip Select 1 line.

sfr; external; PORTD.B2;
var GLCD CS2 : sbit; . . var GLCD CS2 : sbit at
sfr; external; Chw)SebthHne. PORTD.B3;
var GLCD RS : sbit; Register select line var GLCD RS : sbit at
sfr; external; 9 ’ PORTD.B4;

var GLCD RW : sbit; var GLCD RW : sbit at

Read/Write line.

sfr; external; PORTD.B5;
var GLCD EN : sbit; Enable li var GLCD EN : sbit at
sfr; external; nable line. PORTD.B6;
var GLCD RST : sbit; Reset line var GLCD RST : sbit at
sfr; external; ' PORTD.B7;
var . . . ) )

. . Direction of the Chip var GLCD CS1 Direction
GLCD CS1 Direction Select 1 pi . sbit aE DDED BO
sbit; sfr; external; elec pn. : N
var . . . ] ]

. . Direction of the Chip var GLCD CS2 Direction
GLCD_CS2 Direction Select 2 pi . sbit aE DDRD B3
sbit; sfr; external; elect 2 pin. : Y

var GLCD RS Direction |Direction of the Register |var GLCD RS Direction

sbit; sfr; external; sdectpm, : sbit at DDRD.R4;
var GLCD RW Direction |Direction of the var GLCD RW Direction
sbit; sfr; external;|Read/Write pin. : sbit at DDRD.B5;

var GLCD EN Direction
sbit; sfr; external;

var GLCD EN Direction

Direction of the Enable pin. sbit at DDRD.B6;

var GLCD RST Direction
sbit; sfr; external;

var GLCD RST Direction

Direction of the Reset pin. <bit at DDRD.B7;
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Library Routines
Basic routines:

- Gled_Init

- Glcd_Set_Side

- Gled_Set X

- Glcd_Set_Page
- Glcd_Read_Data
- Glcd_Write_Data

Advanced routines:

- Glcd_Fill

- Glcd_Dot

- Gled_Line

- Gled_V_Line

- Gled_H_Line

- Glcd_Rectangle
- Gled_Box

- Glecd_Circle

- Glcd_Set_Font
- Glcd_Write_Char
- Glcd_Write_Text
- Glcd_Image
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Glcd_Init

Prototype procedure Glcd Init();

Returns Nothing.

Initializes the Glcd module. Each of the control lines is both port and pin config-
urable, while data lines must be on a single port (pins <0:7>).

Global variables :

Description

- GLcp cs1 : Chip select 1 signal pin

- GLCcD cs2 : Chip select 2 signal pin

- GLCD RS : Register select signal pin

- gLcp rw @ Read/Write Signal pin

- GLcp EN : Enable signal pin

- GLCcD RsST : Reset signal pin

- GLCD Dataport : Data port

- GLCD Cs1 Direction : Direction of the Chip select 1 pin

- GLCD €S2 Direction : Direction of the Chip select 2 pin

- GLCD RS Direction : Direction of the Register select signal pin
- GLCD RW Direction : Direction of the Read/Write signal pin
- GLCD EN Direction : Direction of the Enable signal pin

- GLCD RST Direction : Direction of the Reset signal pin

- GLCD DataPort Direction : Direction of the Data port

Requires

must be defined before using this function.

// Glcd module connections
var GLCD DataPort : byte at PORTC;
GLCD DataPort Direction : byte at DDRC;

var GLCD CS1 : sbit at PORTD.B2;
GLCD _CS2 : sbit at PORTD.B3;
GLCD RS : sbit at PORTD.B4;
GLCD_RW : sbit at PORTD.B5;
GLCD_EN : sbit at PORTD.B6;
GLCD _RST : sbit at PORTD.B7;

Example var GLCD CS1 Direction : sbit at DDRD.B2;

GLCD CS2 Direction : sbit at DDRD.B3;
GLCD_RS Direction : sbit at DDRD.B4;
GLCD_RW Direction : sbit at DDRD.B5;
GLCD_EN Direction : sbit at DDRD.BG6;
GLCDiRSTiDirection : sbit at DDRD.B7;
// End Glcd module connections

Gled Tnit();
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Glcd_Set_Side

Prototype procedure Glcd Set Side(x_pos: byte);

Returns Nothing.

Selects Glcd side. Refer to the Glcd datasheet for detailed explaination.
Parameters :

- x_pos: position on x-axis. Valid values: 0..127

Description
The parameter x pos specifies the Glcd side: values from 0 to 63 specify the

left side, values from 64 to 127 specify the right side.

Note: For side, x axis and page layout explanation see schematic at the bottom

of this page.
Requires Glcd needs to be initialized, see Glcd_Init routine.
The following two lines are equivalent, and both of them select
the left side of Glcd:
Example
Glcd Select Side(0);
Glcd Select Side(10);
Glcd_Set_X

Prototype |procedure Glcd Set X(x pos: byte);

Returns Nothing.

Sets x-axis position to x_pos dots from the left border of Glcd within the select-
ed side.

Parameters :
Description
- x_pos: position on x-axis. Valid values: 0..63

Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Example Glcd Set X (25);
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Glcd_Set_Page

Prototype procedure Glcd Set Page (page: byte);
Returns Nothing.
Selects page of the Glcd.
Parameters :
Description |_ page: page number. Valid values: 0..7
Note: For side, x axis and page layout explanation see schematic at the bottom
of this page.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example Glcd Set Page(5);
Glcd_Read_Data
Prototype function Glcd Read Data(): byte;
Returns One byte from Glcd memory.
i Reads data from from the current location of Glcd memory and moves to the
Description .
next location.
Glcd needs to be initialized, see Glcd_Init routine.
Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page.
var data: byte;
Example S
data := Glcd Read Data();
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Glcd_Write_Data

Prototype procedure Glcd Write Data (ddata: byte);

Returns Nothing.

Writes one byte to the current location in Glcd memory and moves to the
next location.

Description Parameters :

- ddata: data to be written

Glcd needs to be initialized, see Glcd_Init routine.

Requires Glcd side, x-axis position and page should be set first. See functions
Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page.
var data: byte;

Example -
Glcd Write Data (data);

Glcd_Fill

Prototype procedure Glcd Fill (pattern: byte);

Returns Nothing.

Fills Glcd memory with the byte pattern.
Parameters :

Description |- pattern: byte to fill Glcd memory with

To clear the Glcd screen, use Glcd Fill(0).

To fill the screen completely, use Glcd Fill (0xEF).

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Clear screen

Example Gled Fill(0);
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Glcd_Dot

Prokﬂype procedure Glcd Dot (x pos: byte; y pos: byte; color: byte);

Returns Nothing.

Draws a dot on Glcd at coordinates (x pos, y pos).
Parameters :
- x_pos: X position. Valid values: 0..127

- v pos: Yy position. Valid values: 0..63

Description .
P - color: color parameter. Valid values: 0..2

The parameter color determines a dot state: 0 clears dot, 1 puts a dot, and 2
inverts dot state.

Note: For x and y axis layout explanation see schematic at the bottom of this page.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Invert the dot in the upper left corner

Example |, poc(0, 0, 2);
Glcd_Line
procedure Glcd Line(x start: integer; y start: integer; x end:
Prokﬂype integer; y end: integer; color: byte);
Returns Nothing.
Draws a line on Glcd.
Parameters :
- x_start: x coordinate of the line start. Valid values: 0..127
. -y start:y coordinate of the line start. Valid values: 0..63
Description - . . .
- x_end: X coordinate of the line end. Valid values: 0..127
- v_end: y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example ' Draw a line between dots (0,0) and (20,30)
P Gled Line(0, 0, 20, 30, 1);
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Glcd_V_Line
procedure Glcd V Line(y start: byte; y end: byte; x pos: byte;
Prototype color: byte);
Returns Nothing.
Draws a vertical line on Glcd.
Parameters :
- v start:y coordinate of the line start. Valid values: 0..63
Description |- v end: y coordinate of the line end. Valid values: 0..63
- x_pos: X coordinate of vertical line. Valid values: 0..127
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
' Draw a vertical line between dots (10,5) and (10,25)
E |
xample Gled V Line(5, 25, 10, 1);
Glcd_H_Line
procedure Glcd V Line(x start: byte; x end: byte; y pos: byte;
Prototype color: byte);
Returns Nothing.
Draws a horizontal line on Glcd.
Parameters :
- x_start: X coordinate of the line start. Valid values: 0..127
Description |- x end: x coordinate of the line end. Valid values: 0..127
- v pos: Yy coordinate of horizontal line. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black, and 2 inverts
each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
E I ' Draw a horizontal line between dots (10,20) and (50,20)
xample Gled H Line (10, 50, 20, 1);
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Glcd_Rectangle

Prototype procedure Glcd Rectangle (x upper left: byte; y upper left: byte;
X bottom right: byte; y bottom right: byte; color: byte);
Returns Nothing.
Draws a rectangle on Glcd.
Parameters :
- x upper left:x coordinate of the upper left rectangle corner. Valid values: 0..127
-y upper left:y coordinate of the upper left rectangle corner. Valid values: 0..63
L. - x_bottom right: X coordinate of the lower right rectangle corner. Valid values:
Descrlptlon 0..127
-y bottom right:y coordinate of the lower right rectangle corner. Valid values:
0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the rectangle border: 0 white, 1
black, and 2 inverts each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example ' Draw a rectangle between dots (5,5) and (40,40)
P Glcd Rectangle (5, 5, 40, 40, 1);
Glcd_Box
Prototype procedure Glcd Box(x upper left: byte; y upper left: byte; x bot-
tom right: byte; y bottom right: byte; color: byte);
Returns Nothing.
Draws a box on Glcd.
Parameters :
- x _upper left: X coordinate of the upper left box corner. Valid values: 0..127
- v upper left:y coordinate of the upper left box corner. Valid values: 0..63
o - x_pbottom right: X coordinate of the lower right box corner. Valid values:
Description | 127
- v bottom right:y coordinate of the lower right box corner. Valid values:
0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the box fill: 0 white, 1 black, and 2
inverts each dot.
Requires Glcd needs to be initialized, see Glcd_Init routine.
Example ' Draw a box between dots (5,15) and (20,40)
P Gled Box (5, 15, 20, 40, 1);
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Glcd_Circle

procedure Glcd Circle(x center: integer; y center: integer;
radius: integer; color: byte);

Prototype

Returns Nothing.

Draws a circle on Glcd.
Parameters :

- x_center: X coordinate of the circle center. Valid values: 0..127
Description |- v center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0 white, 1 black, and
2 inverts each dot.

Requires Glcd needs to be initialized, see Glcd_Init routine.

Draw a circle with center in (50,50) and radius=10

Exan“ﬂe Glcd Circle (50, 50, 10, 1);

Glcd_Set_Font

procedure Glcd Set Font (const ActiveFont: “byte; FontWidth: byte;
FontHeight: byte; FontOffs: word);

Prototype

Returns Nothing.
Sets font that will be used with Glcd_Write_Char and Glcd_Write_Text routines.

Parameters :

- activeFont: font to be set. Needs to be formatted as an array of byte

- aFontWidth: width of the font characters in dots.

- aFontHeight: height of the font characters in dots.

Description |- aFontOffs: number that represents difference between the mikroPascal PRO
for AVR character set and regular ASCII set (eg. if 'A" is 65 in ASCII character,
and 'A' is 45 in the mikroPascal PRO for AVR character set, aFontOffs is 20).
Demo fonts supplied with the library have an offset of 32, which means that
they start with space.

The user can use fonts given in the file “__Lib_ GLCDFonts.mpas” file located in
the Uses folder or create his own fonts.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Use the custom 5x7 font "myfont" which starts with space (32):

Exan"ﬂe Glcd Set Font (myfont, 5, 7, 32);
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Glcd_Write_Char

procedure Glcd Write Char(chr: byte; x pos: byte; page num: byte;

Prototype color: byte);

Returns Nothing.

Prints character on the Glcd.
Parameters :

- chr: character to be written

- x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth)
- page num: the number of the page on which character will be written. Valid
Description | values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0 white, 1 black, and
2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.

Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to speci-
Requires fy the font for display; if no font is specified, then default 5x8 font supplied with
the library will be used.

' Write character 'C' on the position 10 inside the page 2:

Glcd Write Char('C', 10, 2, 1);

Example
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Glcd_Write_Text
procedure Glcd Write Text(var text: arrayl 20] of char; x pos:

PrOtOtype byte; page num: byte; color: byte);

Returns Nothing.

Prints text on Glcd.

Parameters :

- text: text to be written

- x_pos: text starting position on x-axis.

- page num: the number of the page on which text will be written. Valid values:

Description | 0..7
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the text: 0 white, 1 black, and 2
inverts each dot.

Note: For x axis and page layout explanation see schematic at the bottom of
this page.
Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to speci-

Requires fy the font for display; if no font is specified, then default 5x8 font supplied with
the library will be used.

' Write text "Hello world!" on the position 10 inside the page

Example 2:

Glcd Write Text ("Hello world!"™, 10, 2, 1);

Glcd_Image

Prototype procedure Glcd Image (const image: “byte);

Returns Nothing.

Displays bitmap on Gicd.
Parameters :

Description | image: image to be displayed. Bitmap array must be located in code memory.
Use the mikroPascal PRO for AVR integrated Glcd Bitmap Editor to convert
image to a constant array suitable for displaying on Glcd.

Requires Glcd needs to be initialized, see Glcd_Init routine.

' Draw image my image on Glcd

Example Glcd Image (my image);
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Library Example

The following example demonstrates routines of the Glcd library: initialization,
clear(pattern fill), image displaying, drawing lines, circles, boxes and rectangles, text

displaying and handling.

program Glcd Test;

uses bitmap;

// Glcd module connections
byte at PORTC;

GLCD DataPort Direction
// end Glcd module connections

var GLCD DataPort

var GLCD Csl : sbit
GLCD CS2 : sbit
GLCD RS : sbit
GLCD RW : sbit
GLCD EN : sbit

GLCD RST : sbit

at
at
at
at
at
at

var GLCD CS1 Direction
GLCD_CS2 Direction
GLCD RS Direction
GLCD _RW Direction
GLCD_EN Direction
GLCD_RST Direction

// End Glcd module connections

var counter : byte;

someText : arrayl 18]

procedure Delay2S();
begin
Delay ms (2000) ;
end;

begin

Glcd Init();
Glcd Fill (0x00);

while TRUE do
begin

byte at DDRC;

PORTD.B2;

PORTD.

B3;

PORTD.B4;
PORTD.B5;
PORTD.B6;

PORTD

sbit
sbit
sbit
sbit
sbit
sbit

.B7;

at
at
at
at
at
at

of char

Glcd Image (@truck bmp) ;
Delay2S(); delay2S();

Glcd Fill (0x00);

DDRD.

DDRD

DDRD.
DDRD.

DDRD

DDRD.

B2;
.B3;
B4;
B5;
.B6;
B7;

// 2 seconds delay function

// Initialize Glcd
// Clear Glcd

// Draw image

// Clear Glcd
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Glcd Box(62,40,124,63,1); // Draw box
Glcd Rectangle(5,5,84,35,1); // Draw rectangle
Glcd Line (0, 0, 127, 63, 1); // Draw line
Delay2S();
counter := 5;

while (counter <= 59) do // Draw horizontal and vertical lines
begin
Delay ms (250);
Glcd V Line(2, 54, counter, 1);
Glcd H Line(2, 120, counter, 1);

Counter := counter + 5;
end;
Delay2S () ;
Glecd Fill (0x00); // Clear Glcd
Glcd Set Font (@Character8x7, 8, 7, 32); // Choose font
"Character8x7"
Glcd Write Text ('mikroE', 1, 7, 2); // Write string
for counter := 1 to 10 do // Draw circles
Glcd Circle (63,32, 3*counter, 1);
Delay2S();
Glcd Box (12,20, 70,57, 2); // Draw box}
Delay2S();
Glcd Fill (OxFF) ; // Fill Glcd
Glcd Set Font (QCharacter8x7, 8, 7, 32); // Change font
someText := '8x7 Font';
Glcd Write Text (someText, 5, 0, 2); // Write string
delay2S();
Glcd Set Font (€System3x6, 3, 5, 32); // Change font
someText := '3X5 CAPITALS ONLY';
Glcd Write Text (someText, 60, 2, 2); // Write string
delay2S();
Glcd Set Font (€fontb5x7, 5, 7, 32); // Change font
someText := '5x7 Font';
Glcd Write Text (someText, 5, 4, 2); // Write string
delay2S();
Glcd Set Font (@FontSystem5x7 v2, 5, 7, 32); // Change font
someText := '5x7 Font (v2)';
Glcd Write Text (someText, 5, 6, 2); // Write string
delay2S();
end;
end.
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HW Connection
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KEYPAD LIBRARY

The mikroPascal PRO for AVR provides a library for working with 4x4 keypad. The library routines
can also be used with 4x1, 4x2, or 4x3 keypad. For connections explanation see schematic at the
bottom of this page.

Note: Since sampling lines for AVR MCUs are activated by logical zero Keypad Library can not
be used with hardwares that have protective diodes connected with anode to MCU side, such as
mikroElektronika's Keypad extra board HW.Rev v1.20

External dependencies of Keypad Library

The following variables
must be defined in all

keypadPort Direction :
byte; sfr; external; : byte at DDRB;

. . Description: Example :
projects using Sound P P
Library:
var keypadPort : var keypadPort : byte
byte; sfr; external; Keypad Port. at PORTB;
var var

Direction of the Keypad
Port.

keypadPort Direction

Library Routines

- Keypad_Init

- Keypad_Key Press
- Keypad_Key_Click

Keypad_Init

Prototype |procedure Keypad Init();

Returns Nothing.

Description |lInitializes port for working with keypad.
Global variables :

. - keypadPort Reg - Keypad port

Requires ypadrort neg =T yp .p N
- keypadPort Reg Direction - Direction of the Keypad port
must be defined before using this function.
// Initialize PORTB for communication with keypad
var keypadPort : byte at PORTB;

Example var keypadPort Direction : byte at DDRB;
Keypad Init();
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Keypad_Key_Press

Prototype function Keypad Key Press(): byte;

The code of a pressed key (1..16).
Returns
If no key is pressed, returns 0.

Description |Reads the key from keypad when key gets pressed.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.

var kp : byte;
Example S
kp := Keypad Key Press();

Keypad_Key_Click

Prototype function Keypad Key Click(): byte;
The code of a clicked key (1..16).

Returns
If no key is clicked, returns 0.

Call to Keypad_Key_Click is a blocking call: the function waits until some key is
pressed and released. When released, the function returns 1 to 16, depending
Description |on the key. If more than one key is pressed simultaneously the function will wait
until all pressed keys are released. After that the function will return the code of
the first pressed key.

Requires Port needs to be initialized for working with the Keypad library, see Keypad_Init.

var kp : byte;
Example

kp := Keypad Key Click();

Library Example

This is a simple example of using the Keypad Library. It supports keypads with 1..4 rows and 1..4
columns. The code being returned by Keypad_Key_Click() function is in range from 1..16. In this
example, the code returned is transformed into ASCII codes [0..9,A..F] and displayed on Lcd. In
addition, a small single-byte counter displays in the second Lcd row number of key presses.
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program Keypad Test;
var kp, cnt, oldstate : byte;
txt : arrayl 6] of byte;
// Keypad module connections
var keypadPort : byte at PORTB;
var keypadPort Direction : byte at DDRB;
// End Keypad module connections
// Lecd plnout definition
var LCD RS : sbit at PORTD.BZ;
LCD EN : sbit at PORTD.B3;
LCD_D4 : sbit at PORTD.B4;
LCD D5 : sbit at PORTD.B5;
LCD D6 : sbit at PORTD.B6;
LCD_D7 : sbit at PORTD.B7;
var LCD_RS_Direction : sbit at DDRD.B2;
LCD EN Direction : sbit at DDRD.B3;
LCD_D4_Direction : sbit at DDRD.B4;
LCD D5 Direction : sbit at DDRD.B5;
LCD D6 Direction : sbit at DDRD.B6;
LCD D7 Direction : sbit at DDRD.B7;
// end Lcd pinout deflnltlons
begin
oldstate := 0;
cnt := 0; // Reset counter
Keypad Init(); // Initialize Keypad
Led Init(); // Initialize Lcd
Lcd Cmd (LCD_CLEAR) ; // Clear display
Lcd Cmd (LCD_CURSOR _OFF) ; // Cursor off
Led Out (1, 1, 'Key :'); // Write message text on Lcd
Lcd Out (2, 1, 'Times:');
while TRUE do
begin
kp := 0; // Reset key code variable

// Wait for key to be pressed and released
while ( kp = 0 ) do
kp := Keypad Key Click(); // Store key code in kp variable
// Prepare value for output, transform key to it's ASCII value
case kp of

//case 10: kp = 42; // '*' // Uncomment this block for
keypad4x3
//case 11: kp = 48; // 0"
//case 12: kp = 35; /) #!

//default: kp += 48;
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1: kp := 49; // 1 // Uncomment this block for keypaddx4
2: kp := 50; // 2
3: kp := 51; // 3
4: kp := 65; // A
5: kp := 52; // 4
6: kp := 53; // 5
7: kp := 54; // 6
8: kp := 66; // B
9: kp := 55; // 7
10: kp := 56; // 8
11: kp := 57; // 9
12: kp := 67; // C
13: kp := 42; // *
14: kp := 48; // O
15: kp := 35; // #
16: kp := 68; // D
end;
if (kp <> oldstate) then // Pressed key differs from
previous
begin
cnt = 1;
oldstate := kp;
end
else // Pressed key 1s same as previous

Inc(cnt);

Led Chr (1, 10, kp); // Print key ASCII value on Lcd
if (cnt = 255) then // If counter varialble overflow
begin
cnt := 0;
Led Out (2, 10, ' ")
end;
WordToStr (cnt, txt); // Transform counter value to string
Led Out (2, 10, txt); // Display counter value on Lcd
end;
end.
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HW Connection
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LCD LIBRARY

The mikroPascal PRO for AVR provides a library for communication with Lcds (with
HD44780 compliant controllers) through the 4-bit interface. An example of Lcd connec-
tions is given on the schematic at the bottom of this page.

For creating a set of custom Lcd characters use Lcd Custom Character Tool.

External dependencies of Lcd Library

The following variables
must be defined in all proj-
ects using Lcd Library :

Description:

Example :

var LCD RS sbit; sfr; Regqister Select line var LCD_RS sbit at
external; 9 ’ PORTD.B2;
var LCD EN sbit; sfr; Enable li var LCD EN sbit at
external; nabie line. PORTD.B3;
var LCD D7 sbit; sfr; Data 7 line var LCD D7 sbit at
external; ine. PORTD.B4;
var LCD D6 sbit; sfr; Data 6 line var LCD D6 sbit at
external; ' PORTD.BS5;
var LCD D5 sbit; sfr; Data 5 line var LCD D5 sbit at
external; ’ PORTD.B6;
var LCD D4 sbit; sfr; Data 4 line var LCD D4 sbit at
external; ' PORTD.B7;

var LCD RS Direction

Register Select direction pin.

var LCD RS Direction

sbit; sfr; external; sbit at DDRD.B2;
var LCD EN Direction Enable direction pin var LCD EN Direction
sbit; sfr; external; pin. sbit at DDRD.B3;

var LCD D7 Direction

Data 7 direction pin.

var LCD D7 Direction

sbit; sfr; external; sbit at DDRD.BR4;
vaJ_': LCD D6 Direction Data 6 direction pin. Va:l-'.' LCD D6 Direction
sbit; sfr; external; sbit at DDRD.B5;
va:l_': LCD D5 Direction Data 5 direction pin. Va:l-'.‘ LCD D5 Direction
sbit; sfr; external; sbit at DDRD.B6;
va:_: LCD D4 Direction Data 4 direction pin. Va:l-'.‘ LCD D4 Direction
sbit; sfr; external; sbit at DDRD.B7;

Library Routines

- Led_Init

- Led_Out

- Led_Out_Cp
- Led_Chr

- Led_Chr_Cp
- Led_Cmd
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Lcd_Init

Prototype

procedure Lcd Init()

Returns

Nothing.

Description

Initializes Lcd module.

Requires

Global variables:

rcp Dp7: Data bit 7
rcp Dé6: Data bit 6
rcp D5: Data bit 5
rcp p4: Data bit 4

Lcp Rrs: Register Select (data/instruction) signal pin

- Lcp EN: Enable signal pin

- LCD_D7 Direction:
LCD D6 Direction:
: Direction of the Data 5 pin
LCD D4 Direction:
LCD RS Direction:
LCD_EN Direction:

LCD D5 Direction

Direction of the Data 7 pin
Direction of the Data 6 pin

Direction of the Data 4 pin
Direction of the Register Select pin
Direction of the Enable signal pin

must be defined before using this function.

Example

// Lcd module connections

var LCD RS : sbit
var LCD EN : sbit
var LCD D4 : sbit
var LCD D5 : sbit
var LCD D6 : sbit
var LCD D7 : sbit

at PORTD.B2;
at PORTD.B3;
at PORTD.B4;
at PORTD.B5;
at PORTD.B6;
at PORTD.B7;

var
var
var
var
var
var

LCD RS Direction
LCD_EN Direction
LCD D4 Direction
LCD D5 Direction
LCD D6 Direction
LCD D7 Direction

sbit
sbit
sbit
sbit
sbit
sbit

at
at
at
at
at
at

// End Lcd module connections

Led

Init ();

DDRD
DDRD
DDRD
DDRD
DDRD
DDRD

.B2;
.B3;
.B4;
.B5;
.B6;
.B7;

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 255



CHAPTER 6

Libraries mikroPASCAL PRO for AVR
Lcd_Out
Prototype I:;ozt;zt:)c? Lcd Out (row: byte; column: byte; var text: array [ 20]
Returns Nothing.

Prints text on Lcd starting from specified position. Both string variables and liter-
als can be passed as a text.

i Parameters :
Description
- row: starting position row number

- column: starting position column number
- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

// Write text "Hello!"™ on Lcd starting from row 1, column 3:
Lecd Out(l, 3, "Hello!");

Example

Lcd_Out_Cp

Prototype procedure Lcd Out Cp(var text: array [ 20] of char);

Returns Nothing.

Prints text on Lcd at current cursor position. Both string variables and literals
can be passed as a text.

Description Parameters :

- text: text to be written

Requires The Lcd module needs to be initialized. See Lcd_Init routine.

// Write text "Here!" at current cursor position:

Example Lcd Out Cp("Here!");
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Lcd_Chr
Prototype procedure Lcd Chr(row: byte; column: byte; out char: byte);
Returns Nothing.

Prints character on Lcd at specified position. Both variables and literals can be
passed as a character.

i Parameters :
Description
- row: writing position row number
- column: writing position column number
- out char: character to be written
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
Example // Write character "i" at row 2, column 3:
P Led Chr(2, 3, 'i');
Lcd_Chr_Cp
Prototype procedure Lcd Chr Cp(out char: byte);
Returns Nothing.
Prints character on Lcd at current cursor position. Both variables and literals
can be passed as a character.
Description
P Parameters :
- out char: character to be written
Requires The Lcd module needs to be initialized. See Lcd_Init routine.
// Write character "e" at current cursor position:
Example

Lcd Chr Cp('e');
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Lcd_Cmd
Prototype procedure Lcd Cmd(out char: byte);
Returns Nothing.
Sends command to Lcd.
Parameters :
Description | out char: command to be sent
Note: Predefined constants can be passed to the function, see Available Lcd
Commands.
Requires The Lcd module needs to be initialized. See Lcd_Init table.
// Clear Lcd display:
Example Led Cmd (LCD_CLEAR) ;

Available Lcd Commands

Lcd Command

Purpose

LCD_FIRST ROW

Move cursor to the 1st row

LCD_SECOND_ROW

Move cursor to the 2nd row

LCD_THIRD ROW

Move cursor to the 3rd row

LCD_FOURTH_ROW

Move cursor to the 4th row

LCD_CLEAR

Clear display

LCD_RETURN HOME

Return cursor to home position, returns a shifted display
to its original position. Display data RAM is unaffected.

LCD_CURSOR OFF

Turn off cursor

LCD_UNDERLINE ON

Underline cursor on

LCD BLINK CURSOR ON

Blink cursor on

LCD_MOVE_CURSOR_LEFT

Move cursor left without changing display data RAM

LCD MOVE CURSOR RIGHT

Move cursor right without changing display data RAM

LCD_TURN ON

Turn Lcd display on

LCD_TURN OFF

Turn Lcd display off

LCD_SHIFT LEFT

Shift display left without changing display data RAM

LCD_SHIFT RIGHT

Shift display right without changing display data RAM
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Library Example

The following code demonstrates usage of the Lcd Library routines:

program Lcd Test;

// Lcd module connections

var LCD RS : sbit at PORTD.B2;
var LCD EN : sbit at PORTD.B3;
var LCD D4 : sbit at PORTD.B4;
var LCD D5 : sbit at PORTD.B5;
var LCD D6 : sbit at PORTD.B6;
var LCD D7 : sbit at PORTD.B7;

var LCD RS Direction : sbit at DDRD.B2;
var LCD EN Direction : sbit at DDRD.B3;
var LCD D4 Direction : sbit at DDRD.B4;
var LCD D5 Direction : sbit at DDRD.B5;
var LCD D6 Direction : sbit at DDRD.B6;
var LCD D7 Direction : sbit at DDRD.B7;
// End Lcd module connections

var txtl : arrayl 16] of char;
txt2 : arrayl 9] of char;
txt3 : arrayl 8] of char;
txtd4 : arrayl 7] of char;

i : byte; // Loop variable
procedure Move Delay(); // Function used for text moving
begin
Delay ms (500) ; // You can change the moving speed here
end;
begin
txtl := 'mikroElektronika'
txt2 := 'EasyAVROLOA';
txt3 := 'Lcd4bit';
txtd := 'example'
Led Init(); // Initialize Lcd
Led Cmd (LCD CLEAR) ; // Clear display
Lcd Cmd (LCD_CURSOR_OFF) ; // Cursor off
LCD Out (1,6,txt3); // Write text in first row
LCD Out (2, 6,txtd); // Write text in second row
Delay ms (2000);
Led Cmd (LCD CLEAR) ; // Clear display
LCD Out(1,1,txtl); // Write text in first row
LCD Out (2,4,txt2); // Write text in second row

Delay ms (500);
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// Moving text
for i:=0 to 3 do // Move text to the right 4 times
begin

Led Cmd (LCD_SHIFT RIGHT) ;
Move Delay () ;

end;
while TRUE do // Endless loop
begin
for i:=0 to 6 do // Move text to the left 7 times
begin
Led Cmd (LCD SHIFT LEFT) ;
Move Delay () ;
end;
for i:=0 to 6 do // Move text to the right 7 times
begin
Led Cmd (LCD _SHIFT RIGHT) ;
Move Delay () ;
end;
end;

end.
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HW connection
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MANCHESTER CODE LIBRARY

The mikroPascal PRO for AVR provides a library for handling Manchester coded sig-
nals. The Manchester code is a code in which data and clock signals are combined
to form a single self-synchronizing data stream; each encoded bit contains a transi-
tion at the midpoint of a bit period, the direction of transition determines whether the
bit is 0 or 1; the second half is the true bit value and the first half is the complement
of the true bit value (as shown in the figure below).

Manchester RF_Send_Byte format

St1|5t2|Cir |B7 |B6|B5|B4 | B3| B2|B1|BO

Bi-phase coding
Al
1 0

2ms Example of transmission

117000100011

Notes: The Manchester receive routines are blocking calls (Man_Receive_Init and
Man_Synchro). This means that MCU will wait until the task has been performed
(e.g. byte is received, synchronization achieved, etc).

Note: Manchester code library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Manchester Code Library

The following variables
must be defined in all L.
. . Description: Example :
projects using Sound
Library:

var MANRXPIN : sbit; . . var MANRXPIN : sbit
sfr; external; Receive line. at PINB.BO;

var MANTXPIN : sbit; o var MANTXPIN : sbit
sfr; external; Transmit line. at PORTB.B1;
var var

MANRXPIN Direction : |Direction of the Receive pin. |MANRXPIN Direction :
sbit; sfr; external; sbit at DDRB.BO;
var var
MANTXPIN Direction : |Direction of the Transmit pin.|MANTXPIN Direction :
sbit; sfr; external; sbit at DDRB.B1;
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Library Routines

- Man_Receive_|Init

- Man_Receive

- Man_Send_Init

- Man_Send

- Man_Synchro

- Man_Break

The following routines are for the internal use by compiler only:

- Manchester_0
- Manchester_1
- Manchester_Out

Man_Receive_Init

Prototype function Man Receive Init(): word;

Returns - 0 - if initialization and synchronization were successful.
- 1 - upon unsuccessful synchronization.
The function configures Receiver pin and performs synchronization procedure in
order to retrieve baud rate out of the incoming signal.

Description
Note: In case of multiple persistent errors on reception, the user should call this
routine once again or Man_Synchro routine to enable synchronization.
Global variables :

. - MANRXPIN : Receive line

Requires ‘ N . .
- MANRXPIN Direction : Direction of the receive pin
must be defined before using this function.
// Initialize Receiver
var MANRXPIN : sbit at PINB.BO;

Example var MANRXPIN Direction : sbit at DDRB.BO;
Man Receive Init();
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Man_Receive

Prokﬂype function Man Receive (var error: byte): byte;

Returns A byte read from the incoming signal.

The function extracts one byte from incoming signal.

i Parameters :
Description
- error: error flag. If signal format does not match the expected, the error flag
will be set to non-zero.
. To use this function, the user must prepare the MCU for receiving. See
Requires . .
Man_Receive_Init.
var data, error : byte
data := 0
error := 0
data := Man Receilve (&error) ;
Example -
if (error <> 0) then
begin
// error handling
end;
Man_Send_lInit

Prototype |procedure Man Send Init();

Returns Nothing.

Description |The function configures Transmitter pin.

Global variables :

- MANRXPIN : Receive line

Requires ‘ i . .
- MANRXPIN Direction : Direction of the receive pin
must be defined before using this function.

// Initialize Transmitter:
var MANTXPIN : sbit at PINB.BI1;
Example var MANTXPIN Direction : sbit at DDRB.BI;

ManisendiLnit();
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Man_Send
Prototype procedure Man Send(tr data: byte);
Returns Nothing.
Sends one byte.
Parameters :
Description
- tr data: data to be sent
Note: Baud rate used is 500 bps.
. To use this function, the user must prepare the MCU for sending. See
Requires .
Man_Send_ Init.
var msg : byte;
Example S
Man Send (msg) ;

Man_Synchro

Prototype function Man Synchro(): word;
- 0 - if synchronization was not successful.
Returns - Half of the manchester bit length, given in multiples of 10us - upon successful
synchronization.
Description |Measures half of the manchester bit length with 10us resolution.
Reaqui To use this function, you must first prepare the MCU for receiving. See
equires . .
Man_Receive_Init.
var man half bit len : word ;
Example S
man half bit len := Man Synchro();
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Man_Break

Prototype procedure Man Break();

Returns Nothing.

Man_Receive is blocking routine and it can block the program flow. Call this
routine from interrupt to unblock the program execution. This mechanism is sim-

e ilar to WDT.
Description

Note: Interrupts should be disabled before using Manchester routines again
(see note at the top of this page).

Requires Nothing.

var datal, error, counter : byte;

procedure TimerOOverflow ISR(); org 0x12;
begin
counter := 0;
if (counter >= 20) then
begin
Man Break();
counter := 0; // reset counter
end
else
Inc (counter) ; // increment counter
end;
begin
TOIEO bit = 1; // Timer0 overflow interrupt enable
TCCRO bit := 5; // Start timer with 1024 prescaler

Example SREG T bit := 0; // Interrupt disable

Man Receive Init();

// try Man Receive with blocking prevention mechanism

SREG I bit := 1; // Interrupt enable

datal := Man Receive (@error);

SREG I bit := 0; // Interrupt disable
end;
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Library Example

The following code is code for the Manchester receiver, it shows how to use the
Manchester Library for receiving data:

program Manchester Receiver;

// Lcd module connections

var LCD RS : sbit at PORTD.B2;
LCD_EN : sbit at PORTD.R3;
LCD_D4 : sbit at PORTD.BR4;
LCD_D5 : sbit at PORTD.B5;
LCD_D6 : sbit at PORTD.B6;
LCD_D7 : sbit at PORTD.R7;

var LCD_RS_Direction : sbit at DDRD.B2;
LCD EN Direction : sbit at DDRD.B3;
LCD D4 Direction : sbit at DDRD.B4;
LCD D5 Direction : sbit at DDRD.B5;
LCD D6 Direction : sbit at DDRD.B6;
LCD D7 Direction : sbit at DDRD.B7;
// End Lcd module connections

// Manchester module connections

var MANRXPIN : sbit at PINB.RO;
MANRXPIN Direction : sbit at DDRB.BO;
MANTXPIN : sbit at PORTB.BI1;
MANTXPIN Direction : sbit at DDRB.BI;

// End Manchester module connections

var error, ErrorCount, temp : byte;
begin
ErrorCount := 0;
Delay 10us();
Led Init () // Initialize Lcd
Lcd Cmd (LCD_CLEAR) ; // Clear Lcd display
Man Receive Init(); // Initialize Receiver
while TRUE do // Endless loop
begin
Lcd Cmd (LCD_FIRST ROW) ; // Move cursor to the 1lst row
while TRUE do // Wait for the "start" byte
begin
temp := Man Receive (error); // Attempt byte receive
if (temp = 0x0B) then // "Start" byte, see Transmitter example
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break; // We got the starting sequence
if (error <> 0) then // Exit so we do not loop forever
break;
end;
repeat
begin
temp := Man Receive (error); // Attempt byte receive
if (error <> 0) then // 1If error occured
begin
Led Chr CP('2'); // Write question mark on Lcd
Inc (ErrorCount) ; // Update error counter
if (ErrorCount > 20) then // In case of multi-
ple errors
begin
temp := Man Synchro(); // Try to synchronize
again
//Man_Receive Init(); // Alternative, try to
Initialize Receiver again
ErrorCount := 0; // Reset error counter
end;
end
else // No error occured
begin
if (temp <> O0xOE) then // If "End" byte was
received(see Transmitter example)
Lcd Chr CP(temp); // do not write received
byte on Lcd
end;
Delay ms(25);
end;
until ( temp = O0x0E );
end; // If "End" byte was received exit do loop

end.

The following code is code for the Manchester transmitter, it shows how to use the
Manchester Library for transmitting data:

program Manchester Transmitter;

// Manchester module connections

var MANRXPIN : sbit at PORTB.BO;
MANRXPIN Direction : sbit at DDRB.BO;
MANTXPIN : sbit at PORTRB.BR1;
MANTXPIN Direction : sbit at DDRB.BI;

// End Manchester module connections

var index, character : byte;
sl : array] 17] of char;
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begin
sl := 'mikroElektronika';
Man Send Init(); // Initialize transmitter
while TRUE do // Endless loop
begin
Man Send (0x0B) ; // Send "start" byte
Delay ms(100); // Wait for a while
character := s1[ 0] ; // Take first char from string
index := 0; // Initialize index variable
while (character <> 0) do // String ends with zero
begin
Man Send (character); // Send character
Delay ms (90); // Wait for a while
Inc (index) ; // Increment index variable
character := sl[ index] ; // Take next char from string
end;
Man Send (0x0E) ; // Send "end" byte
Delay ms (1000);
end;
end.

Connection Example

i S
Transmitter RF {]re
module E
[]
Antenna i >
. E —
N =
i VG m GHD
QESULATOR GHND 1=
BiiiiE
XTAL1
vVCC E ot %
1 O i
——A RT4 n— i ]
[] I
(] I
[] I

j

Simple Transmitter connection
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Receiver RF fra0 ~ i
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Simple Receiver connection
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MULTI MEDIA CARD LIBRARY

The Multi Media Card (MMC) is a flash memory card standard. MMC cards are cur-
rently available in sizes up to and including 1 GB, and are used in cell phones, mp3
players, digital cameras, and PDA’s.

mikroPascal PRO for AVR provides a library for accessing data on Multi Media Card
via SPI communication.This library also supports SD(Secure Digital) memory cards.

Secure Digital Card

Secure Digital (SD) is a flash memory card standard, based on the older Multi Media
Card (MMC) format.

SD cards are currently available in sizes of up to and including 2 GB, and are used
in cell phones, mp3 players, digital cameras, and PDAs.

Notes:

- Routines for file handling can be used only with FAT16 file system.

- Library functions create and read files from the root directory only;

- Library functions populate both FAT1 and FAT2 tables when writing to files, but the
file data is being read from the FAT1 table only; i.e. there is no recovery if FAT1
table is corrupted.

- Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized with
the appropriate SPI_Read routine.

External dependencies of MMC Library

The following variables
must be defined in all
projects using Sound

Library:

Description: Example :

var Mmc Chip Select :
sbit; sfr; external;

var Mmc Chip Select

Chlp select pin. : sbit at PINB.BO;

var var

Mmc Chip Select Direc . . . . Mmc Chip Select Dir
tion : sbit; sfr; Direction of the chip select pin. ection : sbit at
external; DDRB.BO;

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 271



CHAPTER 6
Libraries mikroPASCAL PRO for AVR

Library Routines

- Mmc_Init

- Mmc_Read_Sector
- Mmc_Write_Sector
- Mmc_Read_Cid

- Mmc_Read_Csd

Routines for file handling:

- Mmc_Fat_Init

- Mmc_Fat_QuickFormat

- Mmc_Fat_Assign

- Mmc_Fat_Reset

- Mmc_Fat_Read

- Mmc_Fat_Rewrite

- Mmc_Fat_Append

- Mmc_Fat_Delete

- Mmc_Fat_Write

- Mmc_Fat_Set_File_Date
- Mmc_Fat_Get File_Date
- Mmc_Fat_Get_File_Size
- Mmc_Fat_Get Swap_File
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Mmc_Init
Prototype function Mmc Init(): byte;
- 0 - if MMC/SD card was detected and successfully initialized
Returns

- 1 - otherwise

Initializes MMC through hardware SPI interface.

. Parameters:
Description

- port: chip select signal port address.
- cspin: chip select pin.

Global variables :

-Mmc Chip select: Chip Select line

. - Mmc Chip Select Direction: Direction of the Chip Select pin
Requires - - -
must be defined before using this function.

The appropriate hardware SPI module must be previously initialized. See the
SPI1_Init, SPI1_Init_Advanced routines.

// MMC module connections

var Mmc Chip Select : sbit; sfr; at PORTB.B2;

var Mmc Chip Select Direction : sbit; sfr; at DDRB.B2;
// MMC module connections

error = Mmc_Init(); // Init with CS line at PORTB.B2
Example var i : byte;

SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK LO LEAD-
ING) ;

Spi Rd Ptr := @SPI1 Read; // Pass pointer to SPI Read func-
tion of used SPI module

i = Mmc_ Init();
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Mmc_Read_Sector

function Mmc Read Sector (sector: longint; wvar dbuff: array[ 512]

PrOtOtype of byte): byte;
- 0 - if reading was successful
Returns .
- 1 - if an error occurred
The function reads one sector (512 bytes) from MMC card.
i Parameters:
Description

- sector: MMC/SD card sector to be read.
- data: buffer of minimum 512 bytes in length for data storage.

Requires MMC/SD card must be initialized. See Mmc_Init.

// read sector 510 of the MMC/SD card

var error : byte;
sectorNo : longint;
Example dataBuffer : arrayl 512] of byte;
sectorNo := 510;
error := Mmc Read Sector (sectorNo, dataBuffer);

Mmc_Write_Sector

function Mmc Write Sector(sector: longint; var data : arrayl 512]

Prototype of byte): byte;

- 0 - if writing was successful
Returns - 1 - if there was an error in sending write command
- 2 - if there was an error in writing (data rejected)

The function writes 512 bytes of data to one MMC card sector.

. Parameters:
Description

- sector: MMC/SD card sector to be written to.
- data: data to be written (buffer of minimum 512 bytes in length).

Requires MMC/SD card must be initialized. See Mmc_Init.
// write to sector 510 of the MMC/SD card

var error : byte;
sectorNo : longint;
Example dataBuffer : arrayl 512] of byte;
sectorNo := 510;
error := Mmc Write Sector (sectorNo, dataBuffer);
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Mmc_Read_Cid

Prototype function Mmc_Read Cid(var data cid: array] 16] of byte): byte;
Returns -0- !f CID register was read_succes_sfully

- 1 - if there was an error while reading

The function reads 16-byte CID register.
Description |Parameters:

- data cid: buffer of minimum 16 bytes in length for storing CID register content.
Requires MMC/SD card must be initialized. See Mmc_Init.

var error : byte;
Exanuﬂe dataBuffer : arrayl 16] of byte;

éé%or := Mmc Read Cid(dataBuffer);

Mmc_Read_Csd

Prototype function Mmc Read Csd(var data for registers: array| 16] of
yp byte): byte;
- 0 - if CSD register was read successfully
Returns . . :
- 1 - if there was an error while reading
The function reads 16-byte CSD register.
i Parameters:
Description
- data for registers: buffer of minimum 16 bytes in length for storing CSD
register content.
Requires MMC/SD card must be initialized. See Mmc_Init.
var error : word;
data fo egisters : arrayl 16] of byte;
Example —tor_register vl 16] v
error := Mmc Read Csd(data for registers);
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Mmc_Fat_Init

Prototype |function Mmc Fat Init(): byte;

- 0 - if MMC/SD card was detected and successfully initialized
Returns - 1 - if FAT16 boot sector was not found
- 255 - if MMC/SD card was not detected

Initializes MMC/SD card, reads MMC/SD FAT16 boot sector and extracts neces-
sary data needed by the library.

Description
Note: MMC/SD card has to be formatted to FAT16 file system.

Global variables :

-Mmc Chip select: Chip Select line

. -Mmc Chip Select Direction: Direction of the Chip Select pin
Requires - - -
must be defined before using this function.

The appropriate hardware SPI module must be previously initialized. See the
SPI1_Init, SPI1_Init_Advanced routines.

// init the FAT library

if (Mmc Fat Init() = 0) then

Example begin

end
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Mmc_Fat_QuickFormat

function Mmc Fat QuickFormat (var port : word; pin : word; var

Prototype | = tit 1abel : string 11]) : byte;

- 0 - if MMC/SD card was detected, successfully formated and initialized
Returns - 1 - if FAT16 format was unseccessful
- 255 - if MMC/SD card was not detected

Formats to FAT16 and initializes MMC/SD card.

Parameters:

- port: chip select signal port address.

- pin: chip select pin.

-mmc fat label: volume label (11 characters in length). If less than 11 charac

. ters are provided, the label will be padded with spaces. If an empty string is

Description .
passed, the volume will not be labeled.

Note: This routine can be used instead or in conjunction with the

Mmc_Fat_Init routine.

Note: If MMC/SD card already contains a valid boot sector, it will remain
unchanged (except volume label field) and only FAT and ROOT tables will be
erased. Also, the new volume label will be set.

Requires The appropriate hardware SPI module must be previously initialized.

// format and initialize the FAT library
if (Mmc Fat QuickFormat ('mikroE') = 0) then
Example begin

end;
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Mmc_Fat_Assign

function Mmc Fat Assign(var filename: array[ 12] of char;
file cre attr: byte): byte;

- 1 - if file already exists or file does not exist but a new file is created.

- 0 - if file does not exist and no new file is created.

Assigns file for file operations (read, write, delete...). All subsequent file opera-
tions will be applied on an assigned file.

Prototype

Returns

Parameters:

- filename: name of the file that should be assigned for file operations. File
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to proper case automatically, so the user does not
have to take care of that. Also, in order to keep backward compatibility with the
first version of this library, file names can be entered as UPPERCASE string of
11 bytes in length with no dot character between file name and extension (i.e.
"MIKROELETXT" -> MIKROELE.TXT). In this case last 3 characters of the
string are considered to be file extension.

o - file cre attr: file creation and attributs flags. Each bit corresponds to the
Description | appropriate file attribut:

Bit | Mask Description

0 0x01 [Read Only

1 0x02 [Hidden

2 0x04 [System

3 0x08 [Volume Label

4 0x10 [Subdirectory

5 0x20 |Archive

6 0x40 [Device (internal use only, never found on disk)

7 0x80 File cre_atioq flag. If _tr_le file does _not exist and this flag is set,
a new file with specified name will be created.

Note: Long File Names (LFN) are not supported.
MMC/SD card and MMC library must be initialized for file operations. See

Requires :
q Mmc_Fat_Init.
// create file with archive attribut if it does not already exist
Example : . . :
Mmc Fat Assign ('MIKROO0O07.TXT',O0xAO0);
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Mmc_Fat_Reset

Prototype procedure Mmc Fat Reset(var size: dword);
Returns Nothing.
Opens currently assigned file for reading.
e Parameters:
Description
- size: buffer to store file size to. After file has been open for reading, its size is
returned through this parameter.
MMC/SD card and MMC library must be initialized for file operations. See
. Mmc_Fat_Init.
Requires
The file must be previously assigned. See Mmc_Fat_Assign.
var size : dword;
Example S
Mmc Fat Reset (size);

Mmc_Fat_Read

Prokﬂype procedure Mmc Fat Read(var bdata: byte);
Returns Nothing.
Reads a byte from the currently assigned file opened for reading. Upon function
execution, file pointers will be set to the next character in the file.
Description |Parameters:
- bdata: buffer to store read byte to. Upon this function execution read byte is
returned through this parameter.
MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.
Requires The file must be previously assigned. See Mmc_Fat_Assign.
The file must be opened for reading. See Mmc_Fat_Reset.
var character : byte;
Example

Mmc Fat Read(character);
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Mmc_Fat_Rewrite

Prototype |procedure Mmc Fat Rewrite();

Returns Nothing.

Description Opens the currently assigned file for writing. If the file is not empty its content
will be erased.
MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.

Requires
The file must be previously assigned. See Mmc_Fat_Assign.

E I // open file for writing

Xample Mmc Fat Rewrite();

Mmc_Fat_Append

Prototype procedure Mmc Fat Append () ;
Returns Nothing.
Opens the currently assigned file for appending. Upon this function execution
Description |file pointers will be positioned after the last byte in the file, so any subsequent
file writing operation will start from there.
MMC/SD card and MMC library must be initialized for file operations. See
. Mmc_Fat_Init.
Requires
The file must be previously assigned. See Mmc_Fat_Assign.
// open file for appending
Example Mmc Fat Append() ;

Mmc_Fat_Delete

Prototype procedure Mmc Fat Delete();

Returns Nothing.

Description |Deletes currently assigned file from MMC/SD card.
MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_Init.

Requires - =
The file must be previously assigned. See Mmc_Fat_Assign.

E I // delete current file

xample Mmc Fat Delete();
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Mmc_Fat_Write

procedure Mmc Fat Write(var fdata: array[ 512] of byte; data len:

Prototype

word) ;
Returns Nothing.

Writes requested number of bytes to the currently assigned file opened for writing.
Description Parameters:

- fdata: data to be written.
- data len: number of bytes to be written.

MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.

Requires The file must be previously assigned. See Mmc_Fat_Assign.

The file must be opened for writing. See Mmc_Fat_Rewrite or
Mmc_Fat_Append.

var file contents : arrayl 42] of byte;
Example

Mmc Fat Write(file contents, 42); // write data to the assigned file
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Mmc_Fat_Set_File_Date

procedure Mmc Fat Set File Date(year: word; month: byte; day:

PrOtOtype byte; hours: byte; mins: byte; seconds: byte);

Returns Nothing.

Sets the date/time stamp. Any subsequent file writing operation will write this
stamp to the currently assigned file's time/date attributs.

Parameters:

Description |- year: year attribute. Valid values: 1980-2107
- month: month attribute. Valid values: 1-12

- day: day attribute. Valid values: 1-31

- hours: hours attribute. Valid values: 0-23

- mins: minutes attribute. Valid values: 0-59

- seconds: seconds attribute. Valid values: 0-59

MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.

Requires The file must be previously assigned. See Mmc_Fat_Assign.

The file must be opened for writing. See Mmc_Fat_Rewrite or
Mmc_Fat_Append.

Example Mmc Fat Set File Date(2005,9,30,17,41,0);
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Mmc_Fat_Get_File_Date

procedure Mmc Fat Get File Date(var year: word; var month: byte;
var day: byte; wvar hours: byte; war mins: byte);

Prototype

Returns Nothing.

Reads time/date attributes of the currently assigned file.
Parameters:

- year: buffer to store year attribute to. Upon function execution year attribute is
returned through this parameter.

- month: buffer to store month attribute to. Upon function execution month attrib
ute is returned through this parameter.

- day: buffer to store day attribute to. Upon function execution day attribute is
returned through this parameter.

- hours: buffer to store hours attribute to. Upon function execution hours attrib-
ute is returned through this parameter.

- mins: buffer to store minutes attribute to. Upon function execution minutes
attribute is returned through this parameter.

MMC/SD card and MMC library must be initialized for file operations. See
Mmc_Fat_Init.

Description

Requires

The file must be previously assigned. See Mmc_Fat_Assign.

var year : word;

month, day, hours, mins : byte;
Example v ’

Mmc Fat Get File Date(year, month, day, hours, mins);

Mmc_Fat_Get_File_Size

Prototype function Mmc Fat Get File Size(): dword;

Returns Size of the currently assigned file in bytes.

Description |This function reads size of the currently assigned file in bytes.

MMC/SD card and MMC library must be initialized for file operations. See

. Mmc_Fat_|Init.
Requires - =
The file must be previously assigned. See Mmc_Fat_Assign.
var my file size : dword;
Example S
my file size := Mmc Fat Get File Size();
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Mmc_Fat_Get_Swap_File

function Mmc Fat Get Swap File(sectors cnt: longint; war filename

PrOtOtype : stringf 11] ; file attr : byte) : dword;

- Number of the start sector for the newly created swap file, if there was enough
Returns free space on the MMC/SD card to create file of required size.
- 0 - otherwise.

This function is used to create a swap file of predefined name and size on the
MMC/SD media. If a file with specified name already exists on the media,
search for consecutive sectors will ignore sectors occupied by this file. There-
fore, it is recommended to erase such file if it already exists before calling this
function. If it is not erased and there is still enough space for a new swap file,
this function will delete it after allocating new memory space for a new swap file.

The purpose of the swap file is to make reading and writing to MMC/SD media
as fast as possible, by using the Mmc_Read_Sector() and Mmc_Write_Sector()
functions directly, without potentially damaging the FAT system. The swap file
can be considered as a "window" on the media where the user can freely
write/read data. Its main purpose in the mikroPascal's library is to be used for
fast data acquisition; when the time-critical acquisition has finished, the data
can be re-written into a "normal” file, and formatted in the most suitable way.

o Parameters:

Description

- sectors_cnt: number of consecutive sectors that user wants the swap file to have.

- filename: name of the file that should be assigned for file operations. File
name should be in DOS 8.3 (file_name.extension) format. The file name and
extension will be automatically padded with spaces by the library if they have
less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not
have to take care of that. The file name and extension are case insensitive.
The library will convert them to proper case automatically, so the user does not
have to take care of that.
Also, in order to keep backward compatibility with the first version of this
library, file names can be entered as UPPERCASE string of 11 bytes in length
with no dot character between file name and extension (i.e. "MIKROELETXT" -
> MIKROELE.TXT). In this case the last 3 characters of the string are consid-
ered to be file extension.

- file attr: file creation and attributs flags. Each bit corresponds to the appro-
priate file attribut:

284 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6

mikroPASCAL PRO for AVR Libraries

Bit | Mask Description
0 0x01 |Read Only
1 0x02 |Hidden
2 0x04 [System

Description 3 0x08 [Volume Label
4 0x10 |[Subdirectory
5 0x20 [Archive
6 0x40 [Device (internal use only, never found on disk)
7 0x80 [Not used

Note: Long File Names (LFN) are not supported.

MMC/SD card and MMC library must be initialized for file operations. See

Requires Mmc_Fat_Init.
/)= ————— Try to create a swap file with archive atribute,
whose size will be at least 1000 sectors.
// If it succeeds, it sends No. of start sector
over USART
var size : dword;
size := Mmc Fat Get Swap File (1000, 'mikroE.txt', 0x20);
if (size <> 0) then
Example beqi
egin
UART17WILLG(OXAA
UART1 Write(Lo(size));
UART1 Write (Hi(size));
UART1 Write (Higher (size));
UART1 Write (Highest (size));
UART17WILLG(OXAA
end;
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Library Example

The following example demonstrates MMC library test. Upon flashing, insert a
MMC/SD card into the module, when you should receive the "Init-OK" message.
Then, you can experiment with MMC read and write functions, and observe the
results through the Usart Terminal.

// if defined, we have a debug messages on PC terminal
program MMC Test;

{ SDEFINE RS232 debug}

var MMC chip select : sbit at PORTB.B2Z;
var MMC chip select direction : sbit at DDRB.B2;

// universal variables
var k, 1 : word; // universal for loops and other stuff

// Variables for MMC routines

dData : arrayl 512] of byte;// Buffer for MMC sector reading/writing
data for registers : arrayl 16] of byte; // buffer for CID and CSD

registers

// Display byte in hex

procedure printhex (i : byte) ;
var bHi, bLo : byte;
begin
bHi := i and OxFO0; // High nibble
bHi := bHi shr 4;
bHi := DbHi + '0';
if (bHi>'9') then
bHi := DbHi + 7;
bLo := (i and 0x0F) + '0'; // Low nibble
if (bLo>'9') then
bLo := bLo+7;

UART1 Write (bHi);
UART1 Write (bLo) ;

end;

begin
DDRC := 255;
PORTC := 0;

{ SIFDEF RS232_ debug}
UART1 Init (19200);

{ SENDIEF}

Delay ms (10);
DDRA := 255;
PORTA := 1;
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{ SIFDEF RSZ32_debug}
UART1 Write Text ('PIC-Started'); // If PIC present report
UART1 Write(13);
UART1 Write (10);

{ SENDIF}

// Before all, we must initialize a MMC card

SPI1 Init Advanced( SPI MASTER, SPI FCY DIV2, SPI CLK LO_ LEAD-
ING) ;

Spi Rd Ptr := @SPI1 Read;

i := Mmc Init();
PORTC := 1i;
{ SIFDEF RSZ32_debug}
if(i = 0) then
begin
UART1 Write Text ('MMC Init-OK'); // If MMC present report
UART1 Write(13);
UART1 Write (10);
end;
if (i) then
begin
UART1 Write Text ('MMC Init-error'); // If error report
UART1 Write(13);
UART1 Write (10);
end;
{ SENDIF}

for 1:=0 to 511 do
dbatal 1] := 'E'; // Fill MMC buffer with same characters
1 := Mmc Write Sector (55, dbata);

{ SIFDEF RSZ32_debug}
if(i = 0) then
UART1 Write Text ('Write-OK')
else // if there are errors.....
UARTl_Write_Text('Write—Error');
UART1 Write(13);
UART1 Write (10);

{ SENDIF}

// Reading of CID and CSD register on MMC card.....
{ SIFDEF RS232 debug}

i := Mmc Read Cid(data for registers);

if(i = 0) then

begin
for k:=0 to 15 do
begin
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printhex(data for registers[ k] );
if(k <> 15) then
UART1 Write('-');
end;
UART1 Write(13);
end
else
begin
UART1 Write Text ('CID-error');
end;
i := Mmc Read Csd(data for registers);
if(i = 0) then
begin
for k:=0 to 15 do
begin
printhex(data for registers[ k]);
if(k <> 15) then
UART1 Write('-');
end;
UART1 Write(13);
UART1 Write (10);
end
else
begin
UART1 Write Text ('CSD-error');
end;
{ SENDIF}
end.

Next example consists of several blocks that demonstrate various aspects of usage
of the Mmc_Fat16 library, creation of new file and writing down to it, opening exist-
ing file and re-writing it, opening existing file and appending data to it, opening a file
and reading data it, creating and modifying several files at once, reading file con-
tents, deleting file(s) and creating the swap file.

Program MMC FAT Test;
var

Mmc Chip Select : sbit at PORTG.B1;
Mmc Chip Select Direction : sbit at DDRG.BI1;

var

FAT TXT : stringl 20] ;

file contents : stringl 50] ;

filename : stringl 14]; // File names
character : byte;

loop, loop2 : byte;
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size : longint;

buffer : arrayl 512] of byte;

[/ ——mm Writes string to USART
procedure Write Str(var ostr: arrayl 2] of byte);
var

i : byte;
begin

i = 0;

while ostr[ 1] <> 0 do begin
UART1 Write (ostr[ i]);

Inc (i)
end;
UART1 Write ($0A);
end;//~
[/———————————— Creates new file and writes some data to it
procedure Create New File;
begin
filename[ 7] := 'A'; // Set filename for single-file tests
Mmc Fat Assign(filename, O0xA0Q); // Will not find file and then
create file
Mmc Fat Rewrite; // To clear file and start with new data
for loop:=1 to 99 do // We want 5 files on the MMC card
begin
UART1 Write('.');
file contents[ 0] := loop div 10 + 48;
file contents[ 1] := loop mod 10 + 48;
Mmc Fat Write(file contents, 42); // write data to the
assigned file
end;
end;//~
[/ =—mmmm—m——————— Creates many new files and writes data to them
procedure Create Multiple Files;
begin
for loop2 := 'B' to 'Z' do
begin
UART1 Write(loop2);// this line can slow down the performance
filename[ 7] := loop2; // set filename
Mmc Fat Assign(filename, OxA0); // find existing file or
create a new one
Mmc Fat Rewrite; // To clear file and start with new data
for loop := 1 to 44 do
begin
file contents[ 0] := byte(loop div 10 + 48);
file contents[ 1] := byte(loop mod 10 + 48);
end;
end;
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end;//~
/) == Opens an existing file and rewrites it
procedure Open File Rewrite;
begin
filename[ 7] := 'C'; // Set filename for single-file tests

Mmc Fat Assign(filename, O0);
Mmc Fat Rewrite;

for loop := 1 to 55 do
begin
file contents[ 0] := byte(loop div 10 + 48);
file contents[ 1] := byte(loop mod 10 + 48);
Mmc Fat Write(file contents, 42); // write data to the assigned file
end;
end;//~
[/ —mmm Opens an existing file and appends data to it
// (and alters the date/time stamp)
procedure Open File Append;
begin
filename[ 7] := 'B';

Mmc Fat Assign(filename, O);
Mmc Fat Set File Date(2005,6,21,10,35,0);

Mmc Fat Append(); // Prepare file for append

file contents := ' for mikroElektronika 2007'; // Prepare file
for append

file contents[ 26] := 10; // LF

Mmc Fat Write(file contents, 27); // Write data to assigned file
end;//~
[)=—mmmm————————— Opens an existing file, reads data from it and puts

it to USART
procedure Open File Read;

begin
filename[ 7] := 'B';
Mmc Fat Assign(filename, 0);
Mmc Fat Reset (size); // To read file, procedure

returns size of file
while size > 0 do

begin
Mmc Fat Read(character);
UART1 Write (character); // Write data to USART
Dec (size) ;
end;
end;//~
[ —mmmm—m———————— Deletes a file. If file doesn't exist, it will first
be created
// and then deleted.
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procedure Delete File;
begin
filenamel 7] := 'F';

Mmc Fat Assign(filename, 0);
Mmc Fat Delete;

end;//~

/) ==mmm———————— Tests whether file exists, and if so sends its cre-
ation date

// and file size via USART

procedure Test File Exist;

var

fsize: longint;

year: word;

month, day, hour, minute: byte;
outstr: arrayl 12] of byte;

begin
filenamel 7] := 'B';
if Mmc Fat Assign(filename, 0) <> 0 then begin
//--- file has been found - get its date

Mmc Fat Get File Date(year,month,day,hour,minute);
WordToStr (year, outstr);
Write_Str(outstr);

ByteToStr (month, outstr);
Write_Str(outstr);

WordToStr (day, outstr);
Write_Str(outstr);

WordToStr (hour, outstr);
Write_Str(outstr);

WordToStr (minute, outstr);
Write_Str(outstr);

//--- get file size

fsize := Mmc Fat Get File Size;
LongIntToStr (fsize, outstr);
Write Str(outstr);

end
else begin
//--- file was not found - signal it

UART1 Write (0x55);
Delay ms(1000) ;
UART1 Write (0x55);

end;
end;//~
[/ =—mmm—m——————— Tries to create a swap file, whose size will be at
least 100
// sectors (see Help for details)
procedure M Create Swap File() ;
var 1 : word;
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begin
for i:=0 to 511 do
Buffer[ 1] := 1i;
size := Mmc Fat Get Swap File (5000, 'mikroE.txt', 0x20); // see

help on this function for details

if (size <> 0) then
begin
LongIntToStr (size, fat txt);
UART1 Write Text (fat txt);

for i:=0 to 4999 do

begin
Mmc Write Sector(size, Buffer);
size := size + 1;
UART1 Write('.');
end;
end;
end;
/) ———————————— Main. Uncomment the function(s) to test the desired
operation (s)
begin
FAT TXT := 'FAT16 not found';
file contents := 'XX MMC/SD FAT16 library by Anton Rieckert#';
file contents[ 41] := 10; // newline
filename := 'MIKROOOXTXT';

// we will use PORTC to signal test end
DDRC := OxFF;
PORTC := O0;
UART1 Init (19200);
//delay ms (100) ; // Set up USART for file reading
UART1 Write Text ('Start');
//--- Init the FAT library
SPI1 Init Advanced( SPI MASTER, SPI FCY DIV128, SPI CLK LO LEAD-
ING) ;
Spi Rd Ptr := @SPI1 Read;
// use fatl6 quick format instead of init routine if a formatting is
needed
if Mmc Fat Init() = 0 then begin
PORTC := 0xFO;
// reinitialize spi at higher speed
SPI1 Init Advanced( SPI MASTER, _SPI FCY DIV2,
_SPI_CLK_LO LEADING) ;
//--- signal start-of-test
//--- test functions
Create New File;
Create Multiple Files;
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Open File Rewrite;
Open File Append;
Open File Read;
Delete File;

Test File Exist;
M Create Swap File();
UART1 Write('e');

end
else
begin
UART1 Write Text (FAT TXT);
end;
//--- signal end-of-test
PORTC = SOF;

UART1 Write Text ('End'");
end.
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HW Connection
SPI-MISD

MMC-CS#
SPI-MOSI

5PI-5CK

VCC3
2Kz| |2K2 [] 2Kz

anoononnoooooono

Pin diagram of MMC memory card
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ONEWIRE LIBRARY

The OneWire library provides routines for communication via the Dallas OneWire
protocol, e.g. with DS18x20 digital thermometer. OneWire is a Master/Slave proto-
col, and all communication cabling required is a single wire. OneWire enabled
devices should have open collector drivers (with single pull-up resistor) on the
shared data line.

Slave devices on the OneWire bus can even get their power supply from data line.
For detailed schematic see device datasheet.

Some basic characteristics of this protocol are:

- single master system,

- low cost,

- low transfer rates (up to 16 kbps),

- fairly long distances (up to 300 meters),
- small data transfer packages.

Each OneWire device has also a unique 64-bit registration number (8-bit device
type, 48-bit serial number and 8-bit CRC), so multiple slaves can co-exist on the
same bus.

Note: Oscillator frequency Fosc needs to be at least 8MHz in order to use the rou-
tines with Dallas digital thermometers.

External dependencies of OneWire Library

The following variables
must be defined in all

. : . Description: Example :
projects using OneWire P P
Library :
var OW Bit Read : OneWire read line var OW Bit Read :
sbit; sfr; external; ' sbit at PINB.B2;

var OW Bit Write : OneWire write line var OW Bit Write :
sbit; sfr; external; ) sbit at PORTB.B2;

var OW Bit Direction : Direction of the OneWire var OW Bit Direction
sbit; sfr; external; pin_ : sbit at DDRB.B2;

Library Routines

- Ow_Reset
- Ow_Read
- Ow_Write
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Ow_Reset

Prototype function Ow Reset (): word;

- 0 if the device is present
- 1 if the device is not present

Issues OneWire reset signal for DS18x20.

Returns

Description |Parameters :

- None.
Devices compliant with the Dallas OneWire protocol.

Global variables :

Requires -oW Bit Read: OneWire read line

-ow Bit write: OneWire write line.

-0W Bit Direction: Direction of the OneWire pin

must be defined before using this function.

// OneWire pinout

var OW Bit Read : sbit at PINB.B2;

var OW Bit Write : sbit at PORTB.B2;

E I var OW Bit Direction : sbit at DDRB.B2;
xample // end of OneWire pinout

// Issue Reset signal on One-Wire Bus

Ow_Reset () ;
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Ow_Read

Prototype

function Ow Read(): byte;

Returns

Data read from an external device over the OneWire bus.

Description

Reads one byte of data via the OneWire bus.

Requires

Devices compliant with the Dallas OneWire protocol.
Global variables :

-oW Bit Read: OneWire read line

-ow Bit write: OneWire write line.

-0oW Bit Direction: Direction of the OneWire pin

must be defined before using this function.

Example

// OneWire pinout

var OW Bit Read : sbit at PINB.B2;

var OW Bit Write : sbit at PORTB.B2;
var OW Bit Direction : sbit at DDRB.B2;
// end of OneWire pinout

// Read a byte from the One-Wire Bus
var read data : byte;

read data := Ow _Read():;

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 297



CHAPTER 6
Libraries mikroPASCAL PRO for AVR

Ow_Write

Prototype |procedure Ow Write (par: byte);

Returns Nothing.

Writes one byte of data via the OneWire bus.
Description |Parameters :

- par: data to be written

Devices compliant with the Dallas OneWire protocol.
Global variables :

Requires - 0w Bit RrRead: OneWire read line
-ow Bit wWrite: OneWire write line.
- 0w Bit Direction: Direction of the OneWire pin

must be defined before using this function.

// OneWire pinout

var OW Bit Read : sbit at PINB.B2;

var OW Bit Write : sbit at PORTB.B2;
var OW Bit Direction : sbit at DDRB.B2;
// end of OneWire pinout

Example

// Send a byte to the One-Wire Bus
Ow Write (0xCC) ;

Library Example

This example reads the temperature using DS18x20 connected to pin PORTB.2. After reset,
MCU obtains temperature from the sensor and prints it on the Lcd. Make sure to pull-up PORTB.2
line and to turn off the PORTB leds.

program OneWire;

// Lcd module connections

var LCD RS : sbit at PORTD.B2;
LCD EN : sbit at PORTD.B3;
LCD D4 : sbit at PORTD.B4;
LCD D5 : sbit at PORTD.BS;
LCD D6 : sbit at PORTD.B6;
LCD D7 : sbit at PORTD.B7;
LCDiRsiDirection : sbit at DDRD.B2;
LCD EN Direction : sbit at DDRD.B3;
LCD D4 Direction : sbit at DDRD.B4;
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LCD D5 Direction : sbit at DDRD.B5;
LCD D6 Direction : sbit at DDRD.B6;
LCD D7 Direction : sbit at DDRD.B7;
// End Lcd module connections

// OneWire pinout
var OW Bit Write : sbit at PORTB.B2;
OWw Bit Read : sbit at PINB.B2;
OWw Bit Direction : sbit at DDRB.B2Z;
// end OneWire definition

// Set TEMP RESOLUTION to the corresponding resolution of used
DS18x20 sensor:

// 18S20: 9 (default setting; can be 9,10,11,or 12)

// 18B20: 12

const TEMP RESOLUTION : byte = 9;

var text : arrayl 9] of byte;
temp : word;

procedure Display Temperature( temp2write : word );
const RES SHIFT = TEMP RESOLUTION - 8;

var temp whole : byte;

temp fraction : word;
begin
text := '000.0000"';

// check if temperature is negative
if (temp2write and 0x8000) then
begin
text[ 0] := '-=-';
temp2write := not temp2write + 1;
end;

// extract temp whole
temp whole := word(tempZwrite shr RES SHIFT);

// convert temp whole to characters
if ( temp whole div 100 ) then

text[ 0] := temp whole div 100 + 48
else
text[ 0] := '0';
text[ 1] := (temp whole div 10)mod 10 + 48; // Extract tens digit
text[ 2] := temp whole mod 10 + 48;

// extract temp fraction and convert it to unsigned int
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temp fraction
temp fraction
temp fraction

word (temp2write shl (4-RES SHIFT));
temp fraction and 0x000F;
temp fraction * 625;

// convert temp fraction to characters

text[ 4] := word(temp fraction div 1000) + 48; //
Extract thousands digit

text[ 5] := word((temp fraction div 100)mod 10 + 48); //
Extract hundreds digit

text[ 6] := word((temp fraction div 10)moed 10 + 48); //
Extract tens digit

text[ 7] := word(temp fraction mod 10) + 48; //

Extract ones digit

// print temperature on Lcd
Lcd Out (2, 5, text);

end;
begin
text := '000.0000';
UART1 Init (9600);
Led Init () // Initialize Lcd
Led Cmd (LCD_CLEAR) ; // Clear Lcd
Lcd Cmd (LCD_CURSOR_OFF) ; // Turn cursor off
Led Out(l, 1, ' Temperature: ")
// Print degree character, 'C' for Centigrades
Led Chr(2,13,223); // different Lcd displays have different char

code for degree
// 1if you see greek alpha letter try typing
178 instead of 223
Lcd Chr(2,14,'C');

//--- main loop
while (TRUE) do
begin
//--- perform temperature reading
Ow_Reset(); // Onewire reset signal
Ow Write (0xCC); // Issue command SKIP ROM
Ow_Write (0x44); // Issue command CONVERT T
(

Delay us(120);

Ow Reset ()
Ow Write (0xCC); // Issue command SKIP ROM
Ow_Write (0xBE) ; // Issue command READ SCRATCHPAD
temp := Ow Read();
temp := (Ow_Read() shl 8) + temp;

//--- Format and display result on Lcd
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Display Temperature (temp) ;
Delay ms (520);

end;
end.

HW Connection

125°C

-50°C

d

FB2

e N e B e s s e s e

{eled
GND

GND

]
£

9LVOINLY

PD.2
PD3
PD4
PD&

T e e e e ey

LT

9IND

LCD ZX16

Example of DS1820 connection
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Port Expander Library

The mikroPascal PRO for AVR provides a library for communication with the Microchip’s
Port Expander MCP23S17 via SPI interface. Connections of the AVR compliant MCU and
MCP23S17 is given on the schematic at the bottom of this page.

Note: Library uses the SPI module for communication. The user must initialize SPI
module before using the Port Expander Library.

Note: Prior to calling any of this library routines, Spi_Rd_Ptr needs to be initialized
with the appropriate SPI_Read routine.

Note: Library does not use Port Expander interrupts.

External dependencies of Port Expander Library

The following variables
must be defined in all
projects using Port
Expander Library:

Description: Example :

var SPExpanderRST : Reset line var SPExpanderRST :
sbit; sfr; external; ’ sbit at PORTB.BO;

var SPExpanderCS :
sbit; sfr; external;

var SPExpanderCS

Chip Select line. sbit at PORTB.BI;

var
SPExpanderCS Directio
n : sbit; sfr;

var

Direction of the Reset pin. [SPExpanderRST Directi
on : sbit at DDRB.BO;

external;

var var

SPExpanderCS Directio |Direction of the Chip . .

N : sbit: sfr: Select pi SPExpanderCS Directio
) ! ’ elect pin. n : sbit at DDRB.BI1;

external;

Library Routines

- Expander_Init

- Expander_Read_Byte

- Expander_Write_Byte

- Expander_Read_PortA
- Expander_Read PortB
- Expander_Read_PortAB
- Expander_Write_PortA
- Expander_Write_PortB

- Expander_Write_PortAB
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- Expander_Set_DirectionPortA
- Expander_Set DirectionPortB
- Expander_Set_DirectionPortAB
- Expander_Set PullUpsPortA

- Expander_Set PullUpsPortB

- Expander_Set PullUpsPortAB

Expander_lInit

Prototype procedure Expander Init (ModuleAddress : byte);

Returns Nothing.

Initializes Port Expander using SPI communication.
Port Expander module settings :

- hardware addressing enabled

- automatic address pointer incrementing disabled (byte mode)
Description |- BANK_0 register adressing

- slew rate enabled

Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the bot-
tom of this page

Global variables :

- sPExpandercs: Chip Select line

- sPExpanderRST: Reset line

Requires - SPExpanderCS Direction: Direction of the Chip Select pin
- SPExpanderRST Direction:! Direction of the Reset pin

must be defined before using this function.

SPI module needs to be initialized. See SPI1_Init and SPI1_Init Advanced routines.

// Port Expander module connections

var SPExpanderCS : sbit at PORTB.B1;
SPExpanderRST : sbit at PORTB.BO;
SPExpanderCS Direction : sbit at DDRB.B1;
SPExpanderRST Direction : sbit at DDRB.BO;
Example // End of Port Expander module connections
SPI1 Init():; // initialize SPI module
Spi Rd Ptr := (@SPI1 Read; // Pass pointer to SPI Read function
of used SPI module
Expander Init (0); // initialize port expander
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Expander_Read_Byte

function Expander Read Byte (ModuleAddress : byte; RegAddress

PrOtOtype byte) : byte;

Returns Byte read.
The function reads byte from Port Expander.
Parameters :

Description

- ModuleAddress: Port Expander hardware address, see schematic at the bot-
tom of this page
- RegAddress: Port Expander's internal register address

Requires Port Expander must be initialized. See Expander_lnit.

// Read a byte from Port Expander's register

var read data : byte;
Example — ’

read data := Expander Read Byte(0,1);

Expander_Write_Byte

procedure Expander Write Byte (ModuleAddress: byte; RegAddress:

PrOtOtype byte; Data : byte);

Returns Nothing.
Routine writes a byte to Port Expander.
Parameters :

Description

- ModuleAddress: Port Expander hardware address, see schematic at the bot
tom of this page

- Regiddress: Port Expander's internal register address

- Data : data to be written

Requires Port Expander must be initialized. See Expander_lnit.

rite a byte to e Por xpander's register
// Writ yte to the Port Expander' gist

Example Expander Write Byte (0,1, 0xFF);
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Expander_Read_PortA

Prototype

function Expander Read PortA (ModuleAddress: byte): byte;

Returns

Byte read.

Description

The function reads byte from Port Expander's PortA.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the bot
tom of this page

Requires

Port Expander must be initialized. See Expander_Init.

Port Expander's PortA should be configured as input. See Expander_Set_Direc-
tionPortA and Expander_Set_DirectionPortAB routines.

Example

// Read a byte from Port Expander's PORTA
var read data : byte;

Expander Set DirectionPortA(0,0xFF); // set expander's
porta to be input

read data := Expander Read PortA(0);

Expander_Read_PortB

Prototype

function Expander Read PortB (ModuleAddress: byte): byte;

Returns

Byte read.

Description

The function reads byte from Port Expander's PortB.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the bot-
tom of this page

Requires

Port Expander must be initialized. See Expander_Init.

Port Expander's PortB should be configured as input. See Expander_Set_Direc-
tionPortB and Expander_Set_DirectionPortAB routines.

Example

// Read a byte from Port Expander's PORTB
var read data : byte;

Expander Set DirectionPortB(0,0xFF); // set expander's
portb to be input

read data := Expander Read PortB(0);
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Expander_Read_PortAB

Prokﬂype function Expander Read PortAB (ModuleAddress: byte): word;

Returns Word read.

The function reads word from Port Expander's ports. PortA readings are in the
higher byte of the result. PortB readings are in the lower byte of the result.

Description |[Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the bot-
tom of this page

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortA and PortB should be configured as inputs. See
Expander_Set_DirectionPortA, Expander_Set_DirectionPortB and
Expander_Set_DirectionPortAB routines.

// Read a byte from Port Expander's PORTA and PORTB
var read data : word;

Example Expander Set DirectionPortAB (0, OxFFFF); // set expander's
porta and portb to be input

read data := Expander Read PortAB(O0);

Expander_Write_PortA

Prokﬂype procedure Expander Write PortA(ModuleAddress: byte; Data : byte);

Returns Nothing.

The function writes byte to Port Expander's PortA.

Parameters :

Description - ModuleAddress: Port Expander hardware address, see schematic at the bot-

tom of this page
- Data : data to be written

Port Expander must be initialized. See Expander_lnit.

Requires Port Expander's PortA should be configured as output. See
Expander_Set DirectionPortA and Expander_Set_DirectionPortAB routines.
// Write a byte to Port Expander's PORTA

Exannﬂe Expander Set DirectionPortA(0,0x00); // set expander's

porta to be output

Expander Write PortA (0, OxAA);
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Expander_Write_PortB

Prokﬂype procedure Expander Write PortB(ModuleAddress: byte; Data : byte);

Returns Nothing.

The function writes byte to Port Expander's PortB.

Parameters :

Description .
- ModuleAddress: Port Expander hardware address, see schematic at the bot

tom of this page
- Data :data to be written

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortB should be configured as output. See
Expander_Set_DirectionPortB and Expander_Set_DirectionPortAB routines.
// Write a byte to Port Expander's PORTB

Example Expander Set DirectionPortB(0,0x00); // set expander's

portb to be output

Expander Write PortB(0, 0x55);
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Expander_Write_PortAB

Prokﬂype procedure Expander Write PortAB (ModuleAddress: byte; Data :

word) ;

Returns Nothing.
The function writes word to Port Expander's ports.
Parameters :

Description

- ModuleAddress: Port Expander hardware address, see schematic at the bot
tom of this page

- Data : data to be written. Data to be written to PortA are passed in Data's
higher byte. Data to be written to PortB are passed in Data's lower byte

Port Expander must be initialized. See Expander_Init.

Requires Port Expander's PortA and PortB should be configured as outputs. See
Expander_Set DirectionPortA, Expander_Set DirectionPortB and
Expander_Set DirectionPortAB routines.

// Write a byte to Port Expander's PORTA and PORTB

Example Expander Set DirectionPortAB(0,0x0000) ; // set expander's
porta and portb to be output

Expander Write PortAB (0, O0xAA55);

Expander_Set_DirectionPortA

procedure Expander Set DirectionPortA (ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortA direction.

Parameters :

Description |” ModuleAddress: Port Expander hardware address, see schematic at the bot
tom of this page

- Data : data to be written to the PortA direction register. Each bit corresponds
to the appropriate pin of the PortA register. Set bit designates corresponding
pin as input. Cleared bit designates corresponding pin as output.

Requires Port Expander must be initialized. See Expander_|nit.

// Set Port Expander's PORTA to be output

Example Expander Set DirectionPortA(0,0x00);
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Expander_Set_DirectionPortB

procedure Expander Set DirectionPortB(ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortB direction.
Parameters :

Description |- Modulerddress: Port Expander hardware address, see schematic at the bot
tom of this page

- Data : data to be written to the PortB direction register. Each bit corresponds
to the appropriate pin of the PortB register. Set bit designates corresponding
pin as input. Cleared bit designates corresponding pin as output.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTB to be input

Exan“ﬂe ExpanderiSethirectionPortR(0,0xFP);

Expander_Set_DirectionPortAB

procedure Expander Set DirectionPortAB (ModuleAddress: byte;

PrOtOtype Direction: word);
Returns Nothing.
The function sets Port Expander's PortA and PortB direction.
Parameters :
- ModuleAddress: Port Expander hardware address, see schematic at the bot-
e tom of this page
Description

- Direction: data to be written to direction registers. Data to be written to the
PortA direction register are passed in birection's higher byte. Data to be
written to the PortB direction register are passed in birection's lower byte.
Eachbit corresponds to the appropriate pin of the PortA/PortB register. Set bit
designates corresponding pin as input. Cleared bit designates corresponding
pin as output.

Requires Port Expander must be initialized. See Expander_lnit.

// Set Port Expander's PORTA to be output and PORTB to be input

Example Expander Set DirectionPortAB(0,0x00FF);
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Expander_Set_PullUpsPortA

procedure Expander Set PullUpsPortA (ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortA pull up/down resistors.
Parameters :

Description |- Moduleaddress: Port Expander hardware address, see schematic at the bot
tom of this page

- bata : data for choosing pull up/down resistors configuration. Each bit corre
sponds to the appropriate pin of the PortA register. Set bit enables pull-up for
corresponding pin.

Requires Port Expander must be initialized. See Expander_Init.

// Set Port Expander's PORTA pull-up resistors

Example Expander Set PullUpsPortA (0, OxFF);

Expander_Set_PullUpsPortB

procedure Expander Set PullUpsPortB (ModuleAddress: byte; Data :

Prototype byte) ;

Returns Nothing.

The function sets Port Expander's PortB pull up/down resistors.
Parameters :

Description |- ModuleaAddress: Port Expander hardware address, see schematic at the bot
tom of this page

- pata : data for choosing pull up/down resistors configuration. Each bit corre
sponds to the appropriate pin of the PortB register. Set bit enables pull-up for
corresponding pin.

Requires Port Expander must be initialized. See Expander_|nit.

// Set Port Expander's PORTB pull-up resistors

Exan“ﬂe Expander Set PullUpsPortB (0, OxFF);
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Expander_Set_PullUpsPortAB

procedure Expander Set PullUpsPortAB (ModuleAddress: byte;

Prototype PullUps: word);

Returns Nothing.

The function sets Port Expander's PortA and PortB pull up/down resistors.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic at the bot

Description | tom of this page

- pullups: data for choosing pull up/down resistors configuration. PortA pull
up/down resistors configuration is passed in PullUps's higher byte. PortB pull
up/down resistors configuration is passed in PullUps's lower byte. Each bit cor
responds to the appropriate pin of the PortA/PortB register. Set bit enables
pull-up for corresponding pin.

Requires Port Expander must be initialized. See Expander_lnit.

// Set Port Expander's PORTA and PORTB pull-up resistors

Example Expander Set PullUpsPortAB (0, OxFFFF);

Library Example
The example demonstrates how to communicate with Port Expander MCP23S17.

Note that Port Expander pins A2 A1 A0 are connected to GND so Port Expander Hardware
Address is 0.

program PortExpander;

// Port Expander module connections
var SPExpanderRST : sbit at PORTB.BO;

SPExpanderCS : sbit at PORTB.B1;
SPExpanderRST Direction : sbit at DDRB.BO;
SPExpanderCS Direction : sbit at DDRB.B1;

// End Port Expander module connections

var counter : byte;// = 0;
begin
counter := 0;
DDRC := OxFF; // Set PORTC as output

// If Port Expander Library uses SPI1 module
SPI1 Init(); // Initialize SPI module used with PortExpander
Spi Rd Ptr := @SPI1 Read// Pass pointer to SPI Read function of used SPI module
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// // 1f Port Expander Library uses SPI2 module
// SPI2 Init(); // Initialize SPI module wused with
PortExpander
// Spi Rd Ptr := @SPI2 Read; // Pass pointer to SPI Read function

of used SPI module

Expander Init (0); // Initialize Port Expander

Expander Set DirectionPortA (0, 0x00); // Set Expander's PORTA to
be output

Expander Set DirectionPortB(0,0xFF); // Set Expander's PORTB to
be input

Expander Set PullUpsPortB (0, 0xFF); // Set pull-ups to all of

the Expander's PORTB pins

while ( TRUE ) do // Endless loop
begin
Expander Write PortA(0, counter); // Write i to expander's
PORTA

Inc (counter) ;
PORTC := Expander Read PortB(0); // Read expander's PORTB
and write it to LEDs
Delay ms (100);
end;

end.
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HW Connection
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PS/2 LIBRARY

The mikroPascal PRO for AVR provides a library for communication with the com-
mon PS/2 keyboard.

Note: The library does not utilize interrupts for data retrieval, and requires the oscil-
lator clock to be at least 6MHz.

Note: The pins to which a PS/2 keyboard is attached should be connected to the
pull-up resistors.

Note: Although PS/2 is a two-way communication bus, this library does not provide
MCU-to-keyboard communication; e.g. pressing the Caps Lock key will not turn on
the Caps Lock LED.

External dependencies of PS/2 Library

The following variables
must be defined in all
projects using PS/2

Library:
var PS2 Data :

Description: Example :

sbit; var PS2 Data : sbit

PS/2 Data line.

sfr; external;

at PINC.BO;

var PS2 In Clock :
sbit; sfr; external;

PS/2 Clock line in.

var PS2 In Clock :
sbit at PINC.B1l;

var PS2 Out Clock :
sbit; sfr; external;

PS/2 Clock line out.

var PS2 Out Clock :
sbit at PORTC.BI1;

var
PS2 Data Direction :
sbit; sfr; external;

Direction of the PS/2 Data
pin.

var
PS2 Data Direction :
sbit at DDRC.BO;

var
PS2 Clock Direction :

sbit; sfr; external;

Direction of the PS/2
Clock pin.

var
PS2 Clock Direction :
sbit at DDRC.B1;

Library Routines

- Ps2_Config
- Ps2_Key_Read
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Ps2_Config

Prototype

procedure Ps2 Config();

Returns

Nothing.

Description

Initializes the MCU for work with the PS/2 keyboard.

Requires

Global variables :

- ps2 Dpata: Data signal line

- ps2 In Clock: Clock signal line in

- ps2 out Clock: Clock signal line out

- Ps2 Data Direction: Direction of the Data pin

- Ps2 Clock Direction: Direction of the Clock pin

must be defined before using this function.

Example

// PS2 pinout definition

var PS2 Data : sbit at PINC.BO;

var PS2 In Clock : sbit at PINC.BI;

var PS2 Out Clock : sbit at PORTC.BI;

var PS2 Data Direction : sbit at DDRC.BO;
var PS2 Clock Direction : sbit at DDRC.BI;
// End of PS2 pinout definition

Ps2 Config(); // Init PS/2 Keyboard
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Ps2_Key_Read

function Ps2 Key Read(var value: byte; var special: byte; var

Prototype pressed: byte): byte;

- 1 if reading of a key from the keyboard was successful

Returns - 0 if no key was pressed

The function retrieves information on key pressed.
Parameters :

- value: holds the value of the key pressed. For characters, numerals, punctua

Description | tion marks, and space value will store the appropriate ASCII code. Routine
“recognizes” the function of Shift and Caps Lock, and behaves appropriately.
For special function keys see Special Function Keys Table.
special: is a flag for special function keys (F1, Enter, Esc, etc). If key pressed
is one of these, special will be set to 1, otherwise 0.

- pressed: is set to 1 if the key is pressed, and 0 if it is released.

Requires PS/2 keyboard needs to be initialized. See Ps2_Config routine.

var value, special, pressed: byte;

// Press Enter to continue:

Example repeat
if (Ps2 Key Read(value, special, pressed)) then
if ((value = 13) and (special = 1)) then break;
until (0=1);

316 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroPASCAL PRO for AVR Libraries

Special Function Keys

Key Value returned Scroll Lock 28
F1 1 Num Lock 29
F2 2 Left Arrow 30
F3 3 Right Arrow 31
F4 4 Up Arrow 32
F5 5 Down Arrow 33
F6 6 Escape 34
F7 7 Tab 35
F8 8

F9 9

F10 10

F11 11

F12 12

Enter 13

Page Up 14

Page Down 15

Backspace 16

Insert 17

Delete 18

Windows 19

Ctrl 20

Shift 21

Alt 22

Print Screen 23

Pause 24

Caps Lock 25

End 26

Home 27
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Library Example

This simple example reads values of the pressed keys on the PS/2 keyboard and
sends them via UART.

program PS2 Example;

var keydata, special, down : byte;

var PS2 Data : sbit at PINC.BO;
PS2 Clock Input : sbit at PINC.BI;
PS2 Clock Output : sbit at PORTC.BI;
PS2 Data Direction : sbit at DDRC.BO;

PS2 Clock Direction : sbit at DDRC.BI1;

begin
UART1 Init(19200); // Initialize UART module at 19200 bps
Ps2 Config(); // Init PS/2 Keyboard
Delay ms (100); // Wait for keyboard to finish
UART1 Write('R'); ) // Ready
while TRUE do // Endless loop
begin
if Ps2 Key Read(keydata, special, down) then // If data
was read from PS/2
begin
if (down <> 0) and (keydata = 16) then // Backspace read
begin
UART1 Write (0x08); // Send
Backspace to USART terminal
end
else if (down <> 0) and (keydata = 13) then // Enter read
begin
UART1 Write(10); // Send
carriage return to usart terminal
UART1 Write(13); //
Uncomment this line if usart terminal also expects line feed
// for new line transition
end
else if (down <> 0) and (special = 0) and (keydata <>
0) then // Common key read
begin
UART1 Write (keydata); // Send key to usart terminal
end;
end;
Delay ms (10); // Debounce period
end;
end.
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HW Connection
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PWM LIBRARY

CMO module is available with a number of AVR MCUs. mikroPascal PRO for AVR
provides library which simplifies using PWM HW Module.

Note: For better understanding of PWM module it would be best to start with the exam-
ple provided in Examples folder of our mikroPascal PRO for AVR compiler. When you
select a MCU, mikroPascal PRO for AVR automatically loads the correct PWM library (or
libraries), which can be verified by looking at the Library Manager. PWM library handles
and initializes the PWM module on the given AVR MCU, but it is up to user to set the
correct pins as PWM output. This topic will be covered later in this section. mikroPascal
PRO for AVR does not support enhanced PWM modules.

Library Routines

- PWM_Init

- PWM_Set_Duty
- PWM_Start

- PWM_Stop

- PWM1_Init

- PWM1_Set_Duty
- PWM1_Start

- PWM1_Stop

Predefined constants used in PWM library

The following variables are used

in PWM library functions: Description:

Selects Phase Correct PWM mode on first
PWM library.

Selects Phase Correct PWM mode on second
PWM library (if it exists in Library Manager.

_PWM_PHASE CORRECT MODE

_PWM1 PHASE CORRECT MODE

_PWM_ FAST MODE Selects Fast PWM mode on first PWM library.

Selects Fast PWM mode on second PWM
library (if it exists in Library Manager.

_PWM1 FAST MODE

_PWM_PRESCALER 1 Sets prescaler value to 1 (No prescaling).

_PWM_PRESCALER 8 Sets prescaler value to 8.

Sets prescaler value to 32 (this value is not
available on every MCU. Please use Code
Assistant to see if this value is available for
the given MCU.

_PWM_PRESCALER 32

320
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_PWM_PRESCALER 64 Sets prescaler value to 64.

Sets prescaler value to 128 (this value is
not available on every MCU. Please use
Code Assistant to see if this value is avail-
able for the given MCU.

_PWM_PRESCALER 256 Sets prescaler value to 256.

_PWM PRESCALER 128

_PWM_PRESCALER 1024 Sets prescaler value to 1024.

Sets prescaler value to 1 on second PWM

—FWM1_PRESCALER_1 library (if it exists in Library Manager).

Sets prescaler value to 8 on second PWM

_FWMl_PRESCALER_8 library (if it exists in Library Manager).

Sets prescaler value to 32 on second PWM
library (if it exists in Library Manager). This
_PWM1 PRESCALER_ 32 value is not available on every MCU. Please
use Code Assistant to see if this value is avail-
able for the given MCU.

Sets prescaler value to 64 on second PWM
library (if it exists in Library Manager).

_PWM1 PRESCALER 64

Sets prescaler value to 128 on second
PWM library (if it exists in Library Manager).
_PWM1 PRESCALER 128 This value is not available on every MCU.
Please use Code Assistant to see if this
value is available for the given MCU.

Sets prescaler value to 256 on second

—FWMI_PRESCALER 236 PWM library (if it exists in Library Manager).

Sets prescaler value to 1024 on second

—FWML_PRESCALER_1024 PWM library (if it exists in Library Manager).

_PWM_INVERTED Selects the inverted PWM mode.

Selects the inverted PWM mode on second
PWM library (if it exists in Library Manager).

Selects the normal (non inverted) PWM
mode.

_PWM1_INVERTED

_PWM_NON_INVERTED

Selects the normal (non inverted) PWM
_PWM1 NON_ INVERTED mode on second PWM library (if it exists in
Library Manager).
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Note: Not all of the MCUs have both PWM and PWM1 library included. Sometimes,
like its the case with ATmega8515, MCU has only PWM library. Therefore constants
that have in their name PWM1 are invalid (for ATmega8515) and will not be visible
from Code Assistant. It is highly advisable to use this feature, since it handles all the
constants (available) and eliminates any chance of typing error.
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PWM_Init
Prototype procedure PWM Init (wave mode : byte; prescaler : byte; inverted :

byte; duty : byte);

Returns Nothing.

Initializes the PWM module. Parameter wave_mode is a desired PWM mode.
There are two modes: Phase Correct and Fast PWM. Parameter prescaler
chooses prescale value N = 1,8,64,256 or 1024 (some modules support 32 and
128, but for this you will need to check the datasheet for the desired MCU).
Paremeter inverted is for choosing between inverted and non inverted PWM
signal. Parameter duty sets duty ratio from 0 to 255. PWM signal graphs and
formulas are shown below.

P H AS E f _ fclk ifo
MODE "M N.510
255 y . A~
Duty Ratio /N — AN
- | / \/ . 1 \\\\V/// 1 \\\
0 tF\I'\f"I Zt;’ﬁ'ﬂ 3t“Wl“ 4tl|"|fi"| Stl"ﬂ“ 6tIPWM ?tIPWH t
Mon Inverted
t
Description ] .
Inverted
t
FAST f _ fclk ifo
MODE TN 256
255 y
Duty Ratio L /
. // //
| s .

0 Ztv\fm Ztr?ﬁn 3t?wv 4tP'nv Est?wlv E6tPl\'M ?tpwn

Non Inverted

Inverted
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Description

The N variable represents the prescaler factor (1, 8, 64, 256, or 1024). Some
modules also support 32 and 128 prescaler value, but for this you will need to
check the datasheet for the desired MCU)

PWM_Init must be called before using other functions from PWM Library.

Requires

You need a CMO on the given MCU (that supports PWM).

Before calling this routine you must set the output pin for the PWM (according
to the datasheet):

DDRB.3 = 1; // set PORTB pin 3 as output for the PWM

This code example is for ATmega16, for different MCU please consult datasheet
for the correct pinout of the PWM module or modules.

Example

Initialize PWM module:

PWM Init (
127) ;

PwWM FAST MODE, PWM PRESCALER 8, PWM NON INVERTED,

PWM_Set_Duty

Prototype |procedure PWM Set Duty(duty : byte);
Returns Nothing.
Changes PWM duty ratio. Parameter duty takes values from 0 to 255, where 0
Description |is 0%, 127 is 50%, and 255 is 100% duty ratio. Other specific values for duty
ratio can be calculated as (percent*255) /100.
. PWM module must to be initialised (PWM_Init) before using PWM_Set_Duty
Requires .
function.
For example lets set duty ratio to 75%:
Example
PWM Set Duty(192);
PWM _Start
Prototype |procedure PWM Start();
Returns Nothing.
Description |Starts PWM
Reaqui MCU must have CMO module to use this library. PWM_Init must be called
equires : . ;
before using this routine.
Example PWM Start();
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PWM_Stop

Prototype |procedure PWM Stop();

Returns Nothing.

Description |Stops the PWM.
MCU must have CMO module to use this library. PWM_Init and PWM_Start

Requires must be called before using this routine using this routine, otherwise it will have
no effect as the PWM module is not running.

Example PWM_Stop () ;

Note: Not all the AVR MCUs support both PWM and PWM1 library. The best way to verify this is
by checking the datasheet for the desired MCU. Also you can check this by selecting a MCU in
mikroPascal PRO for AVR looking at the Library Manager. If library manager loads both PWM and
PWM1 library (you are able to check them) then this MCU supports both PWM libraries. Here you
can take full advantage of our Code Assistant and Parameter Assistant feature of our compiler.

PWM1_Init

Prototype

procedure PWMI Init (wave mode :

: byte; duty : byte);

byte; prescaler : byte; inverted

Returns

Nothing.

Description

Initializes the PWM module. Parameter wave_mode is a desired PWM mode.
There are two modes: Phase Correct and Fast PWM. Parameter prescaler
chooses prescale value N = 1,8,64,256 or 1024 (some modules support 32 and
128, but for this you will need to check the datasheet for the desired MCU).
Paremeter inverted is for choosing between inverted and non inverted PWM
signal. Parameter duty sets duty ratio from 0 to 255. PWM signal graphs and

formulas are shown below.
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The N variable represents the prescaler factor (1, 8, 64, 256, or 1024). Some
modules also support 32 and 128 prescaler value, but for this you will need to
check the datasheet for the desired MCU)

PWM1 _Init must be called before using other functions from PWM Library.

You need a CMO on the given MCU (that supports PWM).

Before calling this routine you must set the output pin for the PWM (according
Requires to the datasheet):

DDRB.7 = 1; // set PORTB pin 7 as output for the PWM1

This code cxample is for ATmega16 (second PWM module), for different MCU
please consult datasheet for the correct pinout of the PWM module or modules.

Initialize PWM module:

Example

PWMl Init( PWM1 FAST MODE, PWM1 PRESCALER 8, PWM1 NON INVERTED,127);

326 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6

mikroPASCAL PRO for AVR Libraries

PWM1_Set_Duty

Prototype procedure PWMl Set Duty(duty : byte);

Returns Nothing.
Changes PWM duty ratio. Parameter duty takes values from 0 to 255, where 0

Description |is 0%, 127 is 50%, and 255 is 100% duty ratio. Other specific values for duty
ratio can be calculated as (percent*255) /100.

Reaqui PWM module must to be initialised (PWM1_Init) before using PWM_Set Duty

equires :

function.
For example lets set duty ratio to 75%:

Example
PWM1 Set Duty(192);

PWM1_Start

Prototype |procedure PWMI1 Start();

Returns Nothing.

Description |Starts PWM.

. MCU must have CMO module to use this library. PWM?1_Init must be called

Requires . . ;
before using this routine.

Example PWM1l Start();

PWM1_Stop

Prototype |procedure PWMI1 Stop();

Returns Nothing.

Description |Stops the PWM.
MCU must have CMO module to use this library. PWM1_Init and PWM1_Start

Requires must be called before

q using this routine using this routine, otherwise it will have no effect as the PWM

module is not running.

Example PWM1_Stop () ;
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Library Example

The example changes PWM duty ratio on PB3 and PB7 pins continually. If LED is
connected to PB3 and PB7, you can observe the gradual change of emitted light.

program PWM Test;

var current duty : byte;
current dutyl : byte;

begin
DDRB.BO := 0; // Set PORTB pin 0 as input
DDRB.B1 := 0; // Set PORTB pin 1 as input
DDRC.BO := 0; // Set PORTC pin 0 as input
DDRC.B1 := 0; // Set PORTC pin 1 as input
current duty = 127; // initial value for current duty
current dutyl = 127; // initial value for current duty
DDRB.B3 := 1; // Set PORTB pin 3 as output pin
for the PWM (according to datasheet)
DDRD.B7 := 1; // Set PORTD pin 7 as output pin

for the PWM1 (according to datasheet)

PWM_TInit ( PWM PHASE CORRECT MODE, _PWM_PRESCALER 8§,
_PWM_NON_INVERTED, 127);

PWM1 Tnit( PWM1 PHASE CORRECT MODE, _PWM1_ PRESCALER 8,
_PWM1 NON_INVERTED, 127);

while TRUE do

begin
if (PINB.O <> 0) then
begin // Detect if PORTB pin 0 is pressed
Delay ms (40); // Small delay to avoid deboucing effect
Inc (current duty); // Increment duty ratio
PWM Set Duty(current duty); // Set incremented duty
end
else
if (PINB.1 <> 0) then // Detect if PORTB pin 1 is pressed
begin
Delay ms (40); // Small delay to avoid deboucing effect
Dec (current duty); // Decrement duty ratio
PWM Set Duty(current duty); // Set decremented

duty ratio
end
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else
if (PINC.0 <> 0) then // Detect if PORTC pin 0 is pressed
begin
Delay ms(40); // Small delay to avoid deboucing effect
Inc (current dutyl); // Increment duty ratio
PWM1 Set Duty (current dutyl); // Set incremented duty
end
else
if (PINC.1 <> 0) then // Detect if PORTC pin 1 is pressed
begin
Delay ms (40); // Small delay to
avoid deboucing effect
Dec (current dutyl); // Decrement duty ratio
PWM1 Set Duty (current dutyl); // Set decremented
duty ratio
end;

end;
end.

HW Connection
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PWM 16 BIT LIBRARY

CMO module is available with a number of AVR MCUs. mikroPascal PRO for AVR
provides library which simplifies using PWM HW Module.

Note: For better understanding of PWM module it would be best to start with the exam-
ple provided in Examples folder of our mikroPascal PRO for AVR compiler. When you
select a MCU, mikroPascal PRO for AVR automaticaly loads the correct PWM-16bit
library, which can be verified by looking at the Library Manager. PWM library handles and
initializes the PWM module on the given AVR MCU, but it is up to user to set the correct
pins as PWM output, this topic will be covered later in this section.

Library Routines

- PWM16bit_Init

- PWM16bit_Change_Duty
- PWM16bit_Start

- PWM16bit_Stop

Predefined constants used in PWM-16bit library

The following variables are used in

PWM library functions: Description:

_PWM16_PHASE CORRECT MODE 8BIT |Selects Phase Correct, 8-bit mode.

_PWM16_ PHASE CORRECT MODE 9BIT |Selects Phase Correct, 9-bit mode.

_PWM16 PHASE CORRECT MODE 10BIT |Selects Phase Correct, 10-bit mode.

_PWM16 FAST MODE 8BIT Selects Fast, 8-bit mode.

_PWM16 FAST MODE 9BIT Selects Fast, 9-bit mode.

_PWM16 FAST MODE 10BIT Selects Fast, 10-bit mode.

_PWM16 PRESCALER 16bit 1 Sets prescaler value to 1 (No prescaling).
_PWM16 PRESCALER 16bit 8 Sets prescaler value to 8.

_PWM16 PRESCALER 16bit 64 Sets prescaler value to 64.

_PWM16 PRESCALER 16bit 256 Sets prescaler value to 256.

_PWM16 PRESCALER 16bit 1024 Sets prescaler value to 1024.

_PWM16_ INVERTED Selects the inverted PWM-16bit mode.

Selects the normal (non inverted) PWM-

PWM16 NON INVERTED :
- — = 16bit mode.
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Selects the Timer/Counter1 (used with
PWM16bit_Start and PWM16bit_Stop.

Selects the Timer/Counter3 (used with
PWM16bit_Start and PWM16bit_Stop.

Selects the channel A on Timer/Counter1
(used with PWM16bit_Change_Duty).

Selects the channel B on Timer/Counter1
(used with PWM16bit_Change_Duty).

Selects the channel C on Timer/Counter1
(used with PWM16bit_Change Duty).

Selects the channel A on Timer/Counter3
(used with PWM16bit_Change_Duty).

_TIMER1

_TIMER3

_TIMERL CH A

TIMERI CH B

_TIMERL CH C

_TIMER3 CH A

Selects the channel B on Timer/Counter3

~TIMER3 CH B (used with PWM16bit_Change_Duty).

Selects the channel C on Timer/Counter3

~TIMER3 CH C (used with PWM16bit_Change_Duty).

Note: Not all of the MCUs have 16bit PWM, and not all of the MCUs have both
Timer/Counter1 and Timer/Counter3. Sometimes, like its the case with ATmega168,
MCU has only Timer/Counter1 and channels A and B. Therefore constants that have
in their name Timer3 or channel C are invalid (for ATmega168) and will not be visi-
ble from Code Assistant. It is highly advisable to use this feature, since it handles all
the constants (available) and eliminates any chance of typing error.
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PWM16bit_Init
procedure PWMl6bit Init(wave mode : byte; prescaler : byte;
PrOtOtype inverted : byte; duty : word; timer : byte);

Returns Nothing.

Initializes the PWM module. Parameter wave_mode is a desired PWM-16bit
mode.
There are several modes included :

- PWM, Phase Correct, 8-bit
- PWM, Phase Correct, 9-bit
- PWM, Phase Correct, 10-bit
- Fast PWM, 8-bit

- Fast PWM, 9-bit

- Fast PWM, 10-bit

Parameter prescaler chooses prescale value N = 1,8,64,256 or 1024 (some
modules support 32 and 128, but for this you will need to check the datasheet
for the desired MCU). Paremeter inverted is for choosing between inverted and
non inverted PWM signal. Parameter duty sets duty ratio from 0 to TOP value
(this value varies on the PWM wave mode selected). PWM signal graphs and
formulas are shown below.

Description
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The N variable represents the prescaler factor (1, 8, 64, 256, or 1024).

PWM16bit_Init must be called before using other functions from PWM Library.
You need a CMO on the given MCU (that supports PWM-16bit).

Before calling this routine you must set the output pin for the PWM (according
Requires to the datasheet):

DDRB.B1 = 1; // set PORTB pin 1 as output for the PWM-16bit
This code example is for ATmega168, for different MCU please consult
datasheet for the correct pinout of the PWM module or modules.

Initialize PWM-16bit module:

Exampl
ample PWM16bit Init( PWM16 PHASE CORRECT MODE 8BIT,

_PWM16 PRESCALER 16bit 8, PWM16 NON_ INVERTED, 255, TIMERI);
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PWM16bit_Change_Duty

Prototype procedure PWMI6bit Change Duty(duty : word; channel : byte);
Returns Nothing.
Changes PWM duty ratio. Parameter duty takes values shown on the table
below. Where 0 is 0%, and TOP value is 100% duty ratio. Other specific values
for duty ratio can be calculated as (Percent*TOP)/100.
Timer/Counter Mode of TOP : Update of TOVn Flag Set
Operation : ) OCRnNX at : on:
L. PWM, Phase Correct, 8 bit |0OxO0FF |TOP BOTTOM
Description
PWM, Phase Correct, 9 bit |Ox01FF |TOP BOTTOM
PWM, Phase Correct, 10 bit|0Ox03FF |TOP BOTTOM
Fast PWM, 8 bit 0x00FF |TOP TOP
Fast PWM, 9 bit 0x01FF |TOP TOP
Fast PWM, 10 bit 0x03FF |TOP TOP
Requires PWM module must to be initialised (PWM16bit_Init) before using
q PWM_Set_Duty function.
Example lets set duty ratio to :
Example
PWM16bit Change Duty (300, TIMERI CH A );

PWM16bit_Start

Prototype |procedure PWMl6bit Start (timer : byte);

Returns Nothing.

Starts PWM-16bit module with alredy preset values (wave mode, prescaler,
inverted and duty) given in the PWM16bit_Init.

MCU must have CMO module to use this library. PWM16bit_Init must be called
Requires before using this routine, otherwise it will have no effect as the PWM module is

Description

not initialised.
PWMlébit Start( TIMERL ); // Starts the PWM-1l6bit module
on Timer/Counterl or
Example
PWMlébit Start( TIMER3 ); // Starts the PWM-1l6bit module

on Timer/Counter3
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PWM16bit_Stop

Prototype |procedure PWM16 Stop(timer : byte);

Returns Nothing.

Description |Stops the PWM-16bit module, connected to Timer/Counter set in this stop function.
MCU must have CMO module to use this library. Like in PWM16bit_Start

Requires before, PWM16bit_Init must be called before using this routine , otherwise it will
have no effect as the PWM module is not running.
PWMlé6bit Stop( TIMER1l ); // Stops the PWM-16bit module on
Timor/Coantorli or

Example
PWMlé6bit Stop( TIMER3 ); // Stops the PWM-16bit module on
Timer/Counter3

Library Example

The example changes PWM duty ratio continually by pressing buttons on PORTC (0-3). If LED is
connected to PORTB.1 or PORTB.2 ,you can observe the gradual change of emitted light. This
example is written for ATmega168. This AVR MCU has only Timer/Counter1 split over two chan-
nels A and B. In this example we are changing the duty ratio on both of these channels.

program PWMl6bit Test;

var current duty : byte;
current dutyl : byte;

begin

DDRC.BO := 0; // Set PORTC pin 0 as input

DDRC.B1 := 0; // Set PORTC pin 1 as input

DDRC.B2 := 0; // Set PORTC pin 2 as input

DDRC.B3 := 0; // Set PORTC pin 3 as input

current duty := 255; // initial value for current duty

current dutyl := 255; // initial value for current duty

DDRB.B1 := 1; // Set PORTB pin 1 as output pin for the PWM
(according to datasheet)

DDRB.B2 := 1; // Set PORTB pin 2 as output pin for the PWM

(according to datasheet)
PWM16bit Init( PWM16 FAST MODE 9BIT, PWM16 PRESCALER 16bit 1, PWM16 INVERTED,
255, 1);

while TRUE do
begin
if (PINC.BO <> 0) then // Detect if PORTC pin 0 is pressed
begin
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Delay ms (40); // Small delay to avoid
deboucing effect
Inc (current duty); // Increment duty ratio
PWMl6bit Set Duty(current duty); // Set incremented duty
end
else
if (PINC.B1 <> 0) then // Detect if PORTC pin 1 is pressed
begin
Delay ms (40); // Small delay to avoid
deboucing effect
Dec (current duty); // Decrement duty ratio
PWM16bit Set Duty(current duty); // Set decremented
duty ratio
end
else
if (PINC.B2 <> 0) then // Detect if PORTC pin 2 is pressed
begin
Delay ms (40); // Small delay
to avoid deboucing effect
Inc (current dutyl); // Increment duty ratio
PWM16bit Set Duty(current dutyl); // Set incre-
mented duty
end
else
if (PINC.B3 <> 0) then// Detect if PORTC pin 3 is pressed
begin
Delay ms (40);// Small delay to avoid deboucing effect
Dec (current dutyl); // Decrement duty ratio
PWM16bit Set Duty(current dutyl); // Set decre-

mented duty ratio
end;
end;
end.
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RS-485 LIBRARY

RS-485 is a multipoint communication which allows multiple devices to be connect-
ed to a single bus. The mikroPascal PRO for AVR provides a set of library routines
for comfortable work with RS485 system using Master/Slave architecture. Master
and Slave devices interchange packets of information. Each of these packets con-
tains synchronization bytes, CRC byte, address byte and the data. Each Slave has
unique address and receives only packets addressed to it. The Slave can never ini-
tiate communication.

It is the user’s responsibility to ensure that only one device transmits via 485 bus at a time.

The RS-485 routines require the UART module. Pins of UART need to be attached
to RS-485 interface transceiver, such as LTC485 or similar (see schematic at the
bottom of this page).

Library constants:

- START byte value = 150

- STOP byte value = 169

- Address 50 is the broadcast address for all Slaves (packets containing address 50
will be received by all Slaves except the Slaves with addresses 150 and 169).

Note:

- Prior to calling any of this library routines, UART_Wr_Ptr needs to be initialized
with the appropriate UART_Write routine.

- Prior to calling any of this library routines, UART_Rd_Ptr needs to be initialized
with the appropriate UART_Read routine.

- Prior to calling any of this library routines, UART_Rdy_Ptr needs to be initialized
with the appropriate UART_Ready routine.

- Prior to calling any of this library routines, UART_TX_Idle_Ptr needs to be initiali-
zed with the appropriate UART_TX_Idle routine.
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External dependencies

of RS-485 Library

The following variables
must be defined in all
projects using RS-485

Library:

Description:

Example :

var RS485 rxtx pin :

Control RS-485 Trans-
mit/Receive operation

var RS485 rxtx pin :
sbit at PORTD.B2;

sbit; sfr; external;

mode
var var
RS485 rxtx pin direc- |Direction of the RS-485 RS485 rxtx pin direc-
tion : sbit; sfr; Transmit/Receive pin tion : sbit at
external; DDRD.B2;

Library Routines

- RS485Master_Init

- RS485Master_Receive
- RS485Master_Send

- RS485Slave_Init

- RS485Slave Receive
- RS485Slave_Send
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RS485Master_Init

Prototype procedure RS485Master Init();

Returns Nothing.

Description |[Initializes MCU as a Master for RS-485 communication.

Global variables :

- RS485 rxtx pin - this pin is connected to RE/DE input of RS-485
transceiver(see schematic at the bottom of this page). RE/DE signal controls

. RS-485 transceiver operation mode.

Requires

-RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin
must be defined before using this function.

UART HW module needs to be initialized. See UARTx_Init.

// RS485 module pinout

var RS485 rxtx pin : sbit at PORTD.B2;

var RS485 rxtx pin direction : sbit at DDRD.B2;
// End of RS485 module pinout

// Pass pointers to UART functions of used UART module
UART Wr Ptr := QUART1 Write;

UART Rd Ptr := QUART1 Read;

UART Rdy Ptr := QUART1 Data Ready;

UART TX Idle Ptr := QUART1 TX Idle;

Example

UART1 Init(9600); // initialize UART module
RS485Master Init(); // intialize MCU as a
Master for RS-485 communication
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RS485Master_Receive

Prototype procedure RS485Master Receive (var data buffer: arrayl 5] of byte);

Returns Nothing.

Receives messages from Slaves. Messages are multi-byte, so this routine must
be called for each byte received.

Parameters :

- data buffer: 7 byte buffer for storing received data, in the following manner:

Description datal 0..2] : message content '
- datal 3] : number of message bytes received, 1-3
- data[ 4] : is set to 255 when message is received
- data[ 5] : is set to 255 if error has occurred
- data[ 6] : address of the Slave which sent the message

The function automatically adjusts data[4] and data[5] upon every received mes-
sage. These flags need to be cleared by software.

MCU must be initialized as a Master for RS-485 communication. See
RS485Master_Init.

var msg : arrayl 20] of byte;

Requires

Example S
RS485Master Receive (msg);
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RS485Master_Send

procedure RS485Master Send(var data buffer: arrayl 20] of byte;

Prototype datalen: byte; slave address: byte);

Returns Nothing.

Sends message to Slave(s). Message format can be found at the bottom of this
page.

o Parameters :
Description

-data buffer: data to be sent
- datalen: number of bytes for transmition. Valid values: 0...3.
- slave address: Slave(s) address

MCU must be initialized as a Master for RS-485 communication. See
RS485Master_Init.

Requires
It is the user’s responsibility to ensure (by protocol) that only one device sends
data via 485 bus at a time.
var msg : arrayl 20] of byte;

Example // send 3 bytes of data to Slave with address 0x12

RS485Master Send(msg, 3, 0x12);
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RS485Slave_Init

Prokﬂype procedure RS485Slave Init(slave address: byte);
Returns Nothing.
Initializes MCU as a Slave for RS-485 communication.
Description |[Parameters :
- slave address: Slave address
Global variables :
- RS485 rxtx pin - this pin is connected to RE/DE input of RS-485
transceiver(see schematic at the bottom of this page). RE/DE signal controls --
- RS-485 transceiver operation mode. Valid values: 1 (for transmitting) and 0 (
. for receivin
Requires 9)
- RS485 rxtx pin direction - direction of the RS-485 Transmit/Receive pin
must be defined before using this function.
UART HW module needs to be initialized. See UARTX_Init.
// RS485 module pinout
var RS485 rxtx pin : sbit at PORTD.B2;
var RS485 rxtx pin direction : sbit at DDRD.B2;
// End of RS485 module pinout
// Pass pointers to UART functions of used UART module
UART Wr Ptr := QUARTL Write;
Example UART Rd_Ptr := QUART1 Read;
UART Rdy Ptr := @QUART1 Data Ready;
UART TX Idle Ptr := QUART1 TX Idle;
UART1 Init(9600); // initialize UART module
RS485Slave Init (160); // intialize MCU as a
Slave for RS-485 communication with address 160
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RS485slave_Receive

Prototype procedure RS485Slave Receive (var data buffer: arrayl 20] of byte);

Returns Nothing.

Receives messages from Master. If Slave address and Message address field
don't match then the message will be discarded. Messages are multi-byte, so
this routine must be called for each byte received.

Parameters :

- data buffer: 6 byte buffer for storing received data, in the following manner:

Description .
datal 0..2] : message content
- datal 3] : number of message bytes received, 1-3
- data[ 4] : is set to 255 when message is received
[5

1:is set to 255 if error has occurred

The function automatically adjusts data[4] and data[5] upon every received mes-
sage. These flags need to be cleared by software.

MCU must be initialized as a Slave for RS-485 communication. See
RS485Slave_Init.

var msg : arrayl 20] of byte;

Requires

Example S
RS485Slave Read (msqg) ;

RS485Slave_Send

procedure RS485Slave Send(var data buffer: arrayl 20] of byte;

Prototype datalen : byte);

Returns Nothing.

Sends message to Master. Message format can be found at the bottom of this page.
i Parameters :

Description
- data buffer: data to be sent

- datalen: number of bytes for transmition. Valid values: 0...3.

MCU must be initialized as a Slave for rs-485 communication. See
Requires rRS4855lave Init. Itis the user’s responsibility to ensure (by protocol) that only
one device sends data via 485 bus at a time.

var msg : arrayl 8] of byte;

Example // send 2 bytes of data to the Master

RS485Slave Send(msg, 2);
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Library Example
This is a simple demonstration of RS485 Library routines usage.

Master sends message to Slave with address 160 and waits for a response. The
Slave accepts data, increments it and sends it back to the Master. Master then does
the same and sends incremented data back to Slave, etc.

Master displays received data on PORTB, while error on receive (0xAA) and number of
consecutive unsuccessful retries are displayed on PORTC. Slave displays received data
on PORTB, while error on receive (0xAA) is displayed on PORTC. Hardware configura-
tions in this example are made for the EasyAVR5A board and ATmega16.

RS485 Master code:
program RS485 Master Example;
uses __ Lib RS485;

var dat : arrayl 10] of byte ; // buffer for receving/sending messages
i, J : byte;

cnt : longint;
var rs485 rxtx pin : sbit at PORTD.B2; // set transcieve pin
rs485 rxtx pin direction : sbit at DDRD.BZ; // set transcieve

pin direction

// Interrupt routine

procedure interrupt(); org 0xl6;
begin
RS485Master Receive (dat);
end;
begin
cnt := 0;
PORTA = 0; // clear PORTA
PORTB := 0; // clear PORTB
PORTC := 0; // clear PORTC
DDRA := OxFF; // set PORTA as output
DDRB := OxFF; // set PORTB as output
DDRC = OxFF; // set PORTB as output

// Pass pointers to UART functions of used UART module
UART Wr_ Ptr:= QUART1 Write;

UART Rd Ptr := QUART1 Read;

UART Rdy Ptr := QUART1 Data Ready;
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UART TX Idle Ptr

UART1 Init (9600);
Delay ms (100);

RS485Master Init();

QUART1

TX Idle;

// initialize UART1 module

// initialize MCU as Master

// ensure that message received flag is 0
// ensure that error flag is 0

dat[ 0] O0xAA;
dat[ 1] = 0xFO;
dat[ 2] 0x0F;
datl[ 4] = 0;
dat[ 5] = 0;
dat[ 6] = 0;

RS485Master Send(dat,1,160)

’

SREG I = 1; // enable global interrupt
RXCIE = 1; // enable interrupt on UART receive
while (TRUE) do
begin // upon completed valid message receiving
// datal 4] is set to 255
Inc(cnt);
if (dat[ 5] <> 0) then // if an error detected, signal it
PORTC := dat[ 5] ; // by setting PORTC
if (dat[ 4] <> 0) then // if message received successfully
begin
cnt := 0;
dat[ 4] = 0; // clear message received flag
J := dat[ 3] ;
for i := 1 to dat[ 3] do // show data on PORTB
PORTB := dat[ i-1];
dat[ 0] := dat[ 0] +1; // increment received dat[ 0]
Delay ms(1); // send back to slave
RS485Master Send(dat,1,160);
end;
if (cnt > 100000) then // if in 100000 poll-cycles the answer
begin
Inc (PORTA) ; // was not detected, signal
cnt := 0; // failure of send-message
RS485Master Send(dat,1,160);
if (PORTA > 10) then // if sending failed 10 times
begin
PORTA 0;
RS485Master Send(dat,1,50); // send message on
broadcast address
end;
end;

end;
end.
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RS485 Slave code:

program RS485 Slave Example;

uses __ Lib RS485;

var dat : arrayl 20] of byte; // buffer for receving/sending messages
i, 3 : byte;

var rs485 rxtx pin : sbit at PORTD.B2; // set transcieve pin
rs485 rxtx pin direction : sbit at DDRD.B2; // set transcieve
pin direction

// Interrupt routine
procedure interrupt(); org 0x16;
begin
RS485Slave Receive (dat);

end;
begin
PORTB := 0; // clear PORTB
PORTC := 0; // clear PORTC
DDRB := OxFF; // set PORTB as output
DDRC := OxFF; // set PORTB as output

// Pass pointers to UART functions of used UART module

UART Wr Ptr := QUART1 Write;
UART Rd Ptr := @QUART1 Read;
UART Rdy Ptr := QUART1 Data Ready;
UART TX Idle Ptr := QUART1 TX Idle;
UART1 Init (9600); // initialize UART1 module
Delay ms (100);
RS485Slave Init (160); // Intialize MCU as slave, address 160
dat[ 4] := 0; // ensure that message received flag is 0
dat[ 5] := 0; // ensure that message received flag is 0
dat[ 6] := 0; // ensure that error flag is 0
SREG I := 1; // enable global interrupt
RXCIE := 1; // enable interrupt on UARTs receive

while (TRUE) do

begin
if (dat[ 5] <> 0) then // 1if an error detected, signal it by
begin
PORTC := dat[ 5] ; // setting PORTC
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dat[ 5] := 0;
end;
if (dat[ 4] <> 0) then // upon completed valid message receive
begin
dat[ 4] := 0; // datal 4] is set to OxFF
§ := datl 3] ;
for i := 1 to dat[ 3] do // show data on PORTB
PORTB := dat[ i-1];
dat[ 0] := dat[ 0] +1; // increment received dat[ 0]
Delay ms (1) ;
RS485Slave Send(dat,1); // and send it back to master
end;
end;
end.
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HW Connection
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Example of interfacing PC to AVR MCU via RS485 bus with LTC485 as RS-485
transceiver
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Message format and CRC calculations

Q: How is CRC checksum calculated on RS485 master side?

START BYTE := 0x96; // 10010110
STOP BYTE := O0xA9; // 10101001
PACKAGE :

START BYTE 0x96

ADDRESS

DATALEN

[ DATA1] // if exists
[ DATAZ] // if exists
[ DATA3] // if exists
CRC

STOP BYTE 0xA9

DATALEN bits

bit7 := 1 MASTER SENDS
0 SLAVE SENDS

bit6 := 1 ADDRESS WAS XORed with 1, IT WAS EQUAL TO START BYTE or
STOP BYTE
0 ADDRESS UNCHANGED
bit5 := 0 FIXED
bit4 := 1 DATA3 (if exists) WAS XORed with 1, IT WAS EQUAL TO

START BYTE or STOP BYTE

0 DATA3 (if exists) UNCHANGED
bit3 =1 DATA2 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATA2 (if exists) UNCHANGED
bit2z = 1 DATAl (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATAl (if exists) UNCHANGED
bitlbit0 := 0 to 3 NUMBER OF DATA BYTES SEND

CRC generation

crc_send := datalen xor address;

crc_send := crc_send xor data[ 0] ; // if exists
crc_send := crc_send xor data[ 1] ; // if exists
crc_send := crc_send xor datal 2] ; // if exists
crc_send := not crc_ send;

if ((crc_send = START BYTE) or (crc send = STOP BYTE)) then
Inc(crc_send);

NOTE: DATALEN<4..0> can not take the START